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INTRODUCTION TO VDDT 

What is VDDT? 
Projecting changes in vegetation structure and composition over time is an 
important part of landscape-level analyses. Vegetation can change for a 
variety of reasons such as human activity, fires, insects, pathogens, 
mammals, weather, or growth and competition. The interaction of these 
factors can be quite complex and it can be difficult to project the combined 
effects over long periods of time.  

The Vegetation Dynamics Development Tool (VDDT) is a user-friendly, 
Windows-based computer tool that provides a modeling framework for 
examining the role of various transition agents and management actions in 
vegetation change. 

Terminology Used in VDDT 
Different areas within a landscape can be summarized as being covered by 
vegetation that is predominantly of some type (i.e., the dominant species) and 
structure. Each of these areas can be called a class. VDDT operates on a 
series of these classes. Each class is a unique combination of cover type and 
structural stage, where cover type is the dominant type of vegetation, and the 
structural stage relates to the vegetation structure of the class (e.g., high or 
low grasses, single or multi-storied tree cover, etc.). VDDT moves cells (a 
unit of area) from class to class based on a set of pathways. These pathways 
define how the vegetation changes based on deterministic transitions (i.e., 
aging in the absence of any probabilistic transitions), and probabilistic 
transitions (anything that changes the pathway of the cell such as insects, 
diseases, grazing, harvesting, severe weather events, etc.). Movement along 
pathways can be a deterministic (time dependent event) or a stochastic event, 
the likelihood of which is defined by probabilities. 

Regions are areas in which the basic scenario assumption is the same (for 
example – transition type i, in class j, moves the cell to class x), but the 
probabilities (P(i)) of some transitions differ. 

Probabilistic transitions belong to one or more transition groups. These 
groups are broad categories containing probabilistic transitions that are of 
similar type. The grouping allows users to more easily select pathways for 
drawing, view the effect of the transitions, disable types of transitions for a 
particular simulation, or use multipliers to change the probabilities associated 
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with types of transitions. Users can define up to 30 groups, and can assign 
each probabilistic transition to up to three groups. 

How the Model Works 
Users of VDDT create descriptions of vegetation dynamics using state and 
transition models.  For each state and transition model vegetation states are 
defined as combinations of the predominant cover type and structural stage, 
called classes.  Two types of pathways between classes are possible in a 
pathway diagram: probabilistic transitions and deterministic transitions. 
Probabilistic transitions specify the type of transition event, its probability (or 
return frequency) and its impact on vegetation. Probabilistic transitions are 
typically used to represent natural disturbances (e.g. fire, wind, insects) or 
probabilistic succession. Deterministic transitions specify, for each class, the 
maximum time until a transition must occur, and the class it will move to 
after this time has passed (e.g., to represent deterministic succession). 

The basic VDDT simulation algorithm is described with detail in Appendix 
A.  Here is a brief description.  For each simulation, the landscape is 
partitioned into a number of cells or simulation units; each initially assigned 
a class (i.e., cover type and structural stage) and age. For each time step the 
model simulates the probability of each cell being affected by one of 
probabilistic transition types, and if a transition does occur, moves the cell to 
the class defined in the pathway diagram. Transition probabilities are 
dependent on the current state of the cell, defined by its class. They are 
independent of the state of the neighboring cells. Thus, the model is not 
spatially-explicit, and so does not simulate contagion in space (e.g., wildfire) 
or time (e.g., insect outbreaks).   

VDDT can be used to test the assumptions of transition probabilities and 
pathways. The model simulates changes in landscape-level indicators, such 
as changes in the frequency distribution of classes or structural stages and the 
area affected by each transition type. Results are presented at user-specified 
time intervals or as average statistics for certain time periods.  Detailed 
results can also be exported to text files.  Because of the stochastic nature of 
the model, results are not deterministic, but follow probability distributions 
described in more detail in Appendix B. 

The pathway diagrams depict scenarios of vegetation dynamics. Landscape-
level vegetation changes can thus be simulated for one or more scenarios and 
the impacts of changes in transition frequency can be assessed. Scenarios can 
define different assumptions about fire suppression, land management, or the 
introduction of exotics by assigning different probabilities to the applicable 
pathways.  

This modeling framework provides a common platform for specialists of 
different disciplines (entomology, pathology, fire ecology, silviculture, 
wildlife biology and ecology) to collectively define the roles of various 
processes and agents of transition on landscape-level vegetation dynamics. 
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Moreover, the development tool allows for rapid gaming and testing of the 
sensitivity of the system to alternative assumptions. It thus provides a tool for 
learning and communication. 

Using this Manual 
The User’s Guide has been organized by menu option, and covers the major 
steps involved in setting up the model, carrying out runs, and analyzing 
results. Please consult the Table of Contents and the Index to help you find 
specific information. 

The User’s Guide uses the following typographical conventions. 

Example Description 

Number of simulations Italic type indicates names/text appearing on a 
dialog box, such as the names of fields and tab 
names. 

Results Bold type indicates text you must type exactly as 
shown; it also emphasizes menu names, menu 
options and buttons you can choose. 

New VDDT Features  
VDDT version 6 has been upgraded to include a number of new features.  
These include: 

1. a reorganization of VDDT’s menus and screens to make using the system 
more intuitive; in particular, the options for graphing and exporting 
output, and for controlling advanced features (such as multipliers, 
attributes and area limits), have now been streamlined; 

2. storage of all key user inputs within the VDDT Access database, making 
it easier to track and share models; new features added to the VDDT 
model database since version 5 include attributes, area limits and 
multipliers; 

3. the simplification and streamlining of options for exporting model output, 
making it easier to export model output for use in other applications (such 
as Excel and Access); 

4. improved options for importing and exporting model parameters, 
including the ability to import and export transition pathways and 
probabilities to/from Excel; 

5. the addition of batch run capabilities, allowing multiple projects in a 
database to be run at one time; this feature is particularly useful when 
running VDDT over landscapes with multiple models; and 

6. the ability to invoke batch runs of VDDT models from other applications. 
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Details of these and other changes are explained throughout this manual.  See 
about Working with Version 4 Projects, and Importing Projects and Files for 
specifics on how to use VDDT files from VDDT version 4.4c and earlier. 
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GETTING STARTED 

System Requirements 
We recommend the following system specifications: 

• Microsoft Windows 2000 or later; and 

• 512 MB memory. 

Installing VDDT 
VDDT is installed using an MSI program in the downloaded zip file.  You 
will need a password to extract the VDDT installation program from the ZIP 
file (contact vddt@essa.com to request the password). 

To install VDDT for the first time: 
1. From the Start menu, select Run. 

2. Click on the Browse button and navigate to the temporary directory.  
From the Files of Type drop-down list, select All Files. 

3 Choose VDDT-Setup-60-xxx.msi, where "xxx" denotes the last three 
digits of the version number.  Click Open. 

4. Click OK on the Run window, and follow the instructions on the screen. 

The install program will ask you where you wish to put the program files 
(i.e., the directory in which VDDT should be placed). The default directory is 
C:\Program Files\VDDT but users can change this to a directory of their 
choice. The installation will place files in the chosen directory and in the 
\WINDOWS\SYSTEM32 directory. It will also create items on the 
Programs menu. 

VDDT is distributed with a set of existing files that can be used as a starting 
point or as examples. These files include an example Project in a database 
(VDDT.mdb), and text definition files containing lists of probabilistic 
transitions (DISTCODE.TXT), probabilistic transition groups 
(DISTGRP.TXT), cover types (COVER.TXT, COVERC.TXT), and 
structural stages (STRUCTUR.TXT).  

mailto:vddt@essa.com
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To install an upgraded version of VDDT: 

Note: 
VDDT version 6 can read files from all previous versions of VDDT.  

If you try to install VDDT 6 without uninstalling a previous version, the 
installation program will detect the older version and offer you the 
opportunity to remove it.  The removal process will archive the *.TXT 
definition files found in the VDDT folder, and will remove all program files, 
including the default VDDT.mdb file.  Files and folders that you created 
while working with the earlier version of VDDT, e.g., customized folders 
containing databases and other project-related files, will not be removed by 
the de-installation process.   

Note: 
If you have made manual changes to the location of VDDT program files, 
VDDT may be unable to complete the uninstall.  If this happens, please 
contact us at vddt@essa.com for assistance.  

If you have projects in the default VDDT database (VDDT.mdb) that you 
wish to keep, be sure to make a back-up copy of VDDT.mdb before 
proceeding.  The uninstall process will remove the VDDT.mdb file in the 
VDDT folder, and the installation process will replace that file with a fresh 
one containing only the Ponderosa Pine Demonstration Project.  After the 
installation is complete, you can either copy your backed up VDDT.mdb into 
the VDDT folder (overwriting the newly installed VDDT.mdb), or you can 
import your customized projects from the back-up into the newly installed 
VDDT.mdb. Alternatively, you can export your projects from the back-up 
database into a new database with a different name of your choosing. 

After uninstalling, re-start the installation process by following the steps 
above for installing VDDT for the first time.  

Running the Model 
To assist beginning users, a basic database (VDDT.mdb) and an example 
Project called "Ponderosa Pine Demonstration Project" are distributed with 
VDDT .  Using the example Project, or any other Project in the database, the 
model can be run in just nine steps. 

To run the model using an existing Project: 
1. Start VDDT by selecting VDDT from the Programs menu under the 

Start button. 

2. Select Open from the File menu. 

3. Choose an existing Project (such as Ponderosa Pine Demonstration 
Project) from the list in the Open Project dialog; VDDT will display the 
associated Transition Pathway Diagram (TPD). 

mailto:vddt@essa.com
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4. Select Run|Settings and define your general run conditions on the 
General tab.  Set the Number of timesteps, the Number of cells, and the 
Number of simulations.  In the example below, the model is set to 
simulate 1000 cells for 100 years, repeated for 3 Monte Carlo 
simulations.  
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5. Set the initial run conditions on the Initial Conditions tab of the Settings 
screen under the Run menu (see about Initial Condition Run Settings for 
more information).  In the example below, we’ve set the total area to be 
simulated as 21,235 hectares. The model is set to start with 5% of this 
area as Class A, 40% as Class B, etc.  Click OK to close the screen. 

 
 

6. Run the model by selecting Start Model from the Run menu.   

7. When the run is complete, you can view your results using the various 
options under the Results menu. For example, selecting Results|Graph 
Options and then Class and Bar will display the distribution of area by 
class at up to four different time steps.  
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8. To save any changes you’ve made to your VDDT Project, select 
File|Save As and enter a new name for it. If you now go to the 
File|Open menu, you should see your newly-named Project, alongside 
the original demonstration project used to start this exercise.  

9. When your VDDT session is concluded, select Exit from the File menu 
to close the application. 

The VDDT Database 
VDDT stores all key model inputs in an Microsoft Access database, i.e., 
definitions, potential vegetation type and scenario information, information 
about the location of classes in the pathways diagram, initial conditions, 
attributes, area limits, multipliers and general project information.  Advanced 
information created using the optional Variation menu, e.g., trend 
multipliers and landscape feedback (see about the Variation menu in 
Appendix G), is stored in a series of text files external to the VDDT 
database.  The physical location of these files is stored in the database as part 
of the Project, so VDDT can find them when the Project that references them 
is opened; the database only stores information about the physical location of 
these advanced files, not the information itself. 

VDDT is distributed with a sample database (VDDT.mdb) to assist 
beginning users.  Other VDDT databases of Project information can also be 
created and loaded.  For example, users might keep all Projects from a 
certain geographic location in one database and those from another in a 
separate database.  To load a different VDDT database, choose Database 
from the File menu and select the MDB file with which you wish to work.  
To create a new VDDT database, copy the one in the installation directory 
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(Default C:\Program Files\VDDT), move it into the directory you want to 
use, and rename it. 

Once you have chosen the database with which you wish to work, any 
Project in that database can be opened using the Open option under the File 
menu.  After making changes to your Projects, you must explicitly save them 
to the database using the Save option under the File menu.  If you wish to 
save your changes to a new Project, choose Save As from the File menu and 
rename the Project. 
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WORKING WITH VERSION 4 PROJECTS 

Definition Files 
In early versions of VDDT (4.x and earlier), definition files constituted the 
foundation of all Projects. These files define the meaning of many numerical 
codes used in VDDT (e.g., they relate a cover type code to a name), and 
contain information about the valid cover types, structural stages, and 
probabilistic transitions that are used throughout the model. In later versions 
of VDDT, all definition information is stored within the VDDT database; 
however definition files can still be used to create new Projects (using the 
File|New menu).  Alternatively, definition files can be imported into an 
existing VDDT 5.x or later project using the File|Import|Definitions menu. 

A set of five text definition files is included with the VDDT installation as a 
starting point for new Projects.  They are: 

• DISTCODE.TXT, 

• DISTGRP.TXT, 

• COVER.TXT, 

• COVERC.TXT, and 

• STRUCTUR.TXT. 

New cover types, probabilistic transitions, transition groups, and structural 
stages can be defined by creating a new set of definition files or editing the 
existing ones in any editor capable of reading and writing ASCII files. When 
customizing these files, be sure the file format conforms to the descriptions 
provided in Appendix D.  

Note: 
If you wish to create multiple customized sets of definition files while 
retaining the original TXT files as templates, you can either rename the new 
ones by changing the extension (do not change the filenames), or you can 
move the new sets into different file folders.  

PVT and Scenario Files 
Potential Vegetation Type files (*.PVT) and Scenario files (*.SC) are 
integral to Project files created in early versions of VDDT.  In version 6, the 
information contained in these files is stored in the database, and users only 
handle these files when importing or exporting Projects (using the 
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File|Import|PVT and File|Import|Scenario menus).  For a detailed 
description of these files and how they were used in VDDT version 4.4c, see 
Appendices D and E. 

Location Files 
In early versions of VDDT, location files (*.LOC) contained information 
about the placement of the classes in the Transition Pathway Diagram. This 
information is optional, as VDDT can organize classes using an internal rule-
base.  As with PVT and Scenario files, the information contained in the 
location file is now stored directly in the database.  Users only handle this 
file when importing or exporting Projects (using the File|Import|Scenario 
menu). After the scenario file is read, the model will look to see if there is a 
location file with the same name as the PVT file. If so, the user will be 
prompted to load the location file as well. The information in the location file 
will overwrite the default information produced by VDDT. Once a location 
file is being used for a VDDT session, all new classes must be placed in the 
desired location. 

Clicking on the Cancel button when VDDT asks for the location file name 
will cause VDDT to ignore the location file, and to use the default locations 
for the classes. 

Note: 
If the location file has a different name than the PVT file, the model will not 
find the file and will not prompt the user to load it. You can open a location 
file with a different name by navigating to the directory containing the file, 
and selecting it. 

Project Files 
In early versions of VDDT, project files (*.PRJ) contained a roadmap to all 
component files that comprised a Project.  These component files included 
core information (Definitions, PVT, SCN, LOC, IC) which is now stored in 
the database, as well as advanced information (attributes, temporal variation, 
landscape feedback…), some of which is still stored in files.  Additionally, 
Project files contained various parameter values (such as the number of time 
steps, or whether multipliers are turned on, etc.).  

Users only handle this file when importing or exporting Projects (using the 
File menu). A complete description of the file formats is given in Appendix 
D. 
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Building Projects from Component Files 
For users of VDDT version 4.4c and earlier, Projects can be created in 
version 6 from component files using the Import option under the File 
menu.  Import opens the selected files into memory; nothing is saved to the 
database until the user explicitly saves a Project by selecting Save or Save 
As from the File menu.   

To import component files for a Project: 
1. Start VDDT by selecting VDDT from the Program menu under the 

Start button. 

2. Select Import|Definitions and PVT in turn from the File menu. With 
these menu options, you will import all definition files, the PVT, 
scenario and location files.  When done, the Project defined by the 
selected files will open into memory, displaying the pathway diagram. 

3. Select Save from the File menu and name the Project; this action will 
integrate the Project information into the database. 

4. Use the various menus and submenus of VDDT to read in the 
information contained in all associated files related to the Project, e.g., 
attributes, transition and temporal multipliers, area limits, etc.  How to 
do this will be addressed in subsequent chapters of this User Guide. 
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TRANSITION PATHWAY DIAGRAMS 

Transition Pathway Diagrams 
A Transition Pathway Diagram (TPD) defines the classes (boxes) and the 
pathways (lines and circles) between these classes for each potential 
vegetation type. TPDs illustrate all possible ways in which a cell could travel 
to move from one class to another.  

 
Each box is one class, and is described by a unique combination of cover 
type (upper right corner) and structural stage (lower right corner). Each box 
is also labeled with a letter (assigned automatically by VDDT).  

 
 

The cover type is a short code for the predominant vegetation in the class, 
and the structural stage is a letter or number code for the structure of the 
vegetation in the class. The letter of the class is an identifier used within 
VDDT as a reference for the class. The age range shows the minimum and 
maximum ages for the class, as determined by the deterministic transitions.  
The arrows show the pathways between classes, as described in the Project. 
Deterministic transition pathways start and end on the vertical sides of boxes 
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while probabilistic transition pathways start and end on the top or bottom of 
boxes. 

By default, all defined pathways are shown (see About Class Properties for 
more information). Arrows are drawn in a variety of colors to help users 
identify the type of transition agent.  The colors used are: 

 
The numbers in the table correspond to the Code for the pathway’s 
Transition Group (as defined under File|Properties|Definitions). Note that in 
many pathway diagrams, pathways for multiple agents overlap and will be 
drawn in blue (last column). 

The window header for the TPD contains the words Transition Pathway 
Diagram and then the name of the Project. This information is also displayed 
in the Status window in the lower right corner of the main window. The 
status window displays Unmodified until any information about the classes, 
pathways, probabilities, or attributes has been edited. The top left of the TPD 
also lists the transitions currently being displayed (see the next section for 
more details). 

 

About Class Properties 
All of the information contained within a Transition Pathway Diagram may 
be viewed and edited through the Class Properties dialog box.   

To open the class properties dialog: 
1. Right click on the box representing the class of interest, then select 

Class Properties. 

*OR* 

2. Select Class Properties from the Diagram menu, and enter the letter of 
the class of interest. 

The Class Properties dialog box will appear, showing all the pathways 
going away from the class.  In the top right corner of the dialog, the class 
identifier is shown along with the cover type and structural stage of the class.  
Below this is the Display Pathways section of the dialog, with which users 
can view/edit information about pathways going from the class (From Class), 
or view information about pathways going to the class (To Class).   
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The information in the dialog is divided into two main sections. The top 
section contains the deterministic transition information and the bottom 
section contains a grid showing all the probabilistic transition information.  

Deterministic Transitions 
The deterministic part of the dialog box shows: 

• the start and end age of the class, 

• the destination after deterministic transition (class identifier in the Box 
field), and 

• the cover and structural stage of the destination class. 

 
The cells for start/end age and destination class can be edited when viewing 
pathways from classes.  No cells can be edited when viewing pathways to 
classes. 

Probabilistic Transitions 
Each row of the probabilistic part of the dialog box represents a different 
pathway.  The grid contains information about: 

• Region: the regions associated with the Project (this column only 
displays for Projects with multiple regions) – note that each pathway is 
repeated for each of the regions in the Project; 

• Transition Type: the transition type associated with each pathway; 

• Prob: the probability of the transition pathway occurring (less than or 
equal to one); 

• Propn: the proportion of time that the transition leads to the specified 
class within the specified region (less than or equal to one) – by default 
these values are set to 1; and 

• To Class: pathway destination class information (box, cover type and 
structural stage). 
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The cells for transition type, probability, proportion and destination class 
identifier can all be edited when viewing pathways from classes.  No cells 
can be edited when viewing pathways to classes. 

To save class properties information: 
1. When finished with all edits, click on the OK button to save all the 

changes to memory and close the Class Properties dialog.  

2. Alternatively, you can save your changes to memory without closing the 
dialog by clicking Apply.   

These actions do not save your changes to the database; to do so, you need to 
save your Project (File|Save or File|Save As).  

The Cancel button (or the ESC key) allows users to leave the dialog box and 
ignore all changes. 
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THE USER INTERFACE 

File Menu 
The File menu provides access to VDDT’s file management features.  The 
options on this menu allow users to create new Projects, open existing 
Projects, save Project information, and import/export Project information.  
Use the File menu to also manage Project properties, select a different 
database with which to work, and close VDDT.  The following sections of 
the User Guide provide details for each of these features. 

 

CREATING NEW PROJECTS 
The simplest way to create a new project is to make a copy of an existing 
project. 

To copy an existing Project:  
1. Open an existing Project using the File|Open menu. 

2. Save the Project under a new name using the File|Save As menu. 

3. Edit the newly created Project. 

 

Alternatively, Projects can be created without starting from an existing 
Project.  Users can build a Project based only on a set of text definition files.  
Classes and pathways can be added as needed. 
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To create a new Project:  
1. Choose New from the File menu; VDDT prompts for selection of 

definition files.  

2. Select the DISTCODE.* file that represents the location and file 
extension for all of the definition files you wish to use as a basis for your 
Project. 

3. VDDT will proceed to load all five files. 

4. Choose the number of regions to be used in the Project (minimum = 1, 
maximum = 6). 

  
 

5. Following the prompts, create a name for each region in your Project (no 
spaces). 

  
 

 These steps allow the user to create zones in the Project area that have 
different probabilities for transitions, e.g., an area of fire suppression 
would have a lower probability of wildfire than areas without any 
suppression activity. 

6. Add a class to your Project by selecting a Cover Type and Structural 
Stage from the drop-down lists provided; click OK.  
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7. Add the rest of the classes you need for your Project using the Add new 
class option on the Diagram menu. 

 
 

8. Save your Project (File|Save or Save As) to the database. 

At this point in your Project development, you have a transition pathway 
diagram in place and you are ready to start creating pathways by adding 
details about deterministic and probabilistic transitions to each of your 
classes using the Diagram menu.  

OPENING EXISTING PROJECTS 
Projects that have been saved to the database can be accessed using Open 
from the File menu.   

To open an existing Project: 
1. With VDDT running and the database that contains your project active 

in memory, select Open from the File menu. 

2. From the Open Project dialog, select the Project you wish to open from 
the list of available projects in the current database and click Open. 

If the Project you want is not listed, use the Database option under the File 
menu to select a different database; then try again to open the project as 
described above. 
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CLOSING PROJECTS 
Close an active Project by selecting File|Close.  You will be prompted to 
save your Project to the database if any changes were made during the 
session.   

SAVING PROJECTS 
Save an active Project by selecting File|Save.  This action will update all 
Project-related information in the database for the currently opened Project.  
If you wish to keep the old Project information in the database, while 
creating a new Project for your changes, select the File|Save As option and 
give the edited Project a new name. 

IMPORTING PROJECTS AND FILES 
Projects that were created in VDDT version 4.4c or earlier, that reside in 
another VDDT database, or that originate from other users, need to first be 
imported (File|Import) and saved to the active database before they can be 
accessed with File|Open.  The Import option also allows users to change the 
definition information for an open Project by loading one or more 
customized definition files, or to create Projects based on component files 
from earlier versions of VDDT. 

 

IMPORT A PROJECT 
To import a Project from an *.MDB file: 

1. Select Import|Project|MDB from the File menu. 

2. Using the Select VDDT Database window, browse to the *.MDB that 
contains the project or projects you wish to import, select it and click 
Open. 

3. An Import Project window opens that lists all projects in the selected 
database.  Select the project(s) you wish to import into the active 
database.  Select multiple non-contiguous projects from the list by using 
Ctrl and left-click; select multiple contiguous projects by using Shift and 
left-click.  When you have selected all the projects you wish to import, 
click Import. 
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The selected project(s) will open briefly in the main window as each 
gets integrated into the active database.   

To import a Project from a *.PRJ file: 
1. Select Import|Project|PRJ from the File menu. 

2. Using the Open Project window, browse to the *.PRJ file that contains 
your Project information, select it and click Open. 

The selected Project will open into memory, displaying the pathway 
diagram.  

Note: 
The *.PRJ files contain path information that tells VDDT where the 
associated definition and other project-related files can be found.  If this path 
information is not correct, VDDT will not be able to load the file and will 
generate an error message.  Correct the problem by opening the *.PVT file in 
a text editor such as Notepad; edit the path information so the required files 
can be found.   

 

3. Select Save or Save As from the File menu to integrate the Project 
information into the active database. 

Note: 
When projects with multiple regions are imported from a *.PRJ file, initial 
conditions for only the active region will be included with the import; initial 
conditions for all non-active regions will have to be entered manually 
(Run|Settings|Initial Conditions tab). 

 

Import Definition Files 
With VDDT running and an open Project on the screen, you can change the 
current definition information by loading one or more of your customized 
definition files. 

To load all definition files: 
1. Select Import from the File menu and click on Definitions|All files.  

The program then warns that all files must be in the same directory, have 
the same file extension as each other, and must have the prefixes that are 
listed in the default files.  

2. From the Select one code file window, choose the DISTCODE.* file 
that represents the location and file extension for all of your definition 
files. 

VDDT will proceed to load all five files. If any files are not present in the 
specified location, they are skipped. 
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To load a single type of definition file: 
1. Select Import from the File menu and click on 

Definitions|Disturbances, Cover types, or Structural stages.  

 If Disturbances or Cover types is chosen, two files will be loaded, i.e., 
DISTCODE.* and DISTGRP.* as a pair, and COVER.* and COVERC.* 
as a pair. 

2. Choose the file you want to import and click Open. 

In all cases, the information displayed in the pathway diagram will be 
updated to reflect the new definition information.   

Note: 
Changes to the definitions will not be saved to the database until the project 
itself is saved. 

Import Transitions 
If you wish to make a large number of changes to the transitions in an 
existing Project, you may find it easier to work in Excel rather than VDDT.  
To edit your transitions in Excel, you must first use VDDT to export the 
transitions you wish to edit (see Export Transitions, below); this process 
creates a *.CSV file that can be opened directly in Excel.   

To import transitions to a file: 
1. Open the Project that contains the transitions you wish to edit, and 

export them (File|Export|Transitions and choose Probabilistic or 
Deterministic, depending  upon which type of transition you wish to 
export). The resulting *.CSV file contains all the same information as 
the corresponding MS Access table (i.e., the Probabilistic Transition 
table or the Deterministic Transition table).   

2. Open the resulting *.CSV file directly in Excel, edit as needed and save 
your changes in Excel.   

 To make the transition information easier to edit, the Access column 
headings and ID values in the first seven columns of the *.CSV file, 
which define the Project and its properties, are replaced with meaningful 
text strings.  These text strings are recognized by VDDT when the file is 
imported back into your Project. 

Note: 
It is important to ensure that your edits are consistent with the defined 
properties of the Project into which you are going to import the transitions.  
For example, transitions added to a Project must already be defined 
(File|Properties|Definitions), and combinations of cover type and structural 
stage must correspond with existing classes.  If your edited *.CSV file 
contains any undefined transition or state class information, VDDT will abort 
the import process and display an error message that identifies the first error 
encountered and provides its location in the file.   
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3. Select Import|Transitions|Probabilistic or Deterministic from 
VDDT’s File menu, browse to your modified *.CSV file and click Open 
to import the new transitions into your Project.  VDDT can import the 
transitions for one project at a time.  The target project does not need to 
be open for the import to proceed; VDDT imports the transitions into the 
project identified in the first column of the *.CSV file.   

Note: 
When you import transitions into a Project, the changes are sent directly to 
the database, replacing existing values.  There is no need to explicitly save 
your Project after successfully importing a set of transitions.  If the target 
project is open when you initiate the import process, VDDT will close it 
before implementing the import.  

Import Component Files 
Importing component project files allows users to: 

• change the current definition, PVT, scenario and initial condition 
information for a Project by loading customized definition, PVT, SCN 
and IC files into an open Project, and  

• create new Projects from customized component files. 

In both cases, Import opens the selected files into memory; nothing is saved 
to the database until the user explicitly saves a Project by selecting Save or 
Save As from the File menu.   

To change the current information for a Project: 
1. Open the Project for which you wish to change conditions, and select 

Import from the File menu. 

2. If you wish to change the definition information, select Definitions from 
the Import sub-menu.  You can choose to change all definition 
information (choose All files), or just selected definition information 
(choose Disturbances, Cover types and/or Structural stages).  

3. If you wish to change the PVT information, select PVT from the Import 
sub-menu.  When you elect to change your PVT information, VDDT 
will prompt you to select scenario and location files as well.  

4. If you wish to change just the scenario information for your Project, 
select Scenario from the Import sub-menu and open the SCN file of 
your choice. 

5. If you wish to change just the initial conditions for your Project, select 
Initial Conditions from the Import sub-menu and open the IC file of 
your choice.   

To create a Project from component files: 
1. If you have a Project open on the screen, close it.  From the Import sub-

menu, select Definitions|All files.  
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2. From the Select one code file window, choose the DISTCODE.* file 
that represents the location and file extension for all of your definition 
files. 

3. From the Import sub-menu, select PVT.  VDDT will open a series of 
windows from which you must choose PVT, scenario (SCN) and 
location (LOC) files for your Project.   

 When done, the Project defined by the selected files will open into 
memory, displaying the pathway diagram.   

4. If you wish, you can also import initial conditions for your Project by 
selecting the Initial Conditions option from the Import sub-menu.   

5. Select Save or Save As from the File menu to integrate the Project 
information into the active database. 

IMPORT MULTIPLIERS 
Use this option to import transition and temporal multipliers into a Project 
and integrate them into the active database.   

To import transition multipliers: 
1. Open the Project into which you wish to import transition multipliers.   

2. From the File menu, select Import|Multipliers|Transition.  Navigate to 
and open the *.MLT file that contains your transition multipliers and 
click Open. 

3. You can view the multipliers you just imported under VDDT’s Run 
menu (see about Optional Run Settings).   

Earlier versions of VDDT also stored area limits in the *.MLT file, and these 
can still be imported from this file type. 

To import temporal multipliers: 
1. Open the Project into which you wish to import temporal multipliers.   

2. From the File menu, select Import|Multipliers|Temporal and choose 
either the CSV or MCM option, depending upon the type of file you 
have used to save your temporal multipliers. The process of importing 
temporal multipliers replaces all existing temporal multipliers in the 
open Project, so a warning message will appear.  Click Yes to continue. 

3. Navigate to and open the *.CSV or *.MCM file that contains your 
temporal multipliers and click Open.  A message will appear confirming 
the import, reporting the number of multipliers loaded, and identifying 
any errors that occurred.  

Note: 
An accessory program for generating complex multipliers streams, named 
BUILD_MCM, is explained in Appendix F of the User Guide. 
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4. You can view the multipliers you just imported under VDDT’s Run 
menu (see about Optional Run Settings).   

Note: 
If the file containing the temporal multipliers being imported contains 
transition types or run settings (e.g., number of timesteps or number of 
Monte Carlo simulations) that do not match those of the destination Project, 
errors may be reported.  For example, if a file containing multipliers for 1000 
timesteps is imported into a Project with only 100 timesteps, the import 
confirmation message will report that 900 lines of the import file were 
skipped.  However, if a file containing multipliers for 100 timesteps is 
imported into a Project with 1000 timesteps, 100 multipliers will be imported 
and no error will be reported. 

IMPORT ATTRIBUTES 
Use this option to import calculated, categorical or numeric attributes into a 
Project so they can be used in the next simulation.   

To import attributes: 
1. Open the Project into which you wish to import attributes.   

2. From the File menu, select Import|Attributes.  Navigate to and open 
the *.ATT file that contains your attributes and click Open. 

3. You can view the attributes you just imported under VDDT’s Run menu 
(see about Optional Run Settings).  

EXPORTING PROJECTS AND FILES 
Users can share their Projects and project-related information files with 
others by exporting them using the Export option under the File menu.  
Additionally, Projects can be exported to a database, or to a series of files 
suitable for importing into TELSA, or as comma and quote delimited files 
that can be imported into other applications such as Microsoft Access or 
Excel. 
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Export a Project 

To export a Project to *.MDB: 
1. Select Export|Project|MDB from the File menu.  This action opens an 

Export Projects window that contains a list of all projects in the active 
database. 

2. Select the project(s) you wish to export. You can select multiple non-
contiguous projects from the list by using Ctrl and left-click; select 
multiple contiguous projects by using Shift and left-click.  When you 
have selected all the projects you wish to export, click Export. 

3. Using the Select VDDT Database window, navigate to and select the 
database into which you wish to export the project(s).  If you want to 
create a new database for the exported project(s), simply type a name for 
the new database into the File Name field.  Click Open. 

 The selected project(s) will open briefly in the main window as each 
gets integrated into the active database.   

To export a Project to *.PRJ: 
1. Open the Project you wish to export (File|Open); this action enables all 

options under the Export sub-menu. 

2. Select Export|Project|PRJ from the File menu. 

3. Using the Save Project File As window, browse to the location in which 
you want to save your Project file; enter a name for it (the extension 
should be PRJ) and click Save. 

The export process creates a folder, at the chosen location, bearing the 
Project’s name and containing text files with all of the information about the 
Project that is stored in the database.  This information is exported in the 
form of the text definition files associated with the Project, plus an initial 
conditions file (*.IC), a PVT file, scenario and location files.  If sharing a 
Project, users need to send these plus any advanced external files, such as 
attribute files (*.ATT), to make the exported Project complete.  The database 
only stores information about the location of advanced files, not the 
information itself. 

Export Definition Files 
You can also export the definition files associated with any Project using the 
Export option under the File menu.  Exported definition files can be used as 
a template for creating new definition files, or shared with other users. 

To export all definitions files: 
1. Open the Project whose definition files you wish to export (File|Open); 

this action enables the export option. 

2. Select Export|Definitions from the File menu; this action opens a series 
of Save As windows, one for each of the 5 definition files to be saved.  
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The definition information for each file is saved from memory rather 
than taken from the database. 

3. Enter names for your definition files in the File Name field of each Save 
As window, and click Save. 

Export Transitions 
If you wish to make a large number of changes to the transitions in an 
existing Project, you may find it easier to work in Excel rather than VDDT.  
Use the Export|Transitions option under the File menu to create a *.CSV 
file of your transitions that can be opened directly in Excel for editing and 
then imported back into your Project (File|Import|Transitions) (see Import 
Transitions topic, above).  VDDT can export the transitions for one project at 
a time. 

To export transitions to a file: 
1. Open the Project that contains the transitions you wish to edit; this 

action enables the export option. 

2. Select Export|Transitions, and then choose to export either the 
Probabilistic or the Deterministic transitions associated with the 
Project. 

3. Using the Export Transitions window, browse to the folder in which 
you wish to save the file and click Save. 

VDDT will export the transitions associated with the open Project to a *.CSV 
file; this file contains all the same information as the corresponding MS 
Access table (i.e., the Probabilistic Transition table or the Deterministic 
Transition table).  To make the transition information easier to edit, the 
Access column headings and ID values in the first seven columns of the 
*.CSV file, which define the Project and its properties, are replaced with 
meaningful text strings.  These text strings are recognized by VDDT when 
the file is imported back into your Project. 

Export Probabilities Files 
VDDT allows users to save probability information about their Projects for 
later reference, or as output for subsequent processing in graphical or 
statistical programs. The probability file is an ASCII file which combines 
most of the information in the Project file into a new file which may be 
printed and used for examining the pathways and probabilities.  

To export a probabilities file: 
1. Open the Project that contains the probabilities you wish to export 

(File|Open); this action enables the export option. 

2. Select Export|Probabilities from the File menu. 
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3. Using the Save Probabilities As window, browse to the location in 
which you want to save your probabilities file; enter a name for it (the 
extension should be PRB) and click Save. 

Export Initial Conditions Files 
The initial conditions file contains information about structural stage, cover 
type, age, TSD (optional), and the proportion of cells for each combination of 
these.  Use Export|Initial Conditions to create a file (*.IC) that can be 
imported into other Projects. 

To export initial conditions to a file: 
1. Open the Project that contains the initial conditions you wish to export 

(File|Open); this action enables the export option. 

2. Select Export|Initial Conditions from the File menu. 

3. Using the Save Initial Values As window, browse to the location in 
which you want to save your initial conditions file; enter a name for it 
(the extension should be IC) and click Save. 

EXPORT MULTIPLIERS 
Use this option to export transition and temporal multipliers from a Project 
so you can import them into other Projects as needed.   

To export transition multipliers to a file: 
1. Open the Project from which you wish to export transition multipliers 

(File|Open); this action enables the export option. 

2. From the File menu, select Export|Multipliers|Transition.   

3. Using the Save Multipliers As window, browse to the location in which 
you want to save your transition multipliers file; enter a name for it (the 
extension should be MLT) and click Save. 

To export temporal multipliers to a file: 
1. Open the Project from which you wish to export temporal multipliers 

(File|Open); this action enables the export option. 

2. From the File menu, select Import|Multipliers|Temporal|CSV.  This 
action opens the Export Temporal Multiplier window. 

3. Browse to the location in which you want to save your temporal 
multipliers file, enter a name for it (extension *.CSV) and click Save.  

EXPORT ATTRIBUTES 
Use this option to export calculated, categorical or numeric attributes from a 
Project so you can import them into other Projects as needed.  The resulting 
attribute files define the structure and values of the Project’s attributes. 
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To export attributes to files: 
1. Open the Project from which you wish to export attributes; this action 

enables the export option.   

2. From the File menu, select Export|Attributes.   

3. Using the Save Attribute File As window, browse to the location in 
which you want to save your attributes file; enter a name for it (the 
extension should be ATT) and click Save.  

Export as TELSA-ready Files 
Two specialized exporting options are included with VDDT: exporting for 
the CRB Paradox Database (see below) and exporting for TELSA.  

The TELSA export option produces three comma-delimited files that can be 
read by the TELSA interface and imported into the TELSA database (see 
Appendix D for the file format). 

To export files in TELSA-ready format: 
1. Open the Project for you wish to export TELSA-ready files (File|Open); 

this action enables the export option. 

2. Select Export|TELSA from the File menu.  This option generates 3 text 
files (TX1, TX2 and TX3). 

3. Using the Save Files In Telsa-Ready Format As window, browse to 
the location in which you want to save your files; enter names for each 
in turn and click Save. 

Export as Comma Delimited Files 
Two specialized exporting options are included with VDDT: exporting for 
the CRB Paradox Database and exporting for TELSA (see above).  

The CRB Paradox Database format files are two comma and quotation mark 
delimited files (PDX and PSC) containing the information from the Project 
file, and are in a format that can be directly entered into the Paradox database 
without further processing (see Appendix D for the file format). To use this 
option, select Export and then Comma-delimited from the File menu, enter 
names for the files and Save them. 

PROJECT PROPERTIES 
Use the Properties option under the File menu to review or modify 
information about Definitions files, review the list of Associated Filenames, 
or review/edit the Project Name and Description.  
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Project Name and Description 

To view/edit a Project’s name and description: 
1. With an open Project on the screen, select Project Name and 

Description from the File menu.  The Project Name And Description 
dialog opens. 

 
2. The Project Name and Description of the open Project can both be 

edited. 

3. Click OK when done or Cancel to abandon your changes and return to 
the pathway diagram. 

Defining Regions 
Use the Regions option on the File|Properties sub-menu to create new 
regions for your Project, to rename existing regions, and to delete regions 
you no longer want. 
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To create a new region: 
1. Select Properties from the File menu and then Regions. Click on the 

New button.  

  
2. Enter a new name, with no spaces, into the box that appears.  

  
3. Click on the OK button to save the information to memory, or Cancel to 

abandon the process of adding a new region.  Both actions will close the 
New Management Region window and return you to the pathway 
diagram. 

The new region will be added to the information in memory, and will be part 
of the Project when it is next saved. Note that this new region will contain no 
probabilities at the time it is created.  

To edit region names: 
1. Select Properties from the File menu, and then Regions.  

2. Highlight the region to be renamed with a left-click, and click on 
Rename to edit the name of the selected region (no spaces).   

3. Click OK to close the screen and return to the pathway diagram.  

When the name of the currently active region is changed, the change will 
appear in the Status window. 

To delete an existing region: 
1. Select Properties from the File menu, and then Regions.  

2. Highlight the region to be deleted with a left-click, and click on Delete 
to remove the selected region from your Project.  
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Definition Properties 
Use the Properties option under the File menu to edit the names and 
abbreviations of your cover types, structural stages, transitions and transition 
groups.  You can also use this option to create new definitions and to remove 
unwanted definitions from Projects.  

 

To edit definition names and abbreviations: 
1. Select Properties from the File menu and then Definitions to open the 

Definitions dialog. 

2. Change names and abbreviations for cover types, stages and transitions 
by typing into the selected field.  Codes cannot be edited. 

3. Click OK when done.  The pathway diagram will be updated to show 
your changes to cover type and stage. 

4. Save your changes (File|Save). 

To add/remove transition types associated with transition 
groups: 

1. Select Properties from the File menu and then Definitions to open the 
Definitions dialog. 

2. Click on the Transition Groups tab and left click to select the transition 
group for which you wish to change the associated transition types.   

3. Click on the Types button.  The Types for Transition Group dialog 
shows the selected transition group in the Transition group name field, 
the Available transition types in the left pane and the types currently 
associated with the selected group in the Selected transition types pane 
on the right.  In the example below, the selected Commercial_Thin 
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transition group contains transition types Commercial_Thin&Burn and 
Commercial_Thin. 

 
4. Move transition types between the left and right panes using the arrows 

in the center of the dialog until you have all the types you want to 
associate with the selected group showing in the right-hand pane.   

To create new definitions: 
1. Select Properties from the File menu and then Definitions to open the 

Definitions dialog. 

2. Click on the tab that contains the type of definition you want to create 
and click New. 

3. A new row, with an automatically generated code, will appear in the grid 
(this code can be edited); enter an abbreviation and/or a name 
(depending on the type of definition you are creating), and click OK.  
Integrate the new definition into your Project using the Diagram menu. 

Note: 
VDDT can accommodate up to 30 transition groups and 99 structural stages; 
more than this will prompt a warning message to display.  

To delete a definition: 
1. Select Properties from the File menu and then Definitions to open the 

Definitions dialog. 
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2. Click on the tab that contains the definition you want to delete, select the 
definition (click in any cell in the row) and click Delete.  

Note: 
You cannot delete a definition that is used in the current Project.  If you try to 
do so, a warning message will appear prompting you to edit your model so 
that the definition you wish to delete is no longer being used.  Click Cancel 
to abandon the deletion or OK to return to the Definitions dialog.  

Managing Associated Files 
Use the Properties option under the File menu to review the list of 
Associated Filenames related to the currently open Project.  Associated files 
can be removed from the Project by deleting them from the associated files 
list. 

 

To delete an associated file from a Project: 
1. Select Properties from the File menu and then Associated Files to open 

the Associated Filenames dialog. 

2. Click on the Filename of the file to be deleted and hit the Delete key on 
your keyboard.   

3. Click OK to close the dialog.  A message will appear warning that the 
deletion will not take effect until you save and re-load the Project file. 

CHANGING DATABASES 
To change the active VDDT database: 

1. From the File menu, select Database to open the Select VDDT 
Database window. 

2. Navigate to and select the database with which you wish to work.  Click 
Open.  You can now use File|Open to open any of the Projects in the 
new database. 
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EXIT VDDT 
When your VDDT session is over, select Exit from the File menu to close 
VDDT.  You will be prompted to save your Project if you made any changes 
during the session. 

Diagram Menu 
Existing Projects can be edited to add information to them, or to create new 
Projects based on existing ones.  Using the Diagram menu, the cover type 
and structural stage of each class can be changed, new classes can be added, 
and classes can be deleted. Pathways for both deterministic and probabilistic 
transitions can also be edited, created, or deleted. At any point, the Project 
file may be saved (Save or Save As under the File menu), and/or the new 
information can be applied to a new simulation run. 

 

DRAWING AND EDITING PATHWAYS 
In most pathway diagrams, it is virtually impossible to actually trace each 
pathway when all are displayed. The model allows users to display all or a 
specified subset of pathways.  Users can choose to display: 

• certain probabilistic transitions or combinations of probabilistic 
transitions, 

• pathways with or without defined probabilities, or 

• all the pathways to or from a certain class. 

To display the pathways for the entire Project: 
1. From the Diagram menu, select Redisplay Pathways. A dialog box 

will open listing all probabilistic transitions defined for the Project. 

2. Users can display all transitions by selecting All Transitions (both 
probabilistic and deterministic).  When this option is enabled, the option 
to view only Deterministic Transitions and the list of Available 
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Probabilistic Transition Groups are disabled.  Alternatively, users can 
specify certain probabilistic transition groups, with or without 
Deterministic Transitions, by de-selecting All Transitions and then 
moving selected groups across to the right-hand side of the screen.  In 
the example below, deterministic transitions have been selected as well 
as three probabilistic transitions.   

 
3. The bottom of the Redisplay Pathways dialog box allows users to filter 

pathways based on whether or not a probability has been defined. The 
options are to draw: 

• All pathways which fit the criteria chosen in the upper part of 
the dialog box; 

• those pathways which fit the criteria and which have a 
probability defined (No zero probabilities); or 

• those pathways which fit the criteria but which have either no 
defined probability or a zero probability (Only zero 
probabilities). 

In the example above, pathways for deterministic transitions and three 
probabilistic transitions (Bark_Beetle, Fuel_Buildup and Under_Burn) will 
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be displayed in the pathway diagram, provided they have a probability 
defined in the current scenario file and the current region. Note that the 
transition groups listed in the dialog are those defined by the user in the 
DISTGRP.TXT file. 

Note: 
If either of the last two options are selected (those pathways that have a 
probability or those that do not have a probability), the model will look at the 
probabilities defined for the current region only. If no region has been 
selected, the probabilities from the first region entered will be used. 

 

When done, the selected items will be indicated at the top of the TPD 
window, and only those pathways will be drawn. The program will 
remember this selection until it is changed by the user or until a new Project 
is loaded. 

 
 

To show all the pathways to or from a particular class: 
1. Move the mouse over the box of interest and click the RIGHT button.  

  
2. From the resulting context-sensitive menu, select the Show Class 

Pathways option. The selected class will be highlighted (yellow on most 
computers), and only the transitions to and from that class will be 
displayed. 
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3. To redisplay pathways from all boxes, right-click anywhere on the 
pathway diagram and select Show All Pathways from the context-
sensitive menu.  Alternatively, you can redisplay all pathways by 
resizing the pathway window a small amount or by selecting Redisplay 
Pathways from the Diagram menu and clicking OK. 

DETERMINISTIC TRANSITIONS 
The Deterministic Transitions option under the Diagram menu provides an 
overview of the deterministic transitions defined for all classes in your 
Project. 

To view/edit deterministic transitions for a Project: 
1. Select Deterministic Transitions from the Diagram menu.  The 

Deterministic Transitions dialog opens to show all deterministic 
transitions that have been defined for the active Project. 
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2. You can edit values for Start Age, End Age and destination class (Box).  
The program will check to ensure that the letter that is entered in the Box 
field represents a class that is currently part of the diagram.  If you 
change the destination class, the Cover and Stage information will 
update to correspond to information about the new class. 

3. Click Apply to save your changes to memory and keep the dialog open; 
click OK to save your changes to memory and close the dialog.  Your 
changes will be reflected in the pathway diagram.  Click Cancel to 
abandon your changes and return to the pathway diagram.  

To sort deterministic transitions for a Project: 
1. Select Deterministic Transitions from the Diagram menu.  

2. Click on the Sort button to open the Sort dialog.   

  
 

3. Select the sort fields from the drop-down lists.  You can sort by up to 
four fields, in either ascending or descending order. 

4. Click OK to return to the Deterministic Transitions dialog and your 
sorted list of transitions. 

PROBABILISTIC TRANSITIONS 
The Probabilistic Transitions option under the Diagram menu provides an 
overview of the probabilistic transitions defined for all classes in your 
Project. 

To view/edit all of the probabilistic transitions for a Project: 
1. Select Probabilistic Transitions from the Diagram menu.  The 

Probabilistic Transitions dialog opens to show all probabilistic 
transitions that have been defined for the active Project.  If the active 
Project has only one region, no Region column will appear in the grid. 
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2. You can edit values for origin class (Box), Transition Type, probability 
(Prob), proportion (Propn), and destination class (Box).  The program 
will check to ensure that letters entered into the Box fields are classes 
that are currently part of the diagram.  If you change either the origin or 
destination classes, the Cover and Stage information will update to 
correspond to information about the new class. 

3. Click Apply to save your changes to memory and keep the dialog open; 
click OK to save your changes to memory and close the dialog.  Your 
changes will be reflected in the pathway diagram.  Click Cancel to 
abandon your changes and return to the pathway diagram.  

To sort probabilistic transitions for a Project: 
1. Select Probabilistic Transitions from the Diagram menu.  

2. Click on the Sort button to open the Sort dialog.   

3. Select the sort fields from the drop-down lists.  You can sort by up to 
four fields, in either ascending or descending order. 

4. Click OK to return to the Probabilistic Transitions dialog and your 
sorted list of transitions. 

CLASS PROPERTIES 
Changes to pathways are made in the Class Properties dialog box which 
lists all the information about the pathways associated with a class. If any 
changes are made in this box, the last line in the Status window will change 
to read Modified. 
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Each pathway has an origin, a destination, and either a transition probability 
or a transition period. This information can be changed, and pathways can be 
added or deleted.  For example, the probabilities for a particular agent in a 
single pathway may be modified.  This is useful for choosing initial 
probabilities, setting probabilities which change for different classes, and for 
making subtle refinements to probabilities.   

To open the class properties dialog box: 
1. With a pathway diagram open on the screen, double-click the left mouse 

button on the box representing the class of interest; *OR* 

2. Select Class Properties from the Diagram menu, and enter the letter of 
the class of interest; *OR* 

3. Right-click on the box representing the class of interest, and select Class 
Properties from the context-sensitive menu. 

The Class Properties dialog for the selected class box will appear, showing 
all the pathways going away from the class.  To view pathways to the class, 
click the To Class radio button in the Display Pathways section of the screen. 

 
Note: 
You can have multiple Class Properties screens open at one time. 
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Changing Pathway Information 
Probabilities, destinations, probabilistic transition agents, relative ages, and 
deterministic transition information may all be changed in the Class 
Properties dialog box (Diagram menu).  In the top right corner of the 
dialog, the class identifier is shown along with the cover type and structural 
stage of the class.  Below this is the Display Pathways section of the dialog, 
with which users can choose to view information about pathways going from 
the class (From Class) or to the class (To Class).   

The information in the dialog is divided into two main sections. The top 
section contains the deterministic transition information and the bottom 
section contains a grid showing all the probabilistic transition information.  

From Class Pathways 
Deterministic and probabilistic transition information from a selected class 
is presented in the Class Properties dialog (Diagram menu). 

Deterministic Transitions 
The deterministic part of the dialog box shows: 

• the start and end age of the class, 

• the destination after deterministic transition, and 

• the cover and structural stage of the destination class. 

The cells for start/end age and destination class can be edited. 

The destination for the deterministic transition pathway is the letter identifier 
of the target class. The program will check to ensure that the letter that is 
entered is a class that is currently part of the diagram. 

Note: 
Changing the deterministic transition destination may change the location of 
the current class in the diagram (unless the locations are being set manually). 

The beginning age of the class is used by the model to provide a value from 
which to start incrementing the number of years a cell has been in the class 
and for determining when each probability is valid. It is also presented as a 
reference, to help users picture the class and define probabilities. 

Each class must go somewhere through deterministic transition. If the class is 
considered an endpoint, and cells would only leave that class through a 
probabilistic transition, it should be given a large number of years to stay in 
the class, and then should go to itself through deterministic transition. For 
example, if Class F is an endpoint, the deterministic transition part of the 
dialog box might look like: 
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If the beginning age of the class or the number of years in the class are 
changed, VDDT will ask if the probabilistic transition information should 
also be updated. If so, it will change the beginning age of all probabilistic 
transitions that had the original class starting age and it will change the 
ending age of all probabilistic transitions that had the original class ending 
age. 

Note: 
If VDDT does not automatically update the ages of some probabilistic 
transitions, check to ensure that the transition ages are still within the range 
of the class. Probabilistic transitions with ages outside the class range will 
not occur. 

Probabilistic Transitions 
Each row of the probabilistic part of the dialog box represents a different 
pathway, and can be sorted by up to 4 fields.  The columns are as follows: 

Column Description 

Region: Region name. For Projects with multiple regions, 
the first column in the grid will show the region 
name; this information cannot be edited.  A Project 
with three regions and three transition types will 
have 9 rows in the grid, one for each 
region/transition type combination.   

 
 By default, columns will be wide enough to show 

the entire region name. Columns may be resized to 
hide part of the name and allow more columns to 
be visible on the dialog box without scrolling. 
Management region names can also be shortened 
using the Properties|Regions option under the File 
menu. 

 The Region column will not display for Projects 
with only one region defined.   

Transition Type: Probabilistic transition type.  This column displays 
the transition type for each pathway.  To change 
the transition type, click on the transition to be 



VDDT 6.0 User Guide 

48 

changed and open the drop-down list; select an 
alternative transition.   

Prob: The probability of the transition pathway 
occurring. New values (less than or equal to one) 
can be entered into these cells.  Probabilistic 
transitions will not occur in a particular region if 
the probability is zero. 

Propn: Proportion.  This field is used to help represent 
multiple branching pathways associated with a 
single transition type out of a class. For example, 
suppose that there is a probability of 0.1 that a 
"Fire" transition may occur in a particular class, 
and that there are 2 possible pathways out of this 
class associated this "Fire" transition type, each 
with a 50% chance of occurring. In this situation, 
both pathways can be assigned the same value for 
Prob (i.e., 0.1), and then each pathway is assigned 
a Propn. of 0.5.  When the model actually runs, 
VDDT will calculate the effective probability for 
each of the branching pathways as Prob X Propn.  
If you do not wish to use this feature, set Propn to 
1 for all transitions. 

Prob x Propn: Probability times Proportion.  This is the value 
actually used by the VDDT model for calculating 
transitions – it is a calculated value used by the 
model, and can only be changed by editing either 
the Prob or Propn values.   

 Try to ensure that the total of all Prob X Propn 
values leaving a class does not exceed 1.  Where 
the sum of all probabilities exceeds 1, the 
probabilities will all be adjusted downwards.  This 
is due to the fact that only one probabilistic 
transition per cell per year is allowed. 

To Class: Pathway destination, cover and stage information. 
If a different letter is entered into the Box column 
of this section in the grid, the destination of the 
probabilistic transition will be changed and the 
cover and stage information updated to match.  

Probabilistic Transitions – Ages 
By default, transition probabilities apply to the entire class for which they are 
defined. These probabilities can, however, be made to apply only to a 
selected range of ages within the class. Thus, different probabilities can be 
assigned to the same transition type, as long as the ages do not overlap. 
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To view/edit the age information: 
1. On the Class Properties dialog, click in the Ages box to enter a 

checkmark there.  Four new columns will appear – Min Age, Max Age, 
Rel. Age and Keep Age. 

 
 

Column Description 

Min Age: The minimum age at which the probabilistic 
transition can occur. Note that the minimum age 
cannot be less than the beginning age of the class, 
and that the age can differ between management 
regions. 

Max Age: The maximum age at which the probabilistic 
transition can occur. Note that the maximum age 
cannot be greater than the sum of the beginning 
age and the number of years in the class, and that 
the age can differ between management regions. 

Rel. Age: Relative age. Relative age means slightly different 
things, depending on the type of pathway. In both 
cases, however, the relative age is a number of 
years, not an age. 

 Pathways starting and ending in different 
classes: 
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 After this type of probabilistic transition, the model 
assumes that the cell enters the new class with an 
age equal to the beginning age of that class. The 
relative age tells the model that after this 
probabilistic transition, the cell will enter the new 
class with a higher age (i.e., beginning age plus 
relative age) and thus will stay in the new class for 
a shorter period than it would otherwise. Relative 
ages can only be positive in this case. 

 Pathways starting and ending in the same class: 

 In this case, the probabilistic transition does not 
change the cell’s class but it either advances or 
delays its deterministic transition to the next class. 
A positive relative age shortens the amount of time 
that the cell will remain in that class (i.e., 
deterministic transition is moved forward). A 
negative age allows the cell to remain in that class 
longer (i.e., deterministic transition is set back). 

 In both cases, the age of the cell is bounded by the 
age limits in that class. A cell in a class can never 
be younger than the beginning age of the class, and 
can never be older than the ending age of the class 
(beginning age plus the number of years in the 
class). 

Keep Age: Keep the relative age?  If true, when the 
probabilistic transition occurs, the relative age, i.e., 
the number of years that the cell has been in the 
class, will not change even if the class changes.  
Note that this has no effect on pathways that start 
and end in the same class. 

 
Note: 
If using two pathways that begin and end in the same class, and are the same 
transition type, do not use different relative ages or a different value for the 
keep age flag. The Project file saves only one version of the pathway, and 
will therefore save only one relative age and relative age flag. 

Probabilistic Transitions – TSD 
The probability of some transitions occurring may depend on the time 
interval since a previous set of probabilistic transitions. In VDDT, these 
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types of relationships can be defined using the TSD (Time Since 
Disturbance) columns of the grid. 

To display the TSD columns: 
1. On the Class Properties dialog, click in the TSD box to enter a 

checkmark there.  Three new columns will appear in the grid – Min TSD, 
Max TSD, and Rel. TSD.   

 
 The TSD columns allow users to define when a probabilistic transition 

can occur relative to other transitions in associated groups (associations 
are set using Run|Settings|Options), and how the transition will impact 
the TSD of the affected cell.  For example, a user could define that 
eradication of knapweed via chemical control can occur in a cell up to 3 
timesteps following knapweed invasion.  Alternatively, application of 
herbicides may fail to eradicate knapweed but prolong the time which it 
takes for knapweed to become established in the cell by 2 time steps 
(Rel. TSD -2).   

Column Description 

Min TSD: The minimum number of timesteps following the 
occurrence of any probabilistic transitions 
belonging to the transition’s associated TSD Group 
(Run|Settings|Options) after which the 
probabilistic transition can occur. For example, a 
Min TSD of 4 means that a particular chemical 
treatment pathway can only occur after 4 timesteps 
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have elapsed following an initial knapweed 
invasion.  

Max TSD: The maximum number of timesteps following the 
occurrence of any probabilistic transitions 
belonging to the transition’s associated TSD Group 
(Run|Settings|Options) after which the 
probabilistic transition cannot occur. For example, 
a Max TSD of 5 means that a particular chemical 
treatment pathway cannot occur after 5 timesteps 
have elapsed following an initial knapweed 
invasion.   

Rel. TSD: This value defines how transitions affect the TSD 
of a cell when they occur.  For example, if a 
particular chemical treatment has a Rel. TSD value 
of -2, it will reduce the TSD for the affected cell by 
2 timesteps following the treatment for any 
probabilistic transition groups to which the 
transition type belongs.  A Rel. TSD value of -9999 
sends the cell back to TSD of 0. 

 Multiple TSD data lines may be used to portray a more complex 
relationship. For example, following a fuel treatment, the probability of 
a stand replacement fire may be only 0.5% per year. This probability 
may double after 15 years without a treatment and increase to 100% 
after 30 years without a treatment. This could be modeled using three 
TSD data lines containing the same transition type. These lines would 
have the Min/Max TSD variables set to 0/14, 15/29, and 30/9999 years 
and the annual probabilities set to 0.005, 0.01, and 1, respectively. 

Note: 
VDDT does not use TSD values by default.  Time since disturbance must be 
turned on (Run|Settings|Options) before the TSD values will be used during 
a run.   

Probabilistic Transitions – Manage Rows 
Probabilistic transitions can be added to and removed from the grid, and they 
can be sorted.   

To add rows to the grid: 
1. On the Class Properties dialog, click on the New or Copy buttons to 

add rows to the bottom of the grid.   

2. For new rows, the Transition type and destination Box must be filled in.  
Default values for probability (0) and proportion (1) will be entered by 
VDDT if not specified by the user.  For copied rows, edit the existing 
values as required. 

 For Projects with multiple regions, the New and Copy buttons add one 
row to the grid for each defined region.  For example, if a Project has 3 
regions, 3 rows will be added to the grid.   
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To remove rows from the grid: 
1. On the Class Properties dialog, select the row to be removed and click 

Delete. 

 For Projects with multiple regions, the Delete button removes the 
selected pathway for all regions.  

To sort rows in the grid: 
1. On the Class Properties dialog, click the Sort button; this action opens 

the Sort screen.  

2. Choose the sort order from the drop-down lists in each section of the 
screen.  You can sort in ascending or descending order by Region, 
Transition Type, destination class (Box), Cover and structural Stage.  Up 
to 4 sort fields can be set. 

Save class properties information 
When finished with all edits, click on the OK button to save all the changes 
to memory and close the Class Properties dialog. Alternatively, you can 
save your changes to memory without closing the dialog by clicking Apply.  
These actions do not save your changes to the database; to do so, you need to 
save your Project (File|Save or File|Save As). If the OK button is selected, 
the Status window will change to Modified, even if no changes have been 
made. 

The Cancel button (or the ESC key) allows users to leave the dialog box and 
ignore all changes.   

To Class Pathways 
By default, the Class Properties dialog box shows all the pathways which 
originate in a class.  

To view pathways to a class: 
1. On the Class Properties dialog (Diagram menu), click the To Class 

radio button.  A message will appear warning that any changes made in 
the From Class view of the dialog box will be lost, and the user will be 
given the option of saving the changes.  

2. The To Class view shows all deterministic and probabilistic transition 
pathways entering the class.  This information is read-only.  
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The To Class view is essentially the same as the one showing the pathways 
from a class. The only differences are: 

• more than one deterministic transition pathway can go to a single class, 
and each will be shown, 

• the letters in the Box column are now those of the originating class (the 
class from which the pathway started), and 

• transition pathways cannot be edited, added or removed. 

CREATING NEW CLASSES 
New classes may be added to a pathway diagram using the Diagram menu. 

To add a new class: 
1. Choose New Class from the Diagram menu. The New Class dialog box 

will appear with fields in which to enter the class cover type, and 
structural stage of the new class. A letter, which will be the assigned 
label of the new class, will appear in the first cell. This letter is the first 
letter of the alphabet that is not used in the diagram. Users cannot 
change this letter. 
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2. Enter the cover type and structural stage by selecting from the drop-

down lists. 

3. Click on the OK button (or hit the Enter key on the keyboard) to save 
your edits to memory and add the new class to the pathway diagram.  
Alternatively, you can select the Cancel button (or the ESC key) to exit 
the dialog box without saving any changes.  

The program will give a warning message if the cover type and structural 
stage combination is the same as an existing class, and a different cover type 
or structural stage must be chosen. 

You are now ready to add the deterministic and probabilistic transitions 
which start in the new class (see about Class Properties).  

COPYING CLASSES 
Existing classes can be copied and used as a basis for adding new classes to a 
pathway diagram. 

To copy a class: 
1. Choose Copy Class from the Diagram menu. 

 
2. Enter the letter of the class to be copied. A dialog box will appear which 

contains fields showing a new class letter, and the cover type and 
structural stage of the class you are copying. 

3. Change the structural stage and/or cover type by selecting from the 
options in the pull-down lists. 

4. Click on the OK button (or hit the Enter key on the keyboard) to save 
your edits to memory and add the new class to the pathway diagram.  
Alternatively, you can select the Cancel button (or the ESC key) to exit 
the dialog box without saving any changes.  
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The program will give a warning message if the cover type and structural 
stage combination is the same as an existing class, and a different cover type 
or structural stage must be chosen. 

When a class is copied, all pathways and probabilities associated with the 
class are also copied, but attributes are not. 

DELETING CLASSES 
An entire class, and all the transitions which leave from the class, can be 
removed from the Project. 

To delete a class: 
1. Select Delete class from the Diagram menu. 

2. Enter the letter of the class to be deleted. If pathways exist whose 
destination is the deleted class, then VDDT will highlight all the 
pathways going to and from that class and give a warning message 
stating that some pathways from another class need to have a new 
destination. 

3. If new deterministic transition destinations are required, VDDT will 
open a Deterministic Transitions dialog and if new probabilistic 
transitions are required, VDDT will open a Probabilistic Transitions 
dialog box.  In either case, the values that correspond to pathways going 
towards the class to be deleted will be highlighted. The destination on 
these pathways must be changed. Users may either specify a new 
destination (by entering a new destination class) or, in the case of a 
probabilistic transition, choose to delete the pathway.  If alternate 
destinations are not entered for all pathways to the class chosen for 
deletion, the class will not be deleted.   

4. Click on the OK button to leave the pathways dialog. The pathways 
diagram will redraw with the new pathway destinations.  

If there are no pathways to the class chosen for deletion, the class will simply 
be deleted. 

EDITING COVER AND STAGE 
Class information may be changed using the Diagram menu.  

To edit class cover and stage information: 
1. Choose Edit Cass Cover and Stage from the Diagram menu. The Edit 

Class dialog box will appear which contains fields in which to enter the 
class letter, the cover type, and the structural stage. 

2. Enter the letter of the class to be edited. The cover type and structural 
stage of that class will automatically appear in the appropriate cells. 
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3. Change the structural stage and/or cover type by selecting from the 

drop-down list. 

4. Click on the OK button (or hit the Enter key on the keyboard) to save 
your edits to memory or select the Cancel button (or the ESC key) to 
exit the dialog box without saving any changes. The program will give a 
warning message if the cover type and structural stage combination is 
the same as an existing class, and a different cover type or structural 
stage must be chosen. 

Edits to cover and/or structural stage will be reflected in the labels on the 
class box in the pathway diagram. 

SETTING LOCATIONS 
When you have finished adding classes to your pathway diagram, you can 
define the location of those classes in the diagram using the Set Locations 
option under the Diagram menu. 

When a class is read from the Project file, when a new class is created, or 
when the structural stage or cover type of a class is edited, VDDT determines 
the class’s location based on its deterministic transition pathway. In many 
cases, especially if there are few cover types, the resulting diagram is 
readable and usable. Some Projects are complicated: using many cover types 
and classes. The resulting diagram in these cases may be quite difficult to 
read. 

To change the locations of one or more classes in the diagram: 
1. Select Set Locations from the Diagram menu. 

2. Type in the number of rows you would like to display. The minimum 
possible number of rows is the current number of rows showing. The 
Transition Pathway Diagram will redraw itself and show all the possible 
locations for classes (given the number of rows requested), the current 
class locations, and the transition pathways. 

Note: 
While many rows are possible, only eight (8) columns can be used. If some 
of the final columns are not used in the diagram, they will be hidden after all 
the locations are assigned. 
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3. To change the location of a class, left-click the class whose location is to 
be changed and then left-click on the desired location. The class 
information will move to the new location. This can be done for as many 
classes as necessary, and classes can be moved more than once. 

Note: 
The deterministic transition pathways are not redrawn. Since these are tied to 
the class and not to the class’s location, their information is still correct, and 
they will be drawn properly after the location setting is done. [If the dialog 
box is resized, the pathways may be redrawn, but some of the information 
may be temporarily lost. The information will be restored after location 
setting is done.] 

 

4. The menu item Set Locations now has a check-mark next to it. When all 
classes are in their desired location, simply select Set Locations again to 
remove the check-mark. The diagram will redraw itself into the usual 
format. 

VDDT retains the memory of the class locations. This means that once they 
have been set for a Project, they will not need to be set again, unless new 
classes are added.  

Run Menu 
VDDT simulates the dynamics of vegetation over time. It assumes that the 
area in a landscape is stratified into broad vegetation classes, each of which 
is described in the pathway diagram of a Project.  These pathway diagrams 
contain definitions of all classes and the pathways between them, as 
described in the previous sections. To run the model, users must therefore 
pick: 

• a Project; and 

• a region (if more than one region is present in the project). 

Users then: 

• define the run settings; 

• execute the model; and 

• explore the results. 
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SETTINGS 
Define the conditions for the next model run using the Settings option under 
the Run menu.  Select general run settings such as the length and scale of the 
simulation, define your initial conditions and choose any optional settings 
you wish to use in your run.  

General Run Settings 
General run settings are all those that must be set for a model run.  They 
include the length of the simulation (in timesteps), the total number of cells 
to simulate, the number of Monte Carlo simulations to include in the run, and 
the region to simulate.  Additionally, general run settings also offer users an 
opportunity to define how VDDT will handle multiple regions, if applicable.   

Users can run the model for any number of years between 1 and 1000, and 
any number of Monte Carlo iterations (see below for details).  To run the 
model for longer than 1000 years, the maximum time possible, run the model 
for 1000 years, then ask the model to use the ending conditions to start the 
next run (see about the Initial Conditions tab, under the Run menu, for more 
information about using end values).  Note, however, that the results will 
only show the last run. 

To enter/edit general run settings: 
1. Select Settings from the Run menu to open the Run Settings dialog. 

2. On the General tab, enter values for the length of the simulation (default 
100) and the total number of cells to simulate (default 100, maximum 
50,000).   
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 A large number of cells makes the model slower, but less dependent on 
the choice of random number (see Run|Settings|Options tab). Hence, the 
random variation in results between successive runs will decrease with 
increasing number of cells. 

 Note: 
The number of cells used in a simulation has a direct impact on the 
length of time it takes for a run to be completed, and you may run into 
memory problems when using a large number of cells. 

3. Enter a value for the number of Monte Carlo simulations to include in 
the run. 

4. If the Project has only one region, the Regions controls will be disabled.  
If the Project has multiple regions, you can either choose a single region 
to simulate from the drop-down list or use the Sequencing feature to 
define which regions to run and for how long (see below). 

5. Click OK to save your general run settings to memory and close the 
dialog.   

To define a sequence of regions for a run: 
Regions are just collections of probabilities. While these may represent 
different management regions, they may also represent different management 
regimes in time, such as past and present fire suppression policies. The 
current version of VDDT allows users to ask the model to run one region for 
a number of years, and then switch to a different region in order to use 
different probabilities.  Regions can be run in any order and for any length of 
time within the time span defined for the run.  Each sequence of regions gets 
run for each simulation in the run.   

The advantage of this approach is that the complete run can be viewed at 
once, and the model will easily calculate the statistics over multiple Monte 
Carlo simulations. 

1. On the General tab of the Run Settings dialog, click the Sequencing 
button beside the Region to simulate field.  This action will open the 
Region Sequencing dialog. 
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2. Use the New button and the drop-down lists to enter each Region to be 
included in the run.  The Timestep represents when to start simulating 
each region.  For example, if a timestep value of 0 is entered for the 
region called Fire-Suppression, and a timestep of 30 is entered for the 
region called No-Management, then VDDT will run the Fire-
Suppression region from years 0 to 29.   

3. Remove unwanted regions from the grid using the Delete button. 

4. Click OK to save your changes to memory and close the Region 
Sequencing dialog.  Click Cancel to abandon your changes and return 
to the Initial Conditions tab of the Settings dialog. 

This information will be incorporated into your Project the next time you 
save it (File|Save or Save As). 

Initial Condition Run Settings 
The model simulates the dynamics of a number of cells, each of which is 
assigned one of the classes defined in the Project. Users must tell the model 
how many cells to simulate (General tab) and how to distribute those cells 
among classes.  The total area represented by your Project can also be 
specified.  Additionally, if Time Since Disturbance (TSD) is being used in 
the Project, users can either assign specific TSD values to each set of cells 
(record) in the grid or randomize initial TSD across the entire landscape. 

If no initial conditions have been assigned, the model will prompt the user to 
enter initial conditions before running. 

To enter/edit initial condition run settings: 
1. Select Settings from the Run menu to open the Run Settings dialog.  

Click on the Initial Conditions tab.  To see the TSD and age columns of 
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the grid, ensure that the TSD and Ages boxes on the right side of the 
dialog are checked. 

2. If your Project has more than one region, select the region for which you 
wish to enter initial conditions from the Region drop-down list.  If your 
Project contains only one region, the Region field will not appear on the 
Initial Conditions tab. 

 
3. For the selected region (if applicable), enter values for the total area 

represented by your Project.  Total area can be any value greater than 0 
(if you don’t know the area, you can leave this as the default value of 
100).  Area affects only the value of calculated and numeric attributes, 
and each cell has the same area. VDDT does not do any translation of 
units, so it is up to the user to ensure that the units are consistent 
between the attributes and the area. The area value can also be read from 
a file (see about the Load button, below). 

4. In the Proportion of Cells grid for the active region, enter values for 
TSD (Time Since Disturbance) and for the initial proportion of cells to 
be assigned to each class (total should equal 1) (see about Distributing 
Cells Across Classes, below).  TSD values entered here apply only to 
cells in the records for which they are entered rather than to the entire 
landscape.  

 Class information in this dialog cannot be edited.   

5. TSD for each region (if applicable) can also be controlled using the 
Randomize initial TSD to a maximum of field at the bottom of the 
dialog.  This feature randomly assigns initial TSD values between zero 
and the maximum (or the age of the cell, if the cell is younger than the 
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maximum TSD entered) to each cell in the landscape. Note, that if you 
enable the Randomize initial TSD option, the value entered there will 
override any TSD values in the Proportion of Cells grid.  

6. Repeat Steps 2 through 5 for each region in your Project. 

7. Click OK to save your changes to memory and close the Settings 
dialog, or Cancel to abandon your changes and return to the main 
VDDT window.  Click Run to start a model run based on the conditions 
just entered. 

Managing Records in the Grid 
New records can be added to the grid for each region using the New Age 
button.  This feature allows users to apply different TSD and proportion 
values to different timeframes within classes.   

To add a new record to the grid: 
1. For example, if you wish to add a record for Class A, left-click 

anywhere on an existing row for Class A and click on New Age.   

2. Enter the minimum and maximum ages for the new record and click 
OK.  The new record will be added to the bottom of the grid.  Use the 
Sort button to arrange the records by Class, Cover Type, Structural 
Stage or Min Age. 

3. Enter a proportion value for the new record, making sure that when you 
are done, the total for all records is still 1 (see about Distributing Cells 
Across Classes, below). 

4. Is you wish, you can enter a specific TSD value for the new record.  
Remember that if you have enabled the Randomize initial TSD option 
at the bottom of the screen, the value entered there will override any 
TSD values you enter in the Proportion of Cells grid for the active 
region. 

5. Repeat steps 1 through 4 for each region in your Project to which you 
wish to add records. 

6. Click OK to save your initial conditions to memory.  When you run 
your simulation, VDDT will run each record in each region according to 
the assigned proportion and TSD values.  

Note: 
If a newly added record has the same Class, Min Age and TSD as an existing 
record in the grid, the Propn values for those records will be summed into a 
single record (the one with the highest Max Age) when you save and re-open 
your Project.  

Distributing Cells Across Classes 

To distribute cells evenly across the classes: 
1. In the Proportion of Cells grid of the Initial Conditions tab 

(Run|Settings), all proportion values (Propn column) should either be 
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empty or have the same number.  You can reset all the values in this 
column to 0 by clicking on the Reset button.  

Note: 
Reset also changes TSD values in the grid to zero, removes any added 
records, and sets minimum and maximum ages back to class specifications.  
If you have added records and/or changed age values in the grid, adjust 
proportions manually rather than using the Reset feature. 

 

2. If the Total does not equal 1, click on the Normalize button to adjust the 
values so they total 1 but retain their relative values. 

3. Repeat Steps 1 and 2 for each region in your Project (if applicable). 

To put all the cells in one class: 
1. In the Proportion of Cells grid of the Initial Conditions tab 

(Run|Settings), enter a 1 in the cell corresponding to the class. 

2. Make sure all other cells are empty or contain a zero. 

3. Repeat Steps 1 and 2 for each region in your Project (if applicable). 

To distribute the cells in some specific pattern: 
1. In the Proportion of Cells grid of the Initial Conditions tab 

(Run|Settings), enter the numbers in the cells either as a proportion or 
as an absolute number. For example, if classes A, B, and D are to have 
twice as much area as classes C, E, and F, then enter (in alphabetical 
order): 2, 2, 1, 2, 1, 1. 

2. If the sum of the cells totals is not equal to 1, then click on the 
Normalize button. This normalizes the proportions in all cells such that 
they sum to 1 but retain their relative values. 

3. Repeat Steps 1 and 2 for each region in your Project (if applicable). 

To use ending conditions from the previous run still in memory: 
1. On the Initial Conditions tab (Run|Settings), click on the End Values 

button.  The values in the grid will change to reflect the proportions in 
effect at the end of the previous run. 

2. Repeat for each region in your Project (if applicable). 

To use conditions from an existing file:  
 Conditions from an existing file, such as initial conditions files or final 

conditions files written by the model (see Appendix D for file format), 
can be loaded from the Initial Conditions tab. 

1. On the Initial Conditions tab (Run|Settings), click on the Load button.  
A Read Conditions dialog will open; navigate to and open the *.IC file 
that contains the values you wish to load.  The values in the grid will 
change to reflect the proportions defined in the selected file. 
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2. If the total is not 1, click the Normalize button. 

 Initial condition files can contain information about the proportion or 
amount of the landscape that is within a class, within a given age range, 
and with a given TSD.  It also can contain the total area being simulated.  

Note: 
When the file is read, ages that are less than the beginning age of the class 
are set to the beginning age of the class. Ages that are greater than the 
maximum age of the class will be set to the maximum age of the class. 

 

3. Repeat Steps 1 and 2 for each region in your Project (if applicable). 

Managing Initial Conditions Information 

To save initial conditions to a file: 
1. On the Initial Conditions tab (Run|Settings), select the region for which 

you wish to save initial conditions from the Region drop-down list.  If 
your Project has only one region, no selection will be necessary here; 
proceed directly to Step 2. 

2. Click the Save As button. 

3. Navigate to where you want to store the new initial conditions (*IC) file, 
enter a name for it, and click Save.   

4. Repeat Steps 1 through 3 for each region for which you wish to save 
initial conditions, making sure you enter unique names for each file.  

  

Optional Run Settings 
Use VDDT’s optional run settings to define time since disturbance 
associations, disable selected transitions, set the random seed, and add 
advanced features to your Projects such as probability multipliers, area limits 
and attributes.   

Under the Run menu, select Settings to open the Run Settings dialog; open 
the Options tab.   
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Time Since Disturbance 
Time Since Disturbance (TSD) values, set using the Class Properties dialog 
(Diagram menu), allow users to define the minimum and maximum number 
of timesteps, following a particular set of probabilistic transitions for a cell, 
during which the cell is eligible for a subsequent probabilistic transition (see 
From Class Properties for information about setting TSD values).  For 
example, a user could determine that eradication of knapweed via chemical 
treatment can only occur for 3 timesteps following knapweed invasion.  In 
this case, the eradication via chemical control transition type is associated 
with knapweed invasion.  To use TSD values in this way, associations need 
to be defined for each affected transition type in your Project.   

To use the Time Since Disturbance option: 
1. Open a Project for which you have assigned TSD values to transitions 

(Class Properties dialog). 

2. Under the Run menu, choose Settings and open the Options tab of the 
Run Settings dialog.  Place a checkmark in the Use Time Since 
Disturbance option to turn it on.  

3. Click on the Select button to open the Time Since Disturbance Groups 
dialog. 

4. All transition types in your Project will be listed in the left pane of the 
dialog.  From the drop-down lists in the right pane, select the TSD 
Group with which you wish to associate each affected transition type.  
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Note – the TSD Group is the group of probabilistic transitions on which 
the occurrence of an individual transition type is contingent.  

 
5. Click OK when done, or Cancel to abandon your changes and close the 

dialog. 

6. The next time you run the model using this Project, your TSD values 
will be used in the simulation.  If, at some later time, you wish to run a 
simulation without the TSD values, simply turn the TSD option off.  The 
model will ignore the assigned TSD values until the option is explicitly 
turned back on. 

Note: 
VDDT does not use time since disturbance values by default.  TSD must be 
turned on (Run|Settings|Options) before the values will be used during a 
run.  Once turned on, all other runs with that Project will use the specified 
TSD values unless they are explicitly turned off. 

 

Disable Transitions 
At times, users may wish to run the model without some of the probabilistic 
transitions (e.g., in the absence of any management) or with only a particular 
probabilistic transition (e.g., with fire only). 

To disable transitions: 
1. Select Settings from the Run menu to open the Run Settings dialog; go 

to the Options tab.   

2. Turn on the Disable some transitions field by placing a checkmark in the 
box; click on the Select button to open the Select Transitions To 
Disable dialog.  
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3. Choose the transitions to be disabled by moving them across to the right 

side of the screen using the arrows in the centre.   

4. The OK button saves the selection while the Cancel button (or ESC 
key) leaves the window without making any changes. The selected 
transitions are still present and, although they will not be simulated by 
the model, the information will be saved with the Project. 

If a transition is part of more than one disturbance group, it will not occur if 
any of those groups are disabled. For example, if the probabilistic transition 
"pine beetle and wildfire" is a member of the three groups fire, insects and 
fire/insects, it will not occur if any one of these three groups is turned off for 
the simulation. The distribution of transition types into transition groups can 
be defined by the user under the File|Properties|Definitions menu choice. 

Area Limits 
Limits can be applied to constrain the area affected by particular transition 
types and by transition groups.  Target minimum and maximum area limits 
can be imposed on the total area disturbed by a group of transitions for up to 
five time intervals. 

To limit the area affected by a transition type: 
1. Under VDDT’s Run menu, select Settings to open the Run Settings 

dialog; open the Options tab.  Click on the Area Limits button.  This 
action will open the Area Limits dialog. 

2. On the Transition Types tab, type in minimum and maximum area 
values for the transition types you wish to constrain.  Zeros in this grid 
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mean that no transition will occur; no value means no limit will be 
placed on the associated transition type. 

 

 

Note: 
In VDDT version 5.1 and earlier, a value of zero in the Area Limits grid 
meant "no limit".  If you are working with a Project that you have imported 
from VDDT version 5.1 or earlier, and it contains zeros in the Area Limits 
grid, be sure to delete them.  Otherwise, the transitions to which zero area 
limits are assigned will not occur in your simulations.  

 

To limit the area affected by a transition group: 
Area limits can also be set for transition groups, as long as care is taken to 
maintain consistency where values have also been entered for transition 
types.  For example, if you wish to limit the area affected by a specific form 
of harvesting (e.g., the CC-Burn-Plant transition type), then any limits you 
place on the total harvest (e.g., the Harvest transition group of which CC-
Burn-Plant is part) must be greater than the limits you placed on CC-Burn-
Plant.   

1. On the Area Limits dialog, select the Transition Groups tab.   

2. Type in minimum and maximum area values for the desired transition 
groups.  Zeros assigned to transition groups in this grid mean that no 
transition types that are members of that group will occur; no value 
means no limit will be placed on the associated transition group. 

You can also set area limits on up to 5 time intervals for transition groups.   
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3. On the Transition Groups tab, click on the Breakpoints button to open 
the Time Interval Breakpoints dialog.  The End Year is based on the 
end year defined in the run.  For example, if Interval 1 ends at year 50, 
then it ranges from 1 (Start Year) to 50; if no other interval is set, then 
the last interval ranges from year 51 to 100 (the End Year).  

 As the example below shows, you do not have to use all four available 
intervals.   

  
 

4. Click on OK when done, and Yes to the confirmation message that 
appears if you want to go ahead and replace your existing limits.  The 
Area Limits dialog will now display columns showing the defined time 
intervals. 

5. Type in the minimum and maximum area limits for the desired 
disturbance groups.  
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6. If you wish to remove all breakpoints you have entered, return to the 

Time Interval Breakpoints dialog.  Delete the interval values for each 
time interval and create a single interval by typing the End timestep 
value into one of the interval text boxes.  Click OK.  Click Yes to the 
confirmation message.  The Area Limits dialog will now show all 
timesteps in a single interval. 

Note: 
Each individual transition type can belong to more than one transition group; 
however you can not have area limits on two groups that share the same 
transition type.  
 
Area limits will not be met exactly – the more cells that are simulated, the 
closer the results will be to area limits specified by the user.  
 
Area limits for transition groups or individual transition types may be 
impossible due to the state of the landscape, e.g., if there is not enough area 
of harvestable timber to meet a minimum area target.  
 
If area limits on transitions types are in conflict with limits on transition 
groups, the limits on transition groups will take priority. 

Probability Multipliers 
VDDT, through its stochastic algorithms, inherently generates some 
between-year variability in transition probabilities. The area affected by a 
transition type in any one year is dependent on the state of the landscape.  If a 
large amount of the landscape is in classes that have a high probability for 
transitions, the number of cells undergoing transitions will be higher than if 
most of the landscape is in classes in which transitions have low 
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probabilities. Even disturbances that occur in many or all classes will show 
some minor variation due to random number generation and due to 
variability in the probabilities for different classes (see Appendix B for a 
discussion of probability distributions in transition probabilities). 

In ecological systems, sources of variation also include external factors such 
as weather patterns. For example, several warm, dry years may result in 
higher than average areas burned or affected by mountain pine beetle.  
VDDT can capture this type of variation with user-defined probability 
multipliers.  For example, suppose a user has information that describes 
stand-replacing fire behavior over a 100-year period. Outside of VDDT, the 
user determines the average area burned, and then a multiplier for each year 
to get from the average area burned to the actual area burned. Use VDDT’s 
multipliers option to apply these multipliers and create between-year 
variability for stand-replacing fires in your simulation.   

Multipliers can be imported into Projects from *.MLT, *.CSV and *MCM 
file formats (File|Import|Multipliers).  A Project’s multipliers can also be 
saved to external files (File|Export|Multipliers) so they can be edited and 
imported into other projects.   

The Multipliers section of the Options tab (Run|Settings) allows users to 
turn transition and temporal multipliers on and off, to edit transition 
multipliers, and to specify which temporal multipliers to use in the next 
simulation.   

Note: 
VDDT does not use probability multipliers by default.  Multipliers must be 
turned on (Run|Settings|Options) before they will be used during a run.  
Once turned on, all other runs with that Project will use the multipliers unless 
they are explicitly turned off. 

Transition Multipliers 
Transition multipliers are values that increase or decrease the probability that 
the transition types to which they are applied will occur.  This is a useful 
option for testing the sensitivity of the probabilities, or for exploring "what-
if" scenarios (such as "what if fires were twice as frequent?").   

In order to use transition multipliers in a simulation, you must turn the option 
on and then assign the multiplier values.  If you wish to run a simulation 
without assigned transition multipliers, simply turn the option off (see 
below).  All subsequent simulations using the same Project will ignore the 
multipliers until the option is explicitly turned back on. 

To use transition probability multipliers: 
1. Under VDDT’s Run menu, select Settings to open the Run Settings 

dialog; open the Options tab.  On the Options tab, place a checkmark in 
the Transition option to turn it on.   

2. Click on the Multipliers button to open the Transition Probability 
Multipliers dialog. 
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 All transition types defined for the open project are listed in the dialog.  

If the Project contains more than one region, a Region field will be 
included in this dialog.  Rows in the grid will be sorted first by Region, 
and then by Transition Type. 

3. Assign your multipliers by typing them into the Probability Multiplier 
grid.  Multipliers can be any positive number, including decimals.  A 
multiplier of 1 is equivalent to assigning no multiplier. A multiplier of 0 
means that the transition to which it is assigned will not occur.   

 Click on the Update Probabilities button if you wish to apply your 
multipliers to the transition types in the grid and permanently change the 
probabilities for those pathways.  If you wish to use your multipliers in 
simulation runs but retain the original pathway probabilities, click on 
OK.   

4. The next time you run the model using this Project, your transition 
multipliers will be used in the simulation.  If, at some later time, you 
wish to run a simulation without the multipliers (i.e., you did not use 
Update Probabilities), simply turn the Transition option off.  The 
model will ignore the assigned multipliers until the option is explicitly 
turned back on. 

Temporal Multipliers 
Temporal multipliers, known as annual multipliers in earlier versions of 
VDDT, allow the user to simulate annual variation during a run.  In order to 
use temporal multipliers in a simulation, an appropriate set of multipliers 
must first be generated outside of VDDT.  These can then be imported into 
an open Project using VDDT’s Import menu (File|Import|Multipliers 
|Temporal), or loaded directly using the Temporal Multipliers dialog (see 
below).   
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Your temporal multipliers *.CSV file needs to have the following format: 
ProbabilisticTransitionType_Name Simulation Timestep Multiplier 
Insect/Disease 1 1 0.00125 
Insect/Disease 1 2 0.00125 
Insect/Disease 1 3 0.00125 
Insect/Disease 1 4 0.00125 
Insect/Disease 1 5 0.00125 
  ……  
Insect/Disease 1 18 12.5 
Insect/Disease 1 19 0.125 
Insect/Disease 1 20 0.125 

    

For example, a project with 3 Monte Carlo simulations and 100 timesteps 
would contain 300 multipliers for the Insect/Disease transition type. 

VDDT can also read temporal multipliers directly from an *.MCM file, 
which can be created using the Build MCM Tool (included with the VDDT 
installation files).  Detailed information about the Build MCM Tool is 
provided in Appendix F.  Users who wish to generate multipliers using the 
MCM Tool will need to enable VDDT’s Variation menu in order to create 
the required input files (see Appendix G for information about the Variation 
menu and how to access it). 

In order to use temporal multipliers in a simulation, you must turn the option 
on.  If you wish to run a simulation without assigned temporal multipliers, 
simply turn the option off (see below).  All subsequent simulations using the 
same Project will ignore the multipliers until the option is explicitly turned 
back on. 

To load and view temporal probability multipliers: 
1. Open a Project for which you have temporal multipliers ready to use, 

i.e., either already in the database or in the form of a file ready to import 
or load.   

 If your multipliers are not already in the database, you can import them 
from *.CSV or *.MCM files (File|Import|Multipliers|Temporal), or 
you can load them directly from *.CSV files using the Temporal 
Multipliers dialog (see below).   

2. Under VDDT’s Run menu, select Settings to open the Run Settings 
dialog; open the Options tab.  On the Options tab, place a checkmark in 
the Temporal option to turn it on. Click on the Multipliers button to 
open the Temporal Multipliers dialog.   

3. If no transitions are listed in the left-hand pane of the dialog, then you 
must either import or load them.  To load multipliers directly from 
*.CSV files, click on the Load button.  Navigate to and select the *.CSV 
file that contains your temporal multipliers and click Open to load them 
into the open Project.  A confirmation message will display when the 
loading process is complete. 
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4. Back on the Temporal Multipliers dialog, left-click on the transition 
listed in the left-hand pane of the dialog to display the temporal 
multipliers you just loaded.  Multipliers cannot be edited in the 
Temporal Multipliers dialog. 

 

 

5. To delete all multipliers from a Project, click on the Clear All button.  
Otherwise, click OK to save your multipliers to memory, and Save your 
Project to integrate them into the database. 

Project Attributes 
Project attributes provide additional information about classes.  Use the 
Options tab of the Run Settings dialog (Run|Settings) to define calculated, 
categorical (level/group) and numeric attributes for Projects.  Attribute types 
can be mixed and more than one of each type can be assigned to a Project.  
Once attributes have been added to a Project, they can be edited and graphed 
within VDDT.   

VDDT allows users to create attributes, assign/edit attribute values, import 
attribute information from external files (File|Import|Attributes), and save 
attribute information to external files (File|Export|Attributes) so it can be 
shared with other Projects.  Attribute files are comma and quote delimited 
*.ATT files (see Appendix D for information about the *.ATT file format).   

Three types of attributes are recognized by the model: 

Attribute Description 

Calculated: These are attributes that are dependent on the 
occurrence of a transition. Values are assigned to a 
class and transition type, and the final value is 
"calculated" during a model simulation. For 
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example, outputs such as smoke emissions and 
timber harvest volumes can be tracked. Users can 
set targets for the minimum and maximum amount 
of calculated attribute output per year. Calculated 
attribute information is stored in the VDDT 
database. 

Categorical: This is a qualitative descriptor such as "high," 
"medium," "low," or "excellent," "good," "poor." 
Graphs of this attribute will show the proportion of 
cells at each level. This is a class-based attribute 
only. Categorical attributes are stored in external 
*.ATT files. 

Numeric: Values are numerical descriptors with units, e.g., 
20 snags/acre. This is a class-based attribute only. 
Numeric attributes are stored in external *.ATT 
files. 

  

Calculated Attributes 

A calculated attribute is one whose value depends on a transition event 
occurring.  Values are linked to a specific occurrence of transition type and 
class, e.g., if an underburn occurs in Class G the smoke emissions (the 
calculated attribute) will be x while if it occurs in class N they will be y. 

The Calculated Attributes dialog, accessed by selecting Settings from the 
Run menu, is divided into three tabs. Use the Definitions tab to create new 
attributes and delete unwanted ones.  The Values tab allows users to set 
values for unique attribute/class combinations, and the Limits tab specifies 
lower and upper attribute value limits for specific time periods.  

To define calculated attributes: 
1. Open the Project for which you wish to define calculated attributes.   

2. Under the Run menu, select Settings to open the Run Settings dialog.  
Select the Options tab.  In the Attributes pane, click on the Calculated 
button.  This action opens the Calculated Attributes dialog. 
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3. Define your calculated attributes using the Definitions tab.  Click New to 

insert a row into the grid.  Type in a Name and specify the Units for your 
first calculated attribute.  Provide a Description (optional) of the 
calculated attribute.  Continue until you have defined all of your 
calculated attributes. 

4. Click OK to return to the Options tab of the Run Settings dialog, or 
switch to the Values tab to continue setting your calculated attributes. 

To specify calculated attribute values: 
1. On the Values tab of the Calculated Attributes dialog, click New to 

open the Add Values dialog.   

 
 Use this dialog to select the unique combination of attribute, class 

characteristics and transition type to which you wish to apply an 
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attribute value. The Attribute drop-down list contains all of the attributes 
specified on the Definitions tab; the drop-downs in the other fields 
contain the cover types, structural stages and transition types that have 
been defined for the active Project.  The combination of cover type, 
structural stage and transition type that you choose must be a valid one 
for the open Project (check the Probabilistic Transitions screen - 
Diagram menu - to review transitions for all classes).   

2. Enter the desired attribute value in the Value/unit area field, e.g., for a 
volume attribute with units of m3, a value of 30 means 30 m3/unit area.  
The area units used for the denominator here are the same as determined 
by the user on the Initial Conditions tab (Run|Settings).  Click OK to 
add your new row to the grid on the Values tab. 

 Invalid combinations of cover type, structural stage and transition type 
will generate an error, and the new row will not be added.  Additionally, 
the Add Values operation will not overwrite values for combinations 
you have already added to the Values grid, i.e., if you use the Add 
Values dialog to select a combination of attribute, cover type, structural 
stage and transition type that already exists on the Values tab, your new 
value will not be added unless you enable the Overwrite existing option 
on the Add Values dialog.  

 Continue until you have associated calculated attributes and values to 
each combination of cover type, structural stage and transition type you 
wish.   

 
3. From the Values tab, you can also sort the entries in the Values grid.  To 

do so, click on the Sort button on the Values tab to open the Sort dialog.  
You can sort by up to four fields, in either ascending or descending 
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order.  Click OK to return to the Values grid and your sorted list of 
calculated attributes.   

4. You can also remove unwanted attributes by clicking anywhere on the 
row and clicking the Delete button.  A dialog box will open requesting 
confirmation of the deletion.  Click OK to delete the row and return to 
the Values tab. 

5. Click OK to return to the Options tab of the Run Settings dialog, or 
switch to the Limits tab to continue setting your calculated attributes. 

To set calculated attribute limits: 
VDDT allows the user to place upper and lower annual limits (for up to 5 
time intervals) on the expected total value of a calculated attribute. If users 
have limits on the area disturbed by either individual transitions or transition 
groups, and these limits conflict with the attribute limits, the attribute limits 
will take priority. Attribute limits will only be met approximately because of 
the probabilistic nature of the model. The more cells used in the simulation, 
the closer the results will be to the set limits. Attribute limits may not be met 
at all if the state of the landscape does not allow it (for example, a minimum 
timber harvest volume may not be possible if the area of mature forest in the 
landscape is too low). 

Note: 
The limits will not work properly if limits are placed on two separate 
calculated attributes that share one or more transitions.  The maximum 
number of calculated attributes allowed is 40. 

 

1. On the Limits tab of the Calculated Attributes dialog, click on the 
Breakpoints button to open the Time Interval Breakpoints dialog.  
Use this dialog to define the time intervals over which to set the 
minimum and maximum limits for your calculated attributes. For 
example, values of 20, 40, 60 and 80 produce intervals of 1-20, 21-40, 
41-60, 61-80 and 81-end.  Note that you do not have to fill in all four 
boxes.  When done, click OK to return to the Limits tab.   
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2. On the Limits tab, click on the New button to add your first row to the 

table.  Select the attribute for which you wish to set value limits from the 
Attribute drop-down list.  Type in the limits for the desired intervals and 
click on OK when done.  Continue until you have added one record for 
each attribute to which you wish to assign limits. 

 
  

 In the above example, the model has been set to spend alternately $40 
and $5 annually on restoration in 20 year periods. 

3. You can remove unwanted limits by clicking anywhere on the row and 
clicking the Delete button.  A dialog box will open requesting 
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confirmation of the deletion.  Click OK to delete the row and return to 
the Limits tab. 

4. If you wish to remove all breakpoints you have entered, return to the 
Time Interval Breakpoints dialog.  Delete the interval values for each 
time interval and create a single interval by typing the End timestep 
value into one of the interval text boxes.  Click OK.  The Calculated 
Attributes dialog will now show all timesteps in a single interval. 

5. When done, click OK on the Calculated Attributes dialog to save your 
changes to memory and close the dialog.   

To save your calculated attribute settings to the active Project and to the 
database, select Save from the File menu.   

 

Categorical Attributes 

Categorical attributes, known as level/group attributes in earlier versions of 
VDDT, are class-based qualitative descriptors such as "high," "medium," 
"low," or "excellent," "good," "poor." Graphs of this attribute will show the 
proportion of cells in each category.   

To define categorical attributes: 
1. Open the Project for which you wish to define categorical attributes.   

2. Under the Run menu, select Settings to open the Run Settings dialog.  
Select the Options tab.  In the Attributes pane, click on the Categorical 
button.  This action opens the Categorical Attributes dialog. 
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3. Define your categorical attributes using the Definitions tab.  Click New 
under the Name pane to insert a row into the grid.  Type in a Name for 
the categorical attribute.  Click New under the Valid values pane, and 
enter a descriptive label for the first level in the named category.  Repeat 
this step for each level in the category (e.g., Low, Medium, High).   

 Remove unwanted entries by clicking on them and then clicking the 
corresponding Delete button.  

4. Click OK to return to the Options tab of the Run Settings dialog, or 
switch to the Values tab to continue setting your categorical attributes. 

To specify categorical attribute values: 
1. On the Values tab of the Categorical Attributes dialog, click New to 

open the Add Values dialog.   

  
 Use this dialog to select the unique combination of attribute, class 

characteristics and transition type to which you wish to apply an 
attribute value. The Attribute drop-down list contains all of the attributes 
specified on the Definitions tab; the drop-downs in the other fields 
contain the cover types, structural stages and transition types that have 
been defined for the active Project.  The combination of cover type, 
structural stage and transition type that you choose must be a valid one 
for the open Project (check the Probabilistic Transitions screen - 
Diagram menu - to review transitions for all classes).   

2. Enter the desired attribute value in the Value field, and click OK to add 
your new row to the grid on the Values tab. 

 Invalid combinations of cover type, structural stage and transition type 
will generate an error, and the new row will not be added.  Additionally, 
the Add Values operation will not overwrite values for combinations 
you have already added to the Values grid, i.e., if you use the Add 
Values dialog to select a combination of attribute, cover type, structural 
stage and transition type that already exists on the Values tab, your new 
value will not be added unless you enable the Overwrite existing option 
on the Add Values dialog.  
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 Continue until you have associated categorical attributes and values to 
each combination of cover type, structural stage and transition type you 
wish.   

 
3. From the Values tab, you can also sort the entries in the Values grid.  To 

do so, click on the Sort button on the Values tab to open the Sort dialog.  
You can sort by up to four fields, in either ascending or descending 
order.  Click OK to return to the Values grid and your sorted list of 
calculated attributes.   

4. You can also remove unwanted attributes by clicking anywhere on the 
row and clicking the Delete button.  A dialog box will open requesting 
confirmation of the deletion.  Click OK to delete the row and return to 
the Values tab. 

5. When done, click OK on the Categorical Attributes dialog to save 
your changes to memory and close the dialog.   

Note: 
Valid category values on the Definitions tab that are not used on the Values 
tab will be lost when you click OK on the Categorical Attributes dialog.  A 
message will display to notify users when this is going to occur. For 
example, if you have High, Medium and Low values defined on the 
Definitions tab, but you assign only Medium and Low values on the Values 
tab, the High category value on the Definitions tab will be removed when 
you click OK on the Categorical Attributes dialog.  

To save your categorical attribute settings to the active Project, select Save 
from the File menu.   
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Numeric Attributes 

Numeric attributes are class-based numerical descriptors with units, e.g., 20 
snags/acre.  

To define numeric attributes: 
1. Open the Project for which you wish to define numeric attributes.   

2. Under the Run menu, select Settings to open the Run Settings dialog.  
Select the Options tab.  In the Attributes pane, click on the Numeric 
button.  This action opens the Numeric Attributes dialog. 

 
3. Define your numeric attributes using the Definitions tab.  Click New to 

insert a row into the grid.  Type in a Name and specify the Units for your 
first numeric attribute.  Continue until you have defined all of your 
numeric attributes. 

4. Click OK to return to the Options tab of the Run Settings dialog, or 
switch to the Values tab to continue setting your numeric attributes. 

To specify numeric attribute values: 
1. On the Values tab of the Numeric Attributes dialog, click New to open 

the Add Values dialog.   
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 Use this dialog to select the unique combination of attribute, class 

characteristics and transition type to which you wish to apply an 
attribute value. The Attribute drop-down list contains all of the attributes 
specified on the Definitions tab; the drop-downs in the other fields 
contain the cover types, structural stages and transition types that have 
been defined for the active Project.  The combination of cover type, 
structural stage and transition type that you choose must be a valid one 
for the open Project (check the Probabilistic Transitions screen - 
Diagram menu - to review transitions for all classes).   

2. Enter the desired attribute value in the Value field, and click OK to add 
your new row to the grid on the Values tab. 

 Invalid combinations of cover type, structural stage and transition type 
will generate an error, and the new row will not be added.  Additionally, 
the Add Values operation will not overwrite values for combinations 
you have already added to the Values grid, i.e., if you use the Add 
Values dialog to select a combination of attribute, cover type, structural 
stage and transition type that already exists on the Values tab, your new 
value will not be added unless you enable the Overwrite existing option 
on the Add Values dialog.  

 Continue until you have associated numeric attributes and values to each 
combination of cover type, structural stage and transition type you wish.   



VDDT 6.0 User Guide 

86 

 
3. From the Values tab, you can also sort the entries in the Values grid.  To 

do so, click on the Sort button on the Values tab to open the Sort dialog.  
You can sort by up to four fields, in either ascending or descending 
order.  Click OK to return to the Values grid and your sorted list of 
numeric attributes.   

4. You can also remove unwanted attributes by clicking anywhere on the 
row and clicking the Delete button.  A dialog box will open requesting 
confirmation of the deletion.  Click OK to delete the row and return to 
the Values tab. 

5. When done, click OK on the Numeric Attributes dialog to save your 
changes to memory and close the dialog.   

 

To save your numeric attribute settings to the active Project, select Save from 
the File menu.  

 

Set Random Seed 
A single model run may consist of many iterations or Monte Carlo 
simulations. VDDT uses a random seed (integer between 0 and 32,000) to 
initiate the selection of all its random numbers over the course of a run, 
which you can edit on the Options tab of the Run Settings dialog 
(Run|Settings).  

By default, VDDT selects a different random seed each time you start a run; 
in this way, each time the model is run, the results are slightly different. 
However the user does have the option to fix the random seed for the start of 
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each run.  Two runs of the model, using the same random seed and identical 
project parameters, will give identical results.  Use the Resample button to 
generate a new starting random number seed, or enter one of your own 
choosing.   

Output Settings 
VDDT can produce information about runs that can be saved to file (*.CSV) 
and opened in a spreadsheet program such as Microsoft Excel.  The model 
can produce summary and detailed output reports for classes and transitions.   

VDDT can also send information about ending conditions, probabilistic 
transition means and output time to a series of tables in the active database. 

  

Output Reports 
Use the Output tab of the Run Settings dialog (Run|Settings menu choice) 
to specify where to save report files, what type of information to generate, 
and the level of detail for each report.  These reporting preferences are saved 
as part of a Project’s settings.   

Note: 
If no Output folder is specified on the Output tab, then output will by default 
be sent to {Application Path}\Output\{Project Name}.  For example, if you 
have VDDT installed at C:\Program Files, then output for a project called 
"Grass Model" would go to: C:\Program Files\VDDT\Output\Grass Model. 
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Summary reports  
Summary reports provide overview information about classes and transition 
groups that can be graphed to show trends over time.  The reports are 
generated as text CSV files, which can then be opened directly in Excel for 
further analysis. 

To generate a summary report: 
1. Select the Output tab from the Run Settings dialog (Run|Settings menu 

choice), and use the Browse button to select the location of the folder 
into which you want to save your output.  If no output folder is 
specified, then VDDT will create a folder called Output directly below 
the folder in which the active VDDT database is located and place the 
output files there. The file names for summary output are always 
ClassesSummary.csv and TransitionsSummary.csv. 

2. In the Summary reports section of the screen, place a checkmark next to 
each type of output you wish to generate.   

3. Specify the size of time interval, in terms of timesteps, to use for the 
output by entering the number of timesteps in the text box beside each 
selected report type.  The smaller the time interval, the greater the 
number of records in the report. 

The State Classes summary report contains Area information for each 
combination of state class (represented by structural stage (SSAbbr and 
SSCode) and cover type (CTAbbr and CTCode)), Monte Carlo simulation 
(MC) and Timestep.  In the example below, which shows only the first 15 
records, VDDT generated a record of the area in each state class, for each 
Monte Carlo simulation and timestep.  This information can be used to graph 
area affected in each class over time. 

MC Timestep ClassCode CTCode CTAbbr SSCode SSAbbr Area
1 1 112012 2012 PPine 11 EAD 106175
1 1 122012 2012 PPine 12 MID 828165
1 1 132012 2012 PPine 13 LSD 849400
1 1 212012 2012 PPine 21 EAO 127410
1 1 222012 2012 PPine 22 MIO 106175
1 1 232012 2012 PPine 23 LSO 106175
1 2 112012 2012 PPine 11 EAD 106175
1 2 122012 2012 PPine 12 MID 785695
1 2 132012 2012 PPine 13 LSD 828165
1 2 212012 2012 PPine 21 EAO 191115
1 2 222012 2012 PPine 22 MIO 106175
1 2 232012 2012 PPine 23 LSO 106175
1 3 112012 2012 PPine 11 EAD 148645
1 3 122012 2012 PPine 12 MID 721990
1 3 132012 2012 PPine 13 LSD 849400  

 

The Transitions summary report contains Area information for each 
combination of transition group (TransGrpName and TransGrpCode), 
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Monte Carlo simulation (MC) and Timestep.  In the example below, which 
shows the first 20 records of the report, VDDT generated area information 
for every Monte Carlo simulation, timestep, and defined transition group.  
This information can be used to graph the area affected by each transition 
group over time.  

MC Timestep TransGrpCTransGrpName Area
1 1 1 Selective_Log 0
1 1 2 Commercial_Thin 0
1 1 3 Thin 0
1 1 4 Prescribed_Fire 0
1 1 5 Bark_Beetle 0
1 1 6 Severe_Wild_Fire 21235
1 1 7 Under_Burn 42470
1 1 8 Fuel_Buildup 21235
1 1 9 TSD 84940
1 1 10 Succession 0
1 2 1 Selective_Log 0
1 2 2 Commercial_Thin 0
1 2 3 Thin 0
1 2 4 Prescribed_Fire 0
1 2 5 Bark_Beetle 21235
1 2 6 Severe_Wild_Fire 63705
1 2 7 Under_Burn 0
1 2 8 Fuel_Buildup 0
1 2 9 TSD 63705
1 2 10 Succession 0  

Detailed reports  
Detailed reports track the fate of individual cells in the simulation, which 
provide a history of the state of each cell over time.  Detailed reports can be 
used to look at the distribution of age and time since disturbance. As with 
Summary Reports, Detailed Reports are generated as text CSV files, which 
can then be opened directly in Excel for further analysis. Note that these 
Detailed reports can be very large, as they record output on a per cell basis; if 
the report exceeds 65,000 records in length, Excel will not be able to import 
it in its entirety (however such reports can still be imported into Access for 
analysis). 

To generate a detailed report: 
1. Select the Output tab from the Run Settings dialog (Run|Settings menu 

choice), and use the Browse button to select the location of the folder 
into which you want to save your output. By default, the file names for 
detailed output are always ClassesDetailed.csv and 
TransitionsDetailed.csv. 

2. In the Detailed reports section of the screen, place a checkmark next to 
each type of output you wish to generate.   

3. Specify the size of time interval, in terms of timesteps, to use for the 
output by entering the number of timesteps in the text box beside each 
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selected report type.  The smaller the time interval, the greater the 
number of records in the report. 

4. Select the Minimize size option if you wish to reduce the number of 
reported fields.  For example, a minimized State Classes detailed report 
contains only 4 fields: MC, Timestep, ClassCode and Age. 

5. For detailed transitions reports, you can also choose to exclude 
deterministic transitions from your report by clearing the Deterministic 
checkbox. This option is enabled by default. 

A non-minimized State Classes detailed report contains a row of information 
for every combination of Monte Carlo simulation (MC), Timestep and cell 
(Pixel). Information that is recorded includes state class (SS), Age, Area and 
TSD (time since disturbance). In the example below, which shows only the 
first 10 records, VDDT generated information for every cell, for each 
combination of Monte Carlo simulation and timestep. 

MC Timestep Pixel ClassCode CTCode CTAbbr SSCode SSAbbr Age Area TSD-Selective_Log TSD-Commercial_Thin TSD-Thin
1 1 1 112012 2012 PPine 11 EAD 25 212.35 2 19 5
1 1 2 112012 2012 PPine 11 EAD 31 212.35 11 5 13
1 1 3 112012 2012 PPine 11 EAD 36 212.35 10 3 2
1 1 4 112012 2012 PPine 11 EAD 36 212.35 11 9 23
1 1 5 112012 2012 PPine 11 EAD 3 212.35 14 3 2
1 1 6 122012 2012 PPine 12 MID 112 212.35 29 13 10
1 1 7 122012 2012 PPine 12 MID 43 212.35 4 18 7
1 1 8 122012 2012 PPine 12 MID 135 212.35 13 26 22
1 1 9 122012 2012 PPine 12 MID 103 212.35 24 2 22
1 1 10 122012 2012 PPine 12 MID 130 212.35 6 21 9  

A non-minimized Transitions detailed report contains a row of information 
every time a cell is transitioned during the specified time interval.  For each 
cell transition, information is generated to record the Monte Carlo simulation 
(MC), the Timestep, the cell (Pixel), the transition type that occurred 
(TransType and TransTypeName), the start state class of the cell (i.e., 
before transition), the end state class of the cell (i.e., after the transition), the 
Age of the cell before the transition occurred, the Area of the cell, and the 
TSD values of the cell prior to the transition.   

Generate Database Indicators 
When you run a simulation, VDDT generates certain information about it.  
You can write this information to a series of Output* tables in your active 
VDDT database by enabling the Generate database indicators option at the 
bottom of the Output tab (Run|Settings).  After conducting your run, save 
your Project (File|Save) to write the indicators to the database.  Information 
is written to the following three MS Access tables: 

• OutputEndingConditions; 

• OutputProbabilisticTransitionMean; and 

• OutputTime. 

Note: 
Subsequent runs using the same project will overwrite your database 
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indicator output unless you disable the Generate database indicators option 
at the bottom of the Output tab.  If you wish to keep the output from a 
particular run, the simplest way to do this is to make a copy of the Project 
that contains the output you wish to keep (File|Save As).   

START MODEL 
Once all decisions are made about general and initial conditions settings and 
options (see above), the model is ready to start the run.  

To start the model: 
1. Select Start Model from the Run menu, *OR* 

2. Click the Run button on the Run Settings dialog box (Run|Settings 
menu choice). 

When you start a run, the model will first check to ensure that general run 
settings and initial conditions are present, and that either a region has been 
selected or region sequencing has been defined. 

GRAPH RESULTS 
The easiest way to view the model results is to look at graphs.  Once a run 
has been completed, there are two general types of graphs available in 
VDDT: 

• bar graphs; and 

• line graphs over time. 

Changes in the distribution of classes, cover types, structural stages, or the 
occurrence of transitions can be viewed using either bar graphs or time 
graphs. Other bar graphs include categorical attributes and numeric 
attributes, while other time graphs include numeric attributes and calculated 
attributes. In all cases, VDDT will show up to four graphs at any time. 

To generate a graph of run results: 
1. Select the Graph Results option from the Run menu to open the Graph 

Results dialog.   

2. On the General tab, select the variable (class, cover type, etc.) you wish 
to display, the type of graph (bar, line) you wish to generate, and the 
timesteps for which you wish to generate the graph.   

3. On the Options tab, use the graphing options to specify how your graphs 
will display. 

4. Click Apply to generate graphs without closing the Graph Results 
dialog.  Click OK to close the dialog and return to VDDT’s main 
window. 
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General Graph Settings 
Use the General tab on the Graph Results dialog (Run|Graph Results) to 
select the variable (class, cover type, etc.) you wish to display, the type of 
graph (bar, line) you wish to generate, and the timesteps for which you wish 
to generate the graph.   

 

Display Variable 
This section of the General tab lists the variables available in the active 
Project for graphing. At a minimum, this list will include Classes, Cover 
Types, Structural Stages and Transition Groups.  If attributes have been 
defined for the open Project, the list will also contain one or more attribute 
variables, e.g., Attributes - Numeric, Attributes - Categorical, and/or 
Attributes - Calculated.  Attribute variables can only be graphed over time 
using Line graphs.   

Graph Type 
This section of the General tab allows users to select the type of graph and 
the timesteps over which to view the model output.   
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Bar graphs show the percentage of cells, or the area (see about Graphing 
Options, below), for the selected variable and specified timesteps.  VDDT 
will graph all classes, cover types, structure stages or transition groups 
(depending upon which variable has been selected for display) that have been 
defined for the open Project.  

Line graphs show the percentage of cells, or the area (see about Graphing 
Options, below), for the selected variable over time.  VDDT will graph up to 
four classes, cover types, structural stages, transition groups, or attributes 
over time.  If an attribute variable has been chosen for graphing, the Line 
graph type will automatically be selected. 

Graphing Options 
A number of options are available to users to help increase the flexibility of 
the graphic display. These options are all found on the Options tab of the 
Graph Results dialog (Run|Graph Results).  They include: deciding 
whether single run or summary statistics will be shown in the graph; setting 
error bar limits; changing the variable display and scale for the y-axis; setting 
time intervals; and defining how attributes will be displayed.  
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Each of these options is described more fully in the topics that follow. 

Graph Option: Display Series 
When multiple Monte Carlo iterations are simulated, VDDT automatically 
creates some summary information about the run. Users can view this 
summary information as well as the results of just the last simulation.  
Choose the information series you wish to display by selecting it from the 
Display series for drop-down list. 

Type Description 

Last simulation This option graphs the run results for the last 
simulation only, e.g., the 10th of 10 Monte Carlo 
simulations. 

 

Average, minimum, maximum 

Line graphs: This shows a line for the average of the iterations, 
as well as for the maximum and minimum value 
over all iterations in the given year.  

 
Bar graphs: A point shows the average of the iterations, and a 

vertical line indicates the range of the values. 
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Average & standard deviation 

When this series is selected for display, users will also need to specify the 
number of standard deviations to be shown (any number greater than 0).  
Enter this value in the Number of std deviations text box in the Y error bars 
section of the dialog.   

Type Description 

Line graphs: This option shows three lines:  

• average  

• average + n standard deviations, and 

• average - n standard deviations (with a 
minimum value of 0). 

Bar graphs: A point shows the average of the iterations, and a 
vertical line extends from the average - n standard 
deviations (with a minimum value of 0) to the 
average + n standard deviations. 

 

Average & central tendency 

Showing the central tendency (ct) allows users another way of assessing the 
variability in their results. VDDT allows the user the flexibility to change the 
value of the central tendency. When the Average & central tendency series 
is selected for display, users will need to specify a percentage for the central 
tendency in the Central tendency % field of the Y error bars section of the 
dialog.  

Type Description 

Line graphs: This option shows three lines:  
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• average  

• maximum value – ((1-ct)/2 * (max. value – 
min. value)), and 

• minimum value – ((1-ct)/2 * (max. value – 
min. value)) 

 
The above example summary line graph shows a central tendency of 25% for 
the same data as graphed above for Average, minimum, maximum.  

Bar graphs: A point shows the average of the iterations, and a 
vertical line extends from: 

• maximum value – ((1-ct)/2 * (max. value – 
min. value)) to the 

• minimum value – ((1-ct)/2 * (max. value – 
min. value)) 

Graph Option: Y-axis Settings 
Enable the Display area values option to change the y-axis variable to 
display area rather than proportion of cells.  The total area being used in the 
simulation is one of the initial conditions specified on the 
Run|Settings|Initial Conditions tab. 

Generated graphs can either be displayed with the same y-axis values or 
independent y-axis values, depending on their data. The Same scale for all 
graphs option assigns the same values to the y-axes for all generated graphs.  
This option can be useful for comparative purposes. 

Graph Option: Line Graph Settings 
Display as 10-year moving average 
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This option allows you to smooth out line graphs. You can graph the 10 year 
average with any data series selected from the Display series for drop-down 
list at the top of the Options tab (see above).  

Each point on the line is calculated as the average value of the previous ten 
time steps, producing a smoothed line representing the variable over the 
selected time intervals.  

 
Show interval mean values 

If you select this display option, you must specify the Interval end timesteps 
for each segment of the line graph.  In the example below, the mean line will 
show five distinct segments, one for each of the intervals specified: start-10, 
11-25, 26-50, 51-75, and 76-end. 

 
A series of straight line segments representing the mean values of the 
variable over the selected time intervals is displayed. A table containing the 
values for the line segments will appear after the Graph Results dialog is 
closed and when the mouse pointer is moved over any one of the graph 
panes. This table can be set on any graph – to set the table on a particular 
graph, click once where you want the table to be. If you wish to see the 
values for a different graph, simply left-click on the graph of your choice and 
the table will move to that location.  The values in the table will refresh to 
represent the new graph.   
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Turn on the Include mean for all lines option to display interval mean lines 
for all lines, i.e., maximum, average and minimum) as in the example below. 

 

Graph Option: Attribute Settings 
Numeric and calculated attribute values can be displayed as totals over time 
or as averages over time.  Calculated attributes can also be displayed as 
averages over the affected area. 
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Display as totals 

The Display as totals option graphs the sum of the attribute over all the cells 
in the landscape.  These graphs are sensitive to the size of the landscape that 
is being simulated. Larger landscapes will have higher total values, all else 
being equal. This option is not affected by the number of cells being 
simulated. 

 
In the above example graph for totals over time, the y-axis shows the sum of 
the value of the attribute for all cells.  

Display as averages 

The Display as averages  option graphs the average value of the attribute in 
the landscape for each time interval defined in the Line graph settings option 
(see above).  
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In the above example, the step-wise line represents the averages for three 
time intervals.  

Display as averages over affected area 

Averages over the affected area, i.e., the areas for which the attribute has 
been calculated, can also be graphed for calculated attributes, e.g., the 
average smoke emissions per unit area burned. 

Generating Bar Graphs 
Go to Run|Graph Results and select the General tab.  In the Graph Type 
section of the dialog, click the Bar radio button to generate different types of 
bar graphs.  Bar graphs can be generated for classes, cover types, structural 
stages and transition groups.   

 
Enter up to 4 Timesteps to display; one graph will be generated for each 
timestep entered.   

When you have selected the variable you wish to graph, and have finished 
setting your graphing options (Options tab), click OK on the Graph Results 
dialog to generate selected graphs and close the dialog.  Click Apply to 
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generate graphs and leave the dialog open.  Click Cancel to abandon your 
graph selections and close the dialog. 

Bar Graphs for Classes 
Each bar in the graph represents a different class. Bars are labeled according 
to the letter of the class.   

 

Bar Graphs for Cover Types 
Each bar in the graph represents a different cover type, and may combine 
information from several classes. Bars are labeled with the cover type short 
code (such as Early1). Each of the shrub types will be given a separate bar if 
their cover types are different. 
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Bar Graphs for Structural Stages 
Each bar represents a different structural stage, and may combine 
information from several cover types. Bars are labeled with the abbreviation 
of the structural stage.  

 

Bar Graphs for Transition Groups 
Each bar shows the proportion of cells disturbed by different groups of 
probabilistic transition agents, or by deterministic transition.  The graph of 
year 0 will always be empty because no transitions can occur before the 
model starts its simulation. To avoid showing the empty graph, VDDT will 
show year 1 instead of year 0 (even if year 0 had been requested). 

 
In the above example of one graph of results by transition, the y-axis shows 
the percent of cells affected by each transition group. 

Note: 
In some cases, a probabilistic transition may be part of more than one 
transition group. For example, a transition defined as an "underburn and thin" 
may be assigned to the "thinning" group, the "fire" group and the "combined" 
group. If a cell is disturbed by a transition of this type, the cell will appear as 
affected in each of the three transition groups. 
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Generating Line Graphs Over Time 
Go to Run|Graph Results and select the General tab.  In the Graph Type 
section of the screen, click the Line radio button to generate different types 
of line graphs over time.  Line graphs can be generated for classes, cover 
types, structural stages, transition groups and attributes. 

 
Enter Start Timestep and End Timestep values to define the interval over 
which to generate the graphs.  The End Timestep value cannot be greater 
than the Number of timesteps value specified in Run|Settings|General tab.   

The first time you choose to generate line graphs for a particular variable, a 
Graphs dialog will automatically appear enabling you to specify up to four 
classes, cover types, structural stages, transition groups or attributes to graph.  
Select the desired items (Ctrl-click to select multiple items) from the list of 
available items in the left-hand pane of the dialog, and move them into the 
right-hand pane using the arrow keys.  Click OK when done.  If more than 
four items are selected, only the first four will be used to generate graphs.  In 
the example of the Graphs for Classes dialog below, Classes A, C, E and F 
have been selected for graphing. 
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VDDT will remember which items you chose to graph until you run the next 
simulation, so the Graphs dialog will not appear for subsequent generations 
of line graphs based on the same simulation.  If you wish to change the 
selection of graphs to be generated, click on the Select Graphs button; this 
action will open the Graphs dialog, allowing you to edit your choices. 

When done with your selections, click OK on the Graph Results dialog to 
generate selected graphs and close the dialog.  Click Apply to generate 
graphs and leave the dialog open.  Click Cancel to abandon your graph 
selections and close the dialog. 

Time Graphs for Classes 
This type of graph allows users to view the proportion of cells, or the area, in 
any given class over time.  Each graph represents one class that has been 
defined for the active Project.   

 

Time Graphs for Cover Types 
Cover type line graphs show the proportion of cells, or the area, for any 
given cover type over time. The graphs will resemble those generated for 
Classses (above), except each graph will represent a different cover type. 
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Time Graphs for Structural Stages 
These graphs show the proportion of cells, or the area, in any given structural 
stage over time.  The graphs will resemble those generated by the Class 
option (above), except each graph will represent a different structural stage. 

 

Time Graphs for Transition Groups 
Transition group line graphs show the percentage of cells, or the area, 
disturbed in each time step. The graphs will resemble those generated by the 
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Class option (above), except each graph will represent a different structural 
stage. 

A Graphs for Transition Groups dialog will appear with a list of all the 
transition groups, including deterministic transition. Only those probabilistic 
transitions which have occurred at least once during the simulation period 
can be selected.   

 
Choose to graph All Transitions, Deterministic Transitions, and/or 
Probabilistic Transitions by placing checkmarks in the appropriate boxes at 
the top of the dialog.  Additionally, you can graph individual probabilistic 
transitions by selecting one or more from the left-hand pane of the dialog and 
moving them into the right-hand pane using the arrow keys in the center.  If 
more than four items are chosen on this dialog, including the 3 checkbox 
items at the top of the dialog, only the first four will be shown. 

The graphs show the actual percentage of cells, or the area, disturbed in each 
time step. The pattern shown in the results depends in part on the number of 
cells being simulated. The model is stochastic, which means that the line will 
not be smooth. Larger numbers of cells, however, mean that there is a higher 
probability of some cell being disturbed, and the line may become smoother 
(i.e., the variation between years decreases). Also, the larger numbers of cells 
means that the peaks shown in the graphs may be less conspicuous. If a cell 
is disturbed when few cells are being simulated, it represents a large 
percentage of the total. For example, if 100 cells are simulated, each cell is 
1% of the total. When 1000 cells are simulated, each cell is 0.1% of the total. 
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Generating Attributes Graphs 
Attributes can be graphed as line graphs over time, and only if categorical 
(level/group), numeric and/or calculated attributes have been assigned to 
various classes (either by loading an attribute file or by assigning values 
within VDDT).  

Time Graphs for Categorical Attributes 
These graphs show the proportion of cells in a specific value of a single 
category-type attribute.  From the Run menu, select Graph Results.  On the 
General tab of the Graph Results dialog, select Attributes – Categorical.  
A dialog box will appear with all the values that have been defined for the 
selected categorical attribute.  Choose up to four values from this list.  If 
more than four are selected, only the first four will be graphed. Each graph 
represents a different attribute value. 

Time Graphs for Numeric Attributes 
For Projects that have numeric attributes defined, select Attributes – 
Numeric on the General tab of the Graph Results dialog.  A dialog box will 
appear that lists all of the numeric attributes that have been defined for the 
active Project.  Choose up to four values from this list.  If more than four are 
selected, only the first four will be graphed. Each graph represents a different 
numeric attribute. 

You can also choose to display numeric attributes as either totals or as 
averages (see about Attribute settings on the Options tab of the Graph 
Results dialog).   

Time Graphs for Calculated Attributes 
Select Attributes – Calculated from the Display Variable section of the 
General tab.  A dialog box will appear that lists all of the calculated 
attributes that have been defined for the active Project.  Choose up to four 
values from this list.  If more than four are selected, only the first four will be 
graphed. Each graph represents a different calculated attribute. 

You can also choose to display calculated attributes as totals, averages or 
averages over affected area (see about Attribute settings on the Options tab of 
the Graph Results dialog). 

Note: 
For these attributes, it is important that the values used in the calculation are 
based on the same area units as the area defined on the Initial Conditions tab 
of the Run Settings dialog (Run|Settings menu choice). 

FINAL CONDITIONS 
After a run has been completed, you can view the ending conditions without 
having to get End Values when editing initial conditions 
(Run|Settings|Initial Conditions tab). 
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To view ending conditions: 
1. Select Final Conditions from the Run menu. 

2. The Final Conditions dialog will open, showing the proportion of cells 
in each class at the end of the run.   

  
 

For runs with multiple Monte Carlo simulations, Run|Final Conditions 
displays the average of the final timestep for all Monte Carlos.  

BATCH RUN 
Users can run simulations and generate output for multiple projects 
simultaneously using the Batch Run feature under the Run menu.  Output 
and database indicators are generated based on the output settings defined for 
each project on the Output tab of the Run Settings dialog (Run|Settings 
menu choice).   

To start a batch run: 
1. Select Batch Run from the Run menu.  This action opens the Select 

Projects to Batch Run dialog.  Note that if you have a project on the 
screen that contains unsaved changes, you will be prompted to save 
them because the batch run process will close your project. 

2. Highlight the projects you wish to run from the list of Available 
Projects, and use the arrows in the center of the dialog to move your 
choices to the Selected Projects pane.  The single-headed arrow will 
move only the selected projects to the opposite pane; the double-headed 
arrow will move all available projects to the opposite pane. 

3. Click OK to conduct the batch run, or Cancel to abort the run and close 
the dialog. 

For projects in the batch run that have no output reports specified in their 
output settings, VDDT will generate two summary reports by default: 
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ClassesSummary.csv and TransitionsSummary.csv.  These files will be saved 
to the location specified in each project’s output settings.  If no location is 
specified, VDDT will automatically create a folder called Output directly 
below the folder containing the active VDDT database.  VDDT will then 
create a further subfolder under the Output folder for each batch run, naming 
the folder according to the project name. 

Note: 
When a location for output is specified for a project on the Output tab 
(Run|Settings), VDDT will send the output generated by a batch run to that 
location.  If this path is the same for two (or more) of the projects included in 
the batch run, the output from the first project to be run will be overwritten 
by the output from the next run.  There is no overwrite warning.  To ensure 
that output isn’t overwritten during a batch run, review your output paths to 
be sure there is no duplication, or simply delete the location information.  
When there is no location path on the Output tab, VDDT will use the default 
location (C:\Program Files\VDDT\Output) which includes a folder for each 
project in the batch run.   

 

Conducting Batch Runs from the Command Line 
You can conduct batch runs outside of the VDDT interface from the DOS 
command prompt.  When running batches this way, all projects in the 
specified database will be included in the run.   

To conduct a batch run from the command line: 
1. Click on the Start button and select Run; type cmd in the Open text 

box. 

 
2. This action will open a DOS window on your screen.  Change to the 

directory where the VDDT application is located on your computer by 
typing cd followed by the path, e.g.,: 

cd C:\Program Files\VDDT 

3. Click Enter to move to the selected directory.  To begin your batch run, 
type  

vddt -batch -db="filename"  
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where  

• vddt is the name of the executable file for the 
VDDT application 

• -batch instructs VDDT to launch minimized, and to 
run thru all the projects in the specified database 

• -db="filename" allows you to specify the VDDT 
database file that contains the projects you want to 
batch run; double quote delimiters are required for 
filenames that contain space characters in the path 

You can also conduct simultaneous batch runs on multiple databases from 
the DOS command prompt.  To do this, you need to create a batch (*.bat) file 
containing the locations and names of all databases to be included in the run.  
The following example shows a simple batch file specifying 3 databases 
(vddt.mdb, vddt2,mdb and vddt3.mdb) and an instruction at the end to 
display the exit code (see below). 

 

To conduct a batch run on multiple databases from the 
command line: 

1. Create a batch file (*.bat) in a text editor such as Notepad, using the 
syntax shown in the example above.   

2. With the DOS window open, change to the directory that contains your 
batch file by typing cd followed by the path.  

3. Click Enter to switch to the new directory and type the name of the 
batch file you wish to use, e.g., batch.bat 

4. VDDT will launch minimized and conduct the batch run.  When the run 
is complete, the application will return an exit code in the DOS window. 
The current values for exit codes are as follows: 

• 0 = Success 

• 1 = Database filename unrecognized or cannot be 
opened. 

• 2 = Command line batch mode (-batch) requires a 
valid database filename be specified (-
db=filename). 
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TROUBLE SHOOTING 

Trouble Shooting 
There are generally three types of problems that are encountered by users of 
VDDT. 

1. Those resulting from edits made directly to the input files, i.e., outside of 
VDDT. 

 This is the most common type of problem, simply because it is difficult 
to manually produce these complex files error-free. While it is possible 
to edit the ASCII files directly, it is not encouraged. 

2. Those resulting from changing some files and not others. 

 These problems occur when, for example, PVT files have been modified 
without also changing all corresponding scenario files or when TXT 
files are changed after having created PVT and scenario files. While 
avoiding some problems of this sort is difficult, using care when 
modifying files will ensure that these problems are kept to a minimum. 

Solutions for problems of each of these three categories are given in this 
section, organized by problem area (not category). 

Problems with the Transition Pathway Diagrams 
A class does not show up in the diagram. 
The input file may contain two classes with the same cover type and 
structural stage (and a warning would have occurred when the files were 
read). Select Edit Class Cover and Stage from the Diagram menu, and 
enter the letter of the missing class. The cover type and structural stage of the 
missing class will appear and can be edited. Remember to check all pathways 
to either of the duplicate classes to make sure that they go to the right class. 

If there is no duplication of a specific combination of cover type and 
structural stage, try re-ordering some of the classes in the input file. 

If a location file is being used, ensure that the missing class occurs in the 
location file, and that it is in a different position than other classes. 
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Some cover types are listed as numbers (or letters) in the 
diagram. 
Cover types have abbreviations which are found in the external file 
COVERC.TXT. These abbreviations show up as the cover type identifier in 
the box describing the class. Cover types without defined abbreviations show 
up as numbers. The displayed label format (as numbers or letters) does not 
affect how any part of the program functions since it only uses the numbers. 
Note, however, that any cover types that are not in the COVERC.TXT or 
COVER.TXT files will not show up in any of the graphs by cover type. This 
problem usually results from loading the wrong set of text definition files. 

To change the display from numbers to letters, add the cover type number to 
the file COVERC.TXT with a short (3-5 letter) code. Follow the format 
currently in the file. The full name of the cover type should also be added to 
the file COVER.TXT. Then, reload the cover type files 
(File|Import|Definitions|Cover types). 

Only the lines to/from one class are shown. 
The right mouse button was clicked on one of the boxes. To redraw the 
previously shown pathways, either resize the dialog box or right-click 
anywhere on the pathway diagram and select Show All Pathways from the 
context-sensitive menu. 

Pathways seem to go off the dialog box (usually on the left side). 
The number of pathways to or from a class has exceeded program 
limitations. If fewer pathways are drawn (by right-clicking on a selected 
class and choosing Show Class Pathways), the lines will likely all be drawn 
properly. The program limitation on drawing the lines does not affect any 
other program functions (i.e., the information is all retained and can be edited 
and saved properly). 

Some classes have no succession pathways from or to them. 
Only succession pathways which move from one class to another are drawn. 
Therefore, those classes which are an endpoint of succession (i.e., classes 
that go to themselves through succession) will not have any succession 
pathway emerging from them. Some classes are only reached via a 
probabilistic transition and have no deterministic transition pathways to 
them. 

Some pathways are not drawn in the diagram when they are in 
the files. 
Check to see what pathways have been requested for drawing (label in the 
upper left corner of the diagram). If the label specifies "No 0 Probabilities", 
then the pathways have not been drawn because no probabilities have been 
defined for that pathway in that management region. Either request that all 
probabilities be drawn, select a different management region, or enter a 
probability. Note that if no management region has been chosen (the label in 
the Status window is blank), the model is drawing the pathways for Region 
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1. If one of the boxes is yellow, the pathways are being drawn only to and 
from that one class. To see other pathways, right-click on a different class 
and select Show Class Pathways from the context-sensitive menu.  To see 
all pathways, resize the dialog box or right-click anywhere on the pathway 
diagram and select Show All Pathways from the context-sensitive menu. 

Also check to see if the label which specifies what pathways are being shown 
is covering some of them. An easy way to do this is to maximize the diagram 
window and look again at the pathways. 

Classes switch places when the succession pathway is changed. 
By default, VDDT draws the diagrams based on the defined succession 
pathways. When these are changed, the arrangement of the classes may also 
change. Class locations can be changed using the Set Locations option under 
the Diagram menu. 

Problems with Pathways 
The disturbance name is "UnknownCode." 
The disturbance is not listed in the file DISTCODE.TXT, and will not occur. 

Users may add the numerical code (a four-digit number between 0001 and 
9999), the transition groups to which it belongs (see DISTGRP.TXT) and the 
name of the transition (with no spaces in the name) to DISTCODE.TXT. 
Then, reload the disturbance files (File|Import|Definitions|Disturbances). 

Note: 
Note that if the final file is to be used with the CRB Assessment process, new 
numbers should not be added without checking with Don Long at the USFS 
Fire Lab in Missoula, MT. 

The destination class is @. 
The particular cover type-structural stage combination listed as the 
destination for this disturbance does not exist in the Project. Change the @ to 
the letter of the actual destination. 

This error usually occurs when the cover type or structural stage of the 
destination class was edited. 

The destination class is some letter which is not in the diagram. 
The cover type and structural stage listed as the destination for this 
disturbance were both set to zero in the input file. Change the class name (in 
the pathways window) to the letter of the actual destination. 

During deterministic transition, a class goes to itself. 
This could occur for two reasons: 
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1. The class was an "endpoint" and it would normally go nowhere else in 
the absence of any probabilistic transitions. The model needs some value 
and so makes the class go to itself after several hundred years. 

2. The cover type and structural stage listed in the input file as the 
destination for deterministic succession does not exist in the Project. By 
default, the program warns the users when the files are read in and 
changes the destination to be itself (but does not change the number of 
years or the age). To fix this, change the destination class. 

Blank lines occur in the list of disturbances from or to a box. 
The blank lines do not affect the functionality of the program. They 
correspond to probabilistic transitions that were deleted during this VDDT 
session. When the Project is saved and re-loaded, the blank lines will be 
gone. 

Changes made in the Class Properties dialog were forgotten. 
Three possible causes exist: 

1. The Close or Cancel button was used instead of the OK or Save button. 

 Enter the changes again, and click OK to save the changes. 

2. Changes were not saved when switching to the "To" (or "From") dialog 
box. 

 Enter the changes again and click OK to save and exit or, if going to the 
"To" (or "From") dialog box, reply Yes to saving the changes. 

3. The files were not saved in the previous VDDT session. 

 Save the Project before exiting or closing VDDT. 

Problems with Initial Conditions, Viewing Attributes, or 
Viewing Results 

All cells started in one class. 
Check the Initial Conditions tab (Run|Settings). The proportion of cells in 
each class should be less than one. If this dialog box shows that more than 
one class should have values, click Reset and then Normalize to make sure 
that all values are less than one, and that they add up to one. 

The results show the initial distribution is uneven but cells were 
supposed to be evenly distributed. 
Each class can only be assigned an integer number of cells. If the proportion 
of cells times the number of cells does not equal an integer number, the 
model will approximate it by giving some classes slightly fewer cells and 
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some classes slightly more. If this is of concern, increase the number of cells 
to a multiple of the number of classes. 

In the graphs over time, some transition types cannot be 
selected. 
The program will only allow the user to select transition types which have 
occurred at least once during the simulation. If for example, pathogens were 
present but did not occur, fire was present and did occur, and insects were 
not present (no probabilities had been defined), fire would be the only 
disturbance that could be selected to be viewed over time. 

In the transitions bar graphs, the bars do not add to 100 percent. 
The transitions bar graphs show the percent of pixels that were affected in 
any year, by either probabilistic or deterministic transition. Some cells will 
not have been disturbed and will not have aged enough to move to another 
class (i.e., will not go through deterministic transition). Thus, the sum of the 
percent of cells affected will not add to one. 

In the transitions bar graphs, the bars add to more than 100 
percent. 
This is a relatively rare occurrence, and it is not an error. This can occur 
because some probabilistic transitions can belong to more than one transition 
group. A cell that was disturbed will be accounted for in each group of which 
it is part. For example, a cell that is disturbed by a transition type that is ‘fire 
and bark beetles’ will appear in three different bars: fire, insects, and 
combination. When disturbance levels are high, and a large number of 
combination disturbances occur, the sum of the percentages recorded by the 
bars may be greater than 100. 

The probabilistic transition is not occurring. 
This error can occur for a number of reasons. 

1. The age range for the probabilistic transition is outside the age range of 
the class. To fix this, change the age for which the transition probability 
is valid (see about Class Properties under the Diagram menu). To 
prevent this problem from occurring, ensure that VDDT changes the 
valid ages of the probability when the age of the class is changed. 

2. A transition group to which this probabilistic transition belongs has been 
disabled. To fix this, re-enable the transition group (see about Optional 
Run Settings under the Run menu). 

3. The multiplier for this transition type or group is 0. To fix this, turn off 
the multipliers or change the multiplier to a number greater than 0 (see 
about Probability Multipliers). 

4. Transitions in the time-since-disturbance group are occurring regularly. 
Either turn off the time-since-disturbance feature, or change the number 
of years. 
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None of the attributes are a valid view or printing option. 
The types of attributes are only activated if they are present. Unlike earlier 
versions of VDDT, attributes must now be present before a model run in 
order to be activated. If attributes have been defined, try re-running the 
model. 

The calculated attribute always has a value of 0 in the graph. 
Calculated attributes are linked to specific probabilistic transitions and 
classes. Thus, the final amount of a calculated attribute will only be greater 
than 0 if an applicable transition has occurred in the right class. Check to 
ensure that the transition is occurring. 

The summary line graph only shows one line. 
Summary line graphs always have three lines. In some cases, little variation 
occurs between the different iterations, or only one iteration was done. In 
these cases, all lines may be drawn on top of or close to each other. 

How do I see the results from a different iteration? 
The graphs only show the results of the last iteration of the model run. The 
information from the other iterations is seen using the various summary 
options (see Graph Option: Display Series). To get more information about a 
single iteration, you can either repeat the iteration by starting with the 
appropriate random number seed (Run|Settings|Options), or generate an 
output report of your results which will contain information about each 
iteration in the simulation (see about Output Reports). 

Problems with Input or Output 
Errors reading PVT or SCN files (created from VDDT). 
VDDT should be able to read files that it has created (provided that they have 
not been edited outside the program; see below). Most problems arise 
because the PVT was saved as a different format than it was originally. This 
causes problems when reading new scenario files that were not being used at 
the time the format changed. Load the PVT file again, with the scenario file 
it used at the time. Save them as a different format and see if a different 
scenario file can be read. 

Errors reading PVT or SCN files (which may have been edited or 
created outside VDDT). 
Most errors occur if the files have been created or modified using an editor or 
a program other than VDDT. These problems are marked with an ‘*’ below. 
Check several things: 
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1. Is more than one copy of VDDT running? To find out, hit CTRL-ALT-
DEL once to bring up a list of the programs which Windows thinks are 
running. If more VDDT is listed more than once, close the unused ones 
by selecting them and then clicking on the End Task button. 

*2. Does the file contain tabs? If so, remove them. 

*3. Does the file have one or more blank lines after the last set of 
information or within the main body of the file? If so, remove them. 

*4. Do any of the text descriptors contain a blank character (e.g., 
Lodgepole Pine instead of LodgepolePine or Lodgepole_Pine)? If so, 
remove the blanks. 

*5. Is there a single header line before the PVT number and name? If not, 
put one in. 

and, if none of that works, 

*6. Have all the lines been counted accurately (i.e., the number of classes, 
or the number of probabilistic transitions in a class)? This error usually 
occurs if the line containing the error is the first line of a class or 
management region or the last line of a list of transitions. 

The error message may give some clue about the problem. In many cases, the 
error message will print a line number. The error may occur in that line or the 
line on either side. 

Some transition types were not in the PVT file. 
The scenario file has probabilities for transitions which are not present in the 
PVT file. This occurs when probabilistic transitions have been deleted from a 
PVT when a different scenario file was in use. The model ignores these 
transitions after giving the warning, and when the scenario file is saved, the 
transition will no longer be present. 

A class was not in the PVT file. 
A class present in the scenario file is not present in the PVT file. This occurs 
when a class has been deleted, or its cover type or structural stage changed 
when another scenario file was in use. The model ignores the class in the 
scenario file (after giving the warning), and when the scenario file is saved 
the class, and all its transition probabilities, will no longer be present. There 
is no way to tell the model what class it has been changed to. 

The destination class for deterministic or probabilistic transition 
does not exist. 
This error occurs in two places: 

1. When reading the files: Make a note of the originating class and then, 
when the diagram has been drawn, double-click on the class and edit the 
appropriate pathways. The problem pathways will be indicated by an @ 
or a strange letter combination as the destination. 

2. When editing the pathways: The problem box will be highlighted. 
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a. Check to ensure that the destination letter is one of the classes in the 
diagram. 

b. Check that location in all pages of transitions (i.e., a box in the 
second row might be highlighted but it may indicate a problem with 
the second row on page 1, 2, or 3) and ensure that the destination is 
valid. 

c. Look at the diagram. If the labels in the boxes are not all in the 
corners of the box then click on Close (or hit the ESC key). All 
changes will be lost. Then resize the diagram. If the labels of the 
boxes are now in the corners, try editing the pathway again. 

d. Make sure that blanks were not entered as well as the destination 
letter. 

The probabilistic transition name (in the output files) is 
"UnknownCode". 
The probabilistic transition is not listed in the file DISTURB.TXT, and will 
not occur. 

There are two possible fixes for this problem: 

1. Load a different DISTURB.TXT file that contains the probabilistic 
transition. This error occurs when VDDT is reading the wrong file. 

2. Add the numerical code (a four-digit number between 0001 and9999), 
the transition groups to which it belongs (see DISTGRP.TXT) and the 
name of the probabilistic transition (with no spaces in the name) to 
DISTURB.TXT. Then, load the new files 
(File|Import|Definitions|Disturbances) and save your Project.  The 
next time you open the Project, the code will have a name. 

Note: 
Note that if the final file is to be used with the CRB Assessment process, new 
numbers should not be added without checking with Don Long at the USFS 
Fire Lab in Missoula, MT. 

 

The cover type (in the output files) is "UnknownType." 
The cover type is not listed in the file COVER.TXT. As long as the cover 
type code is between 0001 and 9999, the program will function as usual 
(since it only looks at the number, not the name). 

There are two possible fixes for this problem: 

1. Load a different COVER.TXT file that contains the cover type. 

2. Add the code (a four-digit number between 0001 and 9999) and name 
the cover type (with no spaces in the name) to COVER.TXT, and the 
code and an abbreviated name (with no spaces in the name) to 
COVERC.TXT. Then, load the new files 
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(File|Import|Definitions|Cover types) and save your Project.  The next 
time you open the Project, the code will have a name. 

Note: 
Note that if the final file is to be used with the CRB Assessment process, new 
numbers should not be added without checking with Don Long at the USFS 
Fire Lab in Missoula, MT. 

 

Other Problems 
Garbage fonts. 
The fonts used by VDDT are MS Sans Serif and Roman, both Windows 
fonts. Experience has shown that when the Adobe Type Manager (ATM) is 
active, some of the labels in the program will be unreadable, especially the 
graph labels. Removing the Adobe Type Manager will alleviate these 
problems. 

The dialog box for editing pathways and probabilities isn’t 
drawing properly. 
Depending on your hardware configuration, VDDT occasionally has memory 
problems. For best results, including helping solve this problem, close all 
other open applications in your Windows session. 
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APPENDIX A:  BASIC SIMULATION ALGORITHMS 

The steps in a typical VDDT simulation are as follows (see figure below): 

• The model loops over the number of Monte Carlo simulations 
specified by the user. 

• For each Monte Carlo simulation, the model loops over the number of 
years specified. 

• For each year, the model loops over the number of cells specified. 

• For each cell, VDDT randomly permutes the order of the disturbance 
list for the current class of the cell. 

• For each cell, the model makes a random draw from a uniform 
distribution between zero and one. If that random draw is less than the 
total of all transition probabilities for the cell’s current class, then a 
transition occurs for that cell. The decision about which transition 
occurs is based on the same random draw and on the relative 
probability of all the possible transitions. For example: Class A has 
three possible probabilistic transitions in this order: Fire (p=0.01), 
Wind (p=0.001) and Insects (p=0.02). A random number R is drawn. 
R≤ 0.01 would result in a fire, 0.01<R≤0.011 would result in Wind, 
0.011<R≤0.031 would result in Insects, and 0.031<R would result in 
no transition. Beware that when the sum of input probabilities for a 
class exceeds 1, the observed probabilities will not match the inputs. 
This is because only a single probabilistic transition can occur to a cell 
per time-step. 



VDDT 6.0 User Guide 

122 

 



Appendices 

123 

APPENDIX B:  
ABOUT PROBABILITY DISTRIBUTIONS IN VDDT 

For all the pixels of the same class at any one time step there are two possible 
outcomes — being disturbed or not. The probability distribution for the 
number of disturbed pixels of that class at any one time step is the binomial 
distribution: 

knk pp
knk

nkxP −−
−

== )1(
)!(!

!)(  

where n is the total number of pixels, p is the probability of disturbance and k 
is the observed number of disturbed pixels. The mean of this distribution is 
np and the variance is np(1-p). 

When n is large and p is small – the binomial distribution can be 
approximated by the Poisson distribution: 

!
)(

k
ekxP

kµµ−

==  

where µ is both the mean and the variance of the distribution. When 
approximating the binomial distribution µ is equal to np. The Poisson 
distribution describes the number of events that will occur within a given 
time period or area when the probability of occurrence is constant across 
space and time, events occur randomly and are independent of each other.  

In addition to describing the distribution of the number of pixels affected by 
a disturbance in any one VDDT time step we can also describe the following 
distributions: 

1. The Return Interval Distribution f(t) is the probability distribution of the 
waiting times required before a disturbance occurs. 

2. The Cumulative Mortality Distribution F(t) is the cumulative version of 
f(t) or the time required for a given proportion of the landscape to have 
been affected by a particular disturbance. 

3. The Cumulative Survivorship Distribution A(t) is equal to (1-F(t)) or the 
proportion of the landscape surviving to be at least t years old before 
being affected by a disturbance. 
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Other distributions in VDDT

• The Return Interval Distribution f(t) is the probability 
distribution of the waiting times required before a 
disturbance occurs.
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Other distributions in VDDT

• The Cumulative Mortality Distribution F(t)  (cumulative 
f(t)) is the time required for a proportion of the 
landscape to be affected by a disturbance.
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• The Cumulative Survivorship Distribution A(t) is equal to 
(1-F(t)) or the proportion of the landscape surviving to 
be at least t years old without being affected by a 
disturbance.
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Other distributions in VDDT

 
 

The probability of being disturbed at time t is known as the Hazard of 
Disturbance Function and is defined as: 

λ(t) =f(t)/A(t) 

 

If the Hazard of Disturbance decreases with time, older pixels are less likely 
to be disturbed. If it increases with time, older pixels are more likely to be 
disturbed. If λ(t) is constant that means that the probability of being disturbed 
is independent of age.  
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The negative exponential

Negative exponential Distribution
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In the case where: the Hazard of Disturbance is independent of age; the 
probability of disturbance is constant over time; and the probability of 
whether any pixel is disturbed is independent of what happens to all other 
pixels, the Return Interval Distribution f(t) can be described by the negative 
exponential distribution: 

ptpetf −=)(  

The Cumulative Mortality Distribution F(t) is the integral of this and can be 
described by: 

ptetF −−= 1)(  

The Cumulative Survivorship Distribution A(t) can be described by: 

ptetA −=)(  

And the Hazard (or probability) of Disturbance is: 

pt =)(λ  

In this case p is equal to the probability of disturbance at any point in time. 

 

The Negative Exponential Distribution of Disturbance Return Intervals is a 
special case of the more flexible Weibull Distribution first proposed by 
Johnson (1979) as a description of Fire Return Intervals. In this distribution 
the assumption of a constant hazard of disturbance with age is not necessary. 
The Weibull Return Interval Distribution is described by: 
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( )cptcc ectptf −−= 1)(  

The Cumulative Mortality Distribution F(t) can be described by: 

( )cptetF −−=1)(  

The Cumulative Survivorship Distribution A(t) can be described by: 

( )cptetA −=)(  

And the Hazard of Disturbance function is: 

1)( −= ccctptλ  

If c < 1, the Hazard of Disturbance decreases with age, if c = 1 the Hazard of 
Disturbance is constant and equal to p (negative exponential model); if c > 1, 
the Hazard of Disturbance increases with age. 
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APPENDIX C:  
DATA STRUCTURE AND PROCESSING 

VDDT version 6.0 stores all key model input in a relational Microsoft Access 
2000 database. Multiple VDDT databases can be stored on a single computer 
and users can select which database to use within a VDDT session by 
selecting the Database option from the File menu and navigating to the 
appropriate Microsoft Access database file (i.e. with extension .MDB). Each 
VDDT database file can contain multiple ‘Projects’. A ‘Project’ is essentially 
an independent model in VDDT. It contains all the necessary information to 
edit the inputs, run and view the output of a model.  

With version 5.0 and later, a typical VDDT session goes as follows: 

• When VDDT starts, the application establishes a connection with the 
database that was used most recently. 

• Model data are brought into memory either by ‘importing’ it from the 
version 4 text file format (using File|Import), or by opening an 
existing Project in the database (using File|Open). 

• The user makes changes to the VDDT model (in memory) either by 
changing parameters through the user interface or running the model. 

• Any changes to the model can be saved by the user back to the 
database using the File|Save and File|Save As menu options; 
alternatively, models can be saved to old version 4 text file format 
using the File|Export option. 



Appendices 

129 

 

ESSA Technologies Ltd.

VDDT Version 6.0 Data Structure and Processing

Project: Mixed Conifer Model

Attribute 
Files

Temporal
Variability

Files

Landscape
Condition
Feedback

Files

Old Format
Files

Definitions
PVT SCN...

User
Interface

Output 
Files

Detailed Output

Access Database (VDDT-201.mdb)

RAM

Open

Save

Cover Types
Structural Stages
Disturbance Types
Disturbance Groups
Initial Conditions

Deterministic Transitions
Probabilistic Transitions
External File Information
Output

Export

Import

Summary Output

User Input

Project: Jeffrey Pine Model
Project: Jeffrey Pine Model

Save
Open

 
 



VDDT 6.0 User Guide 

130 

APPENDIX D:  
DEFINITIONS AND FILE DESCRIPTIONS 

ATTRIBUTE STRUCTURE FILE (*.ATT) 
The attributes are stored in a file that has the format: 

Line 1: PVTno, number of attributes, list of the name of each attribute (in 
" ", and separated by commas) 

Line 2: PVTno, number of attributes, list of the type of each attribute (in 
" ", and separated by commas) 

Line 3: PVTno, number of attributes, list of the units for each attribute (in 
" ", and separated by commas) 

Lines by class: 

PVTno, ss-ct #, list of the value of each attribute (in " ", and 
separated by commas) 

One line for all calculated attributes: 

PVTno, -9999, number of time intervals, time steps for the 
intervals including start and end year 

Repeat for each calculated attribute: 

Lines for defining calculated attributes: 

PVTno, -999, name of calculated attribute, min and max 
limit for each time interval 

PVTno, "distid", "att", number of disturbance, disturbance 
numbers 

Lines with calculated attribute values: 

PVTno, disturbance number, number of attribute that this is 
based on, multiplier, value for each disturbance type. Note 
that each row can contain either the number of the attribute 
and the multiplier, or values for each disturbance type. If 
both are present, only the first set will be saved. 

The "ss-ct #" is a combination number of the structural stage 
and the cover type number, with the structural stage being 
the first 1-2 numbers and the cover type being the last four 
numbers. For example, if the ss-ct # was 261015 (see the 
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fourth row of the example), the structural stage would be 26 
and the cover type would be 1015. 

An example of an attribute file with two calculated attributes and one 
numerical attribute: 

 57, 3,"calcatt", "numatt ", "calcatt2" 
 57, 3,"Calculated", "Numerical", "Calculated" 
 57, 3,"", "m", "" 
 57, 261015,, 10, 
 57, 12009,, 11, 
 57, 32009,, 12, 
 57, 42009,, 13, 
 57, 52009,, 14, 
 57, 62009,, 15, 
 57, -9999, 3 , 1 , 50 , 69 , 100  
 57, -999, "calcatt", 1 , 2 , 3 , 4 , 11 , 12   
 57, "distid", " att", 6, 261015, 12009, 32009, 42009, 52009, 62009 
 57, 1022, 0, 11, 1, 0, 0, 0, 0, 0 
 57, -999, "calcatt2", 5 , 6 , 7 , 8 , 13 , 14 
 57, "distid", " att", 6, 261015, 12009, 32009, 42009, 52009, 62009 
 57, 1022, 2, 22, 0, 0, 0, 0, 0, 0 

BETWEEN-YEAR VARIABILITY FILES 
The information about between-year variability is stored in between three 
and five different files. If information about annual variation is present, only 
the annual multiplier file is needed. If new annual multipliers are to be 
generated, year sequence group and year-type multipliers will also be 
needed. 

Year sequence group files (*.YSG) 
This file contains all the information relating to "Year Sequence Groups". 
The first line of the file contains the number of YSGs that are present in the 
file. Then, the first line of each YSG lists the name of the YSG (in quotation 
marks), the percentage of the years that are in each type of year ("Very Low", 
"Low", "Normal", "High", and "Severe"), and the number of disturbances in 
the YSG. The lines following give the disturbance id numbers for each of the 
disturbance types in the YSG. 

 
 2 
"Fires" 16  57  11  11  5  6 
 3014 
 3011 
 3019 
 3004 
 3001 
 3009 
"Pests" 10  80  5  3  2  2 
 2002 
 2101 
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Year-type multipliers file (*.YTM) 
This file contains the multipliers associated with each disturbance type and 
each type of year. Note that in order to load this file, some information about 
YSGs must already be in memory. 

Each line gives a disturbance id number and the multipliers used for that 
disturbance in each of the five types of years ("Very Low", "Low", 
"Normal", "High", and "Severe"). Note that only the disturbances that are in 
a YSG are printed to this file. 

 
 3011   0.2 1 2 5 10 
 3014   0.2 1 2 5 10 
 3019   0.2 1 2 5 10 
 3001   0.2 1 3 7 10 
 3004   0.1 1 2 4 8 
 3009   0.1 1 1.5 3 6 
 2002   0.5 1 2 5 8 
 2101   0.1 1 2 4 5 

Year-type sequence file (*.TSE) 
This file contains the type of year for each year that was generated (up to 300 
years) for one or more YSGs. Each year is given a number from 1 to 5 to 
represent the different year types: 

1 = "Very Low", 
2 = "Low", 
3 = "Normal", 
4 = "High", and 
5 = "Severe". 

The first line of the file gives the number of years that are listed. The first 
line of YSG then gives a YSG number (which is the number of the YSG at 
the time it was saved) and the name of the YSG. Each line following (for that 
YSG) gives the year and the type of year. 

In the example file, only 20 years have been printed. 

 
 20 
 1 Fires 
 1    2 
 2    3 
 3    2 
 4    2 
 5    4 
 6    2 
 7    2 
 8    2 
 9    1 
 10   2 
 11   2 
 12   4 
 13   3 
 14   1 
 15   2 
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 16   2 
 17   2 
 18   2 
 19   1 
 20   5 
 2 Pests 
 1    2 
 2    4 
 3    1 
 4    2 
 5    2 
 6    2 
 7    2 
 8    2 
 9    2 
 10   2 
 11   2 
 12   2 
 13   3 
 14   2 
 15   2 
 16   2 
 17   2 
 18   2 
 19   2 
 20   1 

Multiplier sequence files (*.MSE) 
This file contains a multiplier for each disturbance type for each year that 
was generated (up to 300 years). The values in this file are the originally 
generated multipliers that have not been normalized. The file has the format: 

 
20 
 1 "Fires" 6 
 0  3014 3011 3019 3004 3001 3009 
 1  1  1  1  1  1  1 
 2  2  2  2  2  3  1.5 
 3  1  1  1  1  1  1 
 4  1  1  1  1  1  1 
 5  5  5  5  4  7  3 
 6  1  1  1  1  1  1 
 7  1  1  1  1  1  1 
 8  1  1  1  1  1  1 
 9  0.2  0.2  0.2  0.1  0.2  0.1 
 10  1  1  1  1  1  1 
 11  1  1  1  1  1  1 
 12  5  5  5  4  7  3 
 13  2  2  2  2  3  1.5 
 14  0.2  0.2  0.2  0.1  0.2  0.1 
 15  1  1  1  1  1  1 
 16  1  1  1  1  1  1 
 17  1  1  1  1  1  1 
 18  1  1  1  1  1  1 
 19  0.2  0.2  0.2  0.1  0.2  0.1 
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 20  10  10  10  8  10  6 
 2 "Pests" 2 
 0  2002 2101 
 1  1  1 
 2  5  4 
 3  0.5  0.1 
 4  1  1 
 5  1  1 
 6  1  1 
 7  1  1 
 8  1  1 
 9  1  1 
 10  1  1 
 11  1  1 
 12  1  1 
 13  2  2 
 14  1  1 
 15  1  1 
 16  1  1 
 17  1  1 
 18  1  1 
 19  1  1 
 20  0.5  0.1 

Normalized sequence files (*.NSE) 
This file contains a normalized multiplier for each disturbance type for each 
year that was generated (up to 300 years). The file format is identical to the 
multiplier sequence file. 

 
 

20 
 1 "Fires" 6 
 0  3014 3011 3019 3004 3001 3009 
 1  0.947 0.947 0.947 0.96 0.929 0.976 
 2  1.895 1.895 1.895 1.921 2.789 1.464 
 3  0.947 0.947 0.947 0.96 0.929 0.976 
 4  0.947 0.947 0.947 0.96 0.929 0.976 
 5  4.737 4.737 4.737 3.842 6.509 2.928 
 6  0.947 0.947 0.947 0.96 0.929 0.976 
 7  0.947 0.947 0.947 0.96 0.929 0.976 
 8  0.947 0.947 0.947 0.96 0.929 0.976 
 9  0.189 0.189 0.189 0.096 0.185 0.097 
 10  0.947 0.947 0.947 0.96 0.929 0.976 
 11  0.947 0.947 0.947 0.96 0.929 0.976 
 12  4.737 4.737 4.737 3.842 6.509 2.928 
 13  1.895 1.895 1.895 1.921 2.789 1.464 
 14  0.189 0.189 0.189 0.096 0.185 0.097 
 15  0.947 0.947 0.947 0.96 0.929 0.976 
 16  0.947 0.947 0.947 0.96 0.929 0.976 
 17  0.947 0.947 0.947 0.96 0.929 0.976 
 18  0.947 0.947 0.947 0.96 0.929 0.976 
 19  0.189 0.189 0.189 0.096 0.185 0.097 
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 20  9.475 9.475 9.475 7.684 9.299 5.857 
 2 "Pests" 2 
 0  2002 2101 
 1  0.986 0.992 
 2  4.934 3.97 
 3  0.493 0.099 
 4  0.986 0.992 
 5  0.986 0.992 
 6  0.986 0.992 
 7  0.986 0.992 
 8  0.986 0.992 
 9  0.986 0.992 
 10  0.986 0.992 
 11  0.986 0.992 
 12  0.986 0.992 
 13  1.973 1.985 
 14  0.986 0.992 
 15  0.986 0.992 
 16  0.986 0.992 
 17  0.986 0.992 
 18  0.986 0.992 
 19  0.986 0.992 
 20  0.493 0.099 

COMMA-DELIMITED FILES 
Two comma-delimited files, in the format expected by the CRB Paradox 
database, are created when users select Export and then Comma-delimited 
from the File menu.  

The comma-delimited PVT file (*.PDX) consists of 17 columns which 
describe the class, its succession destination, the disturbances, and their 
destination. The columns are: 

1. the PVT number; 

2. the class identifier as a value with the structural stage in the first one or 
two digits and the cover type as the last four digits; 

3. a disturbance code; 

4. the number of classes in the PVT; 

5. the number of the current class (the class being described); 

6. the structural stage of the class; 

7. the cover type of the class; 

8. the beginning age of the class; 

9. the ending age of the class; 

10. the class to which this class goes during succession; 

11. a column containing a zero (which is not used); 

12. the number of disturbances in the class; 

13. the destination for the disturbance as the combined class identifier; 

14. the age of the pixel after the disturbance; 
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15. the age increment of the pixel (used if it stays in the same class); 

16. the structural stage of the destination class; and 

17. the cover type of the destination class. 

 
 999, 12009, 3001, 6, 2, 1, 2009, 6, 51, 32009,0, 1, 261015, 1, 0, 26, 1015 
 999, 32009, 3001, 6, 3, 3, 2009, 51, 91, 42009,0, 8, 261015, 1, 0, 26, 1015 
 999, 32009, 3011, 6, 3, 3, 2009, 51, 91, 42009,0, 8, 261015, 1, 0, 26, 1015 
 999, 32009, 3021, 6, 3, 3, 2009, 51, 91, 42009,0, 8, 261015, 1, 0, 26, 1015 
 999, 32009, 3030, 6, 3, 3, 2009, 51, 91, 42009,0, 8, 42009, 91, 0, 4, 2009 
 999, 32009, 3106, 6, 3, 3, 2009, 51, 91, 42009,0, 8, 32009, 51, 10, 3, 2009 
 999, 32009, 1103, 6, 3, 3, 2009, 51, 91, 42009,0, 8, 32009, 51, 20, 3, 2009 
 999, 32009, 1101, 6, 3, 3, 2009, 51, 91, 42009,0, 8, 42009, 91, 0, 4, 2009 
 999, 32009, 1001, 6, 3, 3, 2009, 51, 91, 42009,0, 8, 261015, 1, 0, 26, 1015 
 999, 42009, 1001, 6, 4, 4, 2009, 91, 131, 62009,0, 11, 261015, 1, 0, 26, 1015 
 999, 42009, 1021, 6, 4, 4, 2009, 91, 131, 62009,0, 11, 52009, 131, 0, 5, 2009 
 999, 42009, 3001, 6, 4, 4, 2009, 91, 131, 62009,0, 11, 261015, 1, 0, 26, 1015 
 999, 42009, 3011, 6, 4, 4, 2009, 91, 131, 62009,0, 11, 261015, 1, 0, 26, 1015 
 999, 42009, 3021, 6, 4, 4, 2009, 91, 131, 62009,0, 11, 261015, 1, 0, 26, 1015 
 999, 42009, 3009, 6, 4, 4, 2009, 91, 131, 62009,0, 11, 42009, 91, 0, 4, 2009 
 999, 42009, 3019, 6, 4, 4, 2009, 91, 131, 62009,0, 11, 42009, 91, 0, 4, 2009 
 999, 42009, 3029, 6, 4, 4, 2009, 91, 131, 62009,0, 11, 42009, 91, 0, 4, 2009 
 999, 42009, 3483, 6, 4, 4, 2009, 91, 131, 62009,0, 11, 261015, 1, 0, 26, 1015 
 999, 42009, 2002, 6, 4, 4, 2009, 91, 131, 62009,0, 11, 52009, 131, 0, 5, 2009 
 999, 42009, 1103, 6, 4, 4, 2009, 91, 131, 62009,0, 11, 42009, 91, 10, 4, 2009 
 999, 52009, 1001, 6, 5, 5, 2009, 131, 211, 62009,0, 11, 261015, 1, 0, 26, 1015 
 999, 52009, 3001, 6, 5, 5, 2009, 131, 211, 62009,0, 11, 261015, 1, 0, 26, 1015 
 999, 52009, 3011, 6, 5, 5, 2009, 131, 211, 62009,0, 11, 261015, 1, 0, 26, 1015 
 999, 52009, 3021, 6, 5, 5, 2009, 131, 211, 62009,0, 11, 261015, 1, 0, 26, 1015 
 999, 52009, 3030, 6, 5, 5, 2009, 131, 211, 62009,0, 11, 52009, 131, 0, 5, 2009 
 999, 52009, 1021, 6, 5, 5, 2009, 131, 211, 62009,0, 11, 52009, 131, 0, 5, 2009 
 999, 52009, 1103, 6, 5, 5, 2009, 131, 211, 62009,0, 11, 52009, 131, 0, 5, 2009 
 999, 52009, 3440, 6, 5, 5, 2009, 131, 211, 62009,0, 11, 52009, 131, 0, 5, 2009 
 999, 52009, 3441, 6, 5, 5, 2009, 131, 211, 62009,0, 11, 52009, 131, 0, 5, 2009 
 999, 52009, 3442, 6, 5, 5, 2009, 131, 211, 62009,0, 11, 52009, 131, 0, 5, 2009 
 999, 52009, 2002, 6, 5, 5, 2009, 131, 211, 62009,0, 11, 52009, 131, 0, 5, 2009 
 999, 62009, 3001, 6, 6, 6, 2009, 131, 1130, 62009,0, 4, 261015, 1, 0, 26, 1015 
 999, 62009, 1001, 6, 6, 6, 2009, 131, 1130, 62009,0, 4, 261015, 1, 0, 26, 1015 
 999, 62009, 1021, 6, 6, 6, 2009, 131, 1130, 62009,0, 4, 52009, 131, 0, 5, 2009 
 999, 62009, 2002, 6, 6, 6, 2009, 131, 1130, 62009,0, 4, 52009, 131, 0, 5, 2009 

 

The Paradox-format scenario file (*.PSC) consists of 15 columns which 
describe the scenario and its associated disturbance probabilities. As in the 
standard scenario file, no disturbances with zero probabilities are included. 
The columns are: 

1. the PVT number; 

2. a disturbance code; 

3. the class identifier as a combined structural stage (first one or two digits) 
and cover type (last four digits) value; 

4. the management region (as a number); 

5. the phase number; 

6. an brief description of the scenario; 
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7. the structural stage; 

8. the cover type; 

9. a class counter (note that this does not correspond to the class number in 
the PVT file); 

10. the first year of the simulation (usually a 0); 

11. the number of years to simulate; 

12. the number of disturbances in the class; 

13. number of combinations of PVT number and class identifiers in the file 
(this will usually correspond to the number of classes in the file); 

14. the number of management regions; and 

15. the probability of disturbance. 

 
 999, 3001, 12009, 1, 1, "Example", 1, 2009, 1, 0, 300, 1, 5, 3, .006 
 999, 3001, 32009, 1, 1, "Example", 3, 2009, 2, 0, 300, 3, 5, 3, .002 
 999, 3021, 32009, 1, 1, "Example", 3, 2009, 2, 0, 300, 3, 5, 3, .001 
 999, 3106, 32009, 1, 1, "Example", 3, 2009, 2, 0, 300, 3, 5, 3, .0002 
 999, 3001, 42009, 1, 1, "Example", 4, 2009, 3, 0, 300, 5, 5, 3, .004 
 999, 3021, 42009, 1, 1, "Example", 4, 2009, 3, 0, 300, 5, 5, 3, .0015 
 999, 3009, 42009, 1, 1, "Example", 4, 2009, 3, 0, 300, 5, 5, 3, .0001 
 999, 3483, 42009, 1, 1, "Example", 4, 2009, 3, 0, 300, 5, 5, 3, .0015 
 999, 2002, 42009, 1, 1, "Example", 4, 2009, 3, 0, 300, 5, 5, 3, .01 
 999, 3001, 52009, 1, 1, "Example", 5, 2009, 4, 0, 300, 4, 5, 3, .0025 
 999, 3021, 52009, 1, 1, "Example", 5, 2009, 4, 0, 300, 4, 5, 3, .0025 
 999, 3440, 52009, 1, 1, "Example", 5, 2009, 4, 0, 300, 4, 5, 3, .0001 
 999, 2002, 52009, 1, 1, "Example", 5, 2009, 4, 0, 300, 4, 5, 3, .001 
 999, 3001, 62009, 1, 1, "Example", 6, 2009, 5, 0, 300, 2, 5, 3, .007 
 999, 2002, 62009, 1, 1, "Example", 6, 2009, 5, 0, 300, 2, 5, 3, .01 
 999, 3001, 12009, 2, 1, "Example", 1, 2009, 1, 0, 300, 1, 5, 3, .006 
 999, 3001, 32009, 2, 1, "Example", 3, 2009, 2, 0, 300, 5, 5, 3, .002 
 999, 3106, 32009, 2, 1, "Example", 3, 2009, 2, 0, 300, 5, 5, 3, .0002 
 999, 1103, 32009, 2, 1, "Example", 3, 2009, 2, 0, 300, 5, 5, 3, .0125 
 999, 1101, 32009, 2, 1, "Example", 3, 2009, 2, 0, 300, 5, 5, 3, .0023 
 999, 1001, 32009, 2, 1, "Example", 3, 2009, 2, 0, 300, 5, 5, 3, .0015 
 999, 1001, 42009, 2, 1, "Example", 4, 2009, 3, 0, 300, 6, 5, 3, .023 
 999, 1021, 42009, 2, 1, "Example", 4, 2009, 3, 0, 300, 6, 5, 3, .002 
 999, 3001, 42009, 2, 1, "Example", 4, 2009, 3, 0, 300, 6, 5, 3, .004 
 999, 3009, 42009, 2, 1, "Example", 4, 2009, 3, 0, 300, 6, 5, 3, .0001 
 999, 3483, 42009, 2, 1, "Example", 4, 2009, 3, 0, 300, 6, 5, 3, .0015 
 999, 2002, 42009, 2, 1, "Example", 4, 2009, 3, 0, 300, 6, 5, 3, .01 
 999, 3001, 52009, 2, 1, "Example", 5, 2009, 4, 0, 300, 6, 5, 3, .004 
 999, 1021, 52009, 2, 1, "Example", 5, 2009, 4, 0, 300, 6, 5, 3, .0012 
 999, 3440, 52009, 2, 1, "Example", 5, 2009, 4, 0, 300, 6, 5, 3, .0001 
 999, 3441, 52009, 2, 1, "Example", 5, 2009, 4, 0, 300, 6, 5, 3, .0001 
 999, 3442, 52009, 2, 1, "Example", 5, 2009, 4, 0, 300, 6, 5, 3, .0001 
 999, 2002, 52009, 2, 1, "Example", 5, 2009, 4, 0, 300, 6, 5, 3, .001 
 999, 3001, 62009, 2, 1, "Example", 6, 2009, 5, 0, 300, 4, 5, 3, .007 
 999, 1001, 62009, 2, 1, "Example", 6, 2009, 5, 0, 300, 4, 5, 3, .05 
 999, 1021, 62009, 2, 1, "Example", 6, 2009, 5, 0, 300, 4, 5, 3, .005 
 999, 2002, 62009, 2, 1, "Example", 6, 2009, 5, 0, 300, 4, 5, 3, .01 
 999, 3001, 12009, 3, 1, "Example", 1, 2009, 1, 0, 300, 1, 5, 3, .006 
 999, 3001, 32009, 3, 1, "Example", 3, 2009, 2, 0, 300, 5, 5, 3, .002 
 999, 3106, 32009, 3, 1, "Example", 3, 2009, 2, 0, 300, 5, 5, 3, .0002 
 999, 1103, 32009, 3, 1, "Example", 3, 2009, 2, 0, 300, 5, 5, 3, .0125 
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 999, 1101, 32009, 3, 1, "Example", 3, 2009, 2, 0, 300, 5, 5, 3, .0023 
 999, 1001, 32009, 3, 1, "Example", 3, 2009, 2, 0, 300, 5, 5, 3, .0015 
 999, 1001, 42009, 3, 1, "Example", 4, 2009, 3, 0, 300, 6, 5, 3, .023 
 999, 1021, 42009, 3, 1, "Example", 4, 2009, 3, 0, 300, 6, 5, 3, .002 
 999, 3001, 42009, 3, 1, "Example", 4, 2009, 3, 0, 300, 6, 5, 3, .004 
 999, 3009, 42009, 3, 1, "Example", 4, 2009, 3, 0, 300, 6, 5, 3, .0001 
 999, 3483, 42009, 3, 1, "Example", 4, 2009, 3, 0, 300, 6, 5, 3, .0015 
 999, 2002, 42009, 3, 1, "Example", 4, 2009, 3, 0, 300, 6, 5, 3, .01 
 999, 3001, 52009, 3, 1, "Example", 5, 2009, 4, 0, 300, 6, 5, 3, .004 
 999, 1021, 52009, 3, 1, "Example", 5, 2009, 4, 0, 300, 6, 5, 3, .0012 
 999, 3440, 52009, 3, 1, "Example", 5, 2009, 4, 0, 300, 6, 5, 3, .0001 
 999, 3441, 52009, 3, 1, "Example", 5, 2009, 4, 0, 300, 6, 5, 3, .0001 
 999, 3442, 52009, 3, 1, "Example", 5, 2009, 4, 0, 300, 6, 5, 3, .0001 
 999, 2002, 52009, 3, 1, "Example", 5, 2009, 4, 0, 300, 6, 5, 3, .001 
 999, 3001, 62009, 3, 1, "Example", 6, 2009, 5, 0, 300, 4, 5, 3, .007 
 999, 1001, 62009, 3, 1, "Example", 6, 2009, 5, 0, 300, 4, 5, 3, .05 
 999, 1021, 62009, 3, 1, "Example", 6, 2009, 5, 0, 300, 4, 5, 3, .005 
 999, 2002, 62009, 3, 1, "Example", 6, 2009, 5, 0, 300, 4, 5, 3, .01 

COVER TYPE CODES FILES (COVER.TXT, COVERC.TXT) 
Cover types are defined by a four-digit code between 0001 and 9999. 

Two cover type code files are necessary for the model to operate. 
COVER.TXT gives a long version of the name COVERC.TXT is a file 
containing 4-6 letter abbreviations for the cover types. These abbreviations 
are the ones seen in the transition pathway diagram. This appendix lists only 
the long version of the cover types and their numbers. 

This example file is the one distributed with VDDT. 
1001 Rock/Barrenlands 
1002 Water 
1004 Grass/Forb 
1005 Shrub/Regen 
1009 Exotics 
1010 PerennialNativeBunchgrass 
1013 MountainShrub 
1014 HerbShrub 
1015 GeneralShrub 
1016 MountainShrub(Ceanothus) 
1017 BareSoil 
2001 Spruce/SubAlpineFir 
2002 WhitebarkPine 
2003 Douglas Fir 
2005 WesternLarch 
2006 Grand/WhiteFir 
2007 WhitePine 
2008 Aspen 
2009 LodgepolePine 
2010 MountainHemlock 
2011 PacificSilverFir 
2012 HemlockCedar 
2013 ShastaRedFir 
2014 Aspen/Poa 
2014 Aspen/Exotic 
2018 InteriorPonderosaPine 
2023 WhitebarkPine/SubalpineLarch 
2024 SubalpineLarch 
2025 JuniperWoodland 

4013 SeededNativeGrass(AGSP/FEID) 
4015 LowprodPerennialGrass 
4019 PioneerForbs 
4020 SmallPerennialGrass 
4021 NativeForbs 
4022 ExoticPerennialGrass 
4023 ExoticForbs 
4024 ExoticHerbaceous 
4025 JuniperForest/ExoticHerb 
4027 ArtemisArbuscula/NativeForbs 
4028 Juniper/LowSage/Shortgrass 
4029 Juniper/PoaSecunda 
4031 ArtemisiaArbuscula/NativeBunchgrass 
4038 ExoticAnnualGrass 
4040 SitanionHystrix 
4042 PoaSecunda 
4043 Poa/PerennialGrass 
4047 ExoticGrass(BRTE/ELCA/POSE) 
4048 SeededNativeGrass(POSE/AGSP) 
4049 FireMaintainedGrass(POSE/AGSP) 
4057 PoaPratensis 
4058 Salix/Carex 
4059 Salix/Grass 
4060 Grass/Carex 
4079 GravelBar 
4080 Populus/Cornus 
4081 PopulusTrichocarpa 
4084 Populus/PoaPratensis 
4087 Cornus/Crateagus 
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2027 LimberPine 
2030 SierraMixedConifer 
2031 PacificPonderosaPine 
3001 AgropyronSpicatum 
3003 Purshia/AgropyronSpicatum 
3004 Juniper/Sagebrush/Wheatgrass 
3007 MountainMahogany 
3010 IdahoFescue/Wheatgrass 
3013 Artemisia_tri_tri 
3015 SaltDesertShrub 
3016 Chokecherry/Serviceberry/Rose 
3021 Artemisia/ElymusCinereus 
3022 ThreetipSagebrush 
4001 ConiferEncroachment/ExoticGrass 
4003 ExoticForbs 

4089 Salix/Calamagrostis 
4090 Salix/Carex 
4091 Salix/ExoticForbs 
4092 Salix/PoaPratensis 
4093 ExoticHerbs 
4094 DeschampsiaCalamagrostis 
4095 ExoticRiparianHerbs 
4096 ExoticMoistHerbs 
4097 Agropyron/PoaSecunda 
4098 PoaSecunda/FestucaOctaflora 
4099 Artemisia/PoaSecunda 
5001 BromusTectorum 
5002 Artemisia/BromusTectorum 
5006 SeededExoticAgropyron 
5009 ArtemisiaVasy_triden/PerennialGrass 

5011 ConiferEncroachment/Sage/PerennialGrass 
5012 NativePerennialGrass 
5013 ArtemisiaVasy_triden/PerrennialHerbs 
5014 PerennialNativeHerbs 
5016 ArtemisiaVasy_triden/PerennialGrass 
5017 ConiferEncroachment/Sage/PerennialGrass 
5019 Conifer/PerennialGrass 
5021 ArtemisiaVasy_triden/ExoticHerbs 
5039 IrrigatedCrop 
5040 DrylandPasture/HayLand 
5041 IrrigatedPasture/HayLand 
5043 UrbanLand 
5046 DrylandCrop 
5047 DrylandPasture/HayLand 
5050 ElymusCinereus 
5051 ElymusCinereus/Agropyron 
5052 ElymusCinereus/BromusTectorum 
5053 AgropyronCristatum 
5055 AgropyronCristatum/BromusTectorum 
5056 PerennialHerbs 
5059 ArtemisiaTriparteta/Exotics 
5060 ArtemisiaTriparteta/AgropyronCristatum 

5061 AristidaLongiseta 
5062 ArtemisiaArbuscula/BromusTectorum 
5063 PurshiaTridentata/BromusTectorum 
5064 PoaSecunda/PerennialForbs 
5066 SarcobatusVermiculatus 
5067 Ryegrass 
5068 Greasewood/Saltgrass 
5069 Greasewood 
5070 Juniper/LowSage/Fescue 
5072 Phylodoce 
5073 Conifer/ExoticHerbs 
5074 Juniper/NativeBunchgrass 
5075 Juniper/ExoticHerbs 
5076 Pinus/Populus/Shrub 
5077 Fir/Populus/Shrub 
5078 Pinus/Populus/Exotic 
5079 Fir/Exotic 
5080 WhiteOak/Shrub 
5081 MidShrub 
5082 WhiteOak/Exotic 
5084 CarexRostrata/aquatilis 
5085 CarexNebraskensis 

DISTURBANCE CODE FILE: DISTCODE.TXT 
This file defines all the possible disturbances that can occur in the model. 
Each disturbance is given a four-digit code and a short name. In addition, 
each disturbance can be a member of between one and three disturbance 
groups (see the disturbance group file description for more details). The 
numerical code must be an integer between 0001 and 9999. The short name 
must contain no commas or blanks, should be fewer than 10 characters 
(although there is no limit), and should be reasonably descriptive. 

The file lists the information in five columns: 

col 1: the numerical code; 

cols 2-4: the number of the disturbance groups to which this disturbance 
belongs; 

col 5: the short description of the type of disturbance. 

For ease of reference, the file is printed here in three sets of columns. This 
example file is the one distributed with VDDT and may be edited as needed. 
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1001 1 0 0 CC-Noprep 
1003 1 0 0 GrpSelCut 
1005 1 0 0 IndSelCut 
1006 1 0 0 OSR 
1009 1 0 0 SanitationCut 
1012 1 0 0 Shelterwood 
1014 1 6 0 CC+PlantPP 
1015 1 6 0 CC+PlantDF 
1016 1 6 0 CC+PlantWL 
1017 1 6 0 CC+Plant 
1018 1 6 0 CC+PlantWP 
1020 1 0 0 PartialCut6 
1021 1 0 0 PartialCut 
1022 1 5 0 CC+Burn 
1023 1 0 0 CC+Sprout 
1027 1 0 0 PartialCut1 
1028 1 0 0 PartialCut2 
1029 1 0 0 OSR1 
1031 1 0 0 CC-Noprep2 
1035 1 0 0 PartialCut3 
1036 1 0 0 PartialCut4 
1037 1 0 0 PartialCut5 
1040 1 5 0 SW+Burn 
1041 1 0 0 SWRsrv 
1042 1 0 0 SWRsrv2 
1043 1 0 0 SWRsrv3 
1045 1 0 0 GrpSelCut2 
1048 1 0 0 SWDeadRsrv 
1050 1 0 0 SWDeadRsrv2 
1052 1 0 0 CCRsrv 
1053 1 0 0 CCRsrv2 
1055 1 0 0 CCDeadRsrv 
1101 1 0 0 CommerThin 
1102 4 0 0 PrecomThin 
1103 4 0 0 ThinLow 
1104 4 0 0 ThinHigh 
1105 4 0 0 Thin2 
1106 4 0 0 Thin3 
1108 4 0 0 ThinLow2 

1201 6 0 0 BarerootPltng 
1301 7 0 0 UnspecGrazing 
1302 7 0 0 LCSCG 
1303 3 0 0 LCSMG 
1304 3 0 0 LCSAG 
1305 13 0 0 LCSNG 
1306 7 0 0 BSCG 
1307 3 0 0 BSMG 
1308 3 0 0 BSAG 
1309 13 0 0 BSNG 
1310 7 2 0 LCSCG+Exotics 
1311 3 2 0 BSCG+Exotics 
1313 6 6 0 Herbicide+Seed 
1314 6 6 0 MechPrep+Seed 
1315 3 0 0 WinterGraze 
1317 12 0 0 Erosion 
1318 11 0 0 Agriculture 
1319 7 0 0 UnspecGrazing2 
1320 7 0 0 LCSCGsheep 
1331 6 0 0 Seed 
1332 6 0 0 VegManipulation 
1333 6 6 0 VegManip+Seed 
1334 6 0 0 VegPlanting 
1335 6 6 0 Herbicide+SeedExotic 
1501 11 0 0 Till+SeedAnn+Spray 
1502 11 0 0 TillSeed 
1503 11 0 0 Irrigation 
1504 11 0 0 Development 
1505 11 0 0 Till+SdNtv+Spray 
1506 11 0 0 Till+SdPer+Spray 
2001 9 0 0 DFB1 
2002 9 0 0 MPB 
2003 9 0 0 WPB 
2004 9 0 0 MPB/WPB 
2005 9 8 0 WPP+SRF1 
2006 9 0 0 BB 
2007 9 0 0 SpruceBeetles 
2008 9 0 0 BWA 
2009 9 0 0 SBW 

2010 9 0 0 TussockMoth 
2013 9 10 0 WPB+RD 
2014 9 0 0 Defoliators 
2016 9 9 0 DFB+Def 
2017 9 0 0 MPB1 
2018 9 0 0 MPB2 
2020 9 0 0 InsectsGen 
2021 9 0 0 BB2 
2022 9 10 0 LessI+D 
2023 9 0 0 DFB2 
2024 9 0 0 MPB3 
2025 9 0 0 MPB4 
2026 9 0 0 PoplarBorer 
2032 9 0 0 BBlow 
2033 9 0 0 BBhigh 
2035 9 0 0 WPB2 
2038 9 0 0 BB3 
2044 9 0 0 BB5 
2101 10 0 0 BR1 
2102 10 0 0 DwarfMistletoe 
2103 10 0 0 RootDisease 
2104 10 0 0 Canker 

3007 8 0 0 WMFS3 
3008 8 0 0 WMSF4 
3009 8 0 0 WUB 
3011 5 0 0 PPSRF 
3012 5 0 0 PPSRF2 
3013 5 0 0 PPSRF3 
3014 5 0 0 PPMSF 
3015 5 0 0 PPMSF1 
3016 5 0 0 PPMSF2 
3017 5 0 0 PPMSF3 
3018 5 0 0 PPMSF4 
3019 5 0 0 PPUB1 
3020 5 0 0 PPUB2 
3021 5 0 0 PUSRF 
3022 5 0 0 PUSRF2 
3023 5 0 0 PUSRF3 
3024 5 0 0 PUMSF 
3025 5 0 0 PUMSF1 
3026 5 0 0 PUMSF2 
3027 5 0 0 PUMSF3 
3028 5 0 0 PUMSF4 
3029 5 0 0 PUUB 
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2106 10 0 0 StemDecay 
2111 10 0 0 BR2 
2112 10 0 0 RD2 
2113 10 0 0 BR3 
2114 9 0 0 LeafDisease 
2115 10 0 0 Canker2 
2116 10 0 0 RootPathogens 
2118 10 0 0 RD3 
2119 10 9 0 RD+BB 
2120 10 0 0 RD7 
2121 10 0 0 RD8 
2122 10 0 0 RD9 
2123 10 0 0 RD10 
2124 10 0 0 BR4 
2125 10 0 0 BR5 
2126 10 0 0 BR6 
2127 10 0 0 RD3 
2128 10 0 0 RD4 
2129 10 0 0 RD5 
2130 10 0 0 RD6 
2133 10 0 0 AspenDiseases 
2201 12 0 0 Seed1 
2202 12 0 0 Seed2 
2203 12 0 0 Seed3 
2204 12 0 0 Seed4 
2205 12 0 0 Seed5 
2206 12 0 0 Seed6 
3001 8 0 0 WSRF 
3002 8 0 0 WSRF2 
3003 8 0 0 WSRF3 
3004 8 0 0 WMSF 
3005 8 0 0 WMSF1 
3006 8 0 0 WMSF2 

3030 13 0 0 WFC 
3032 5 0 0 PPMSF5 
3033 5 0 0 PUMSF5 
3034 8 0 0 WNonLethal 
3035 5 0 0 PPNonLethal 
3036 5 0 0 PUNonLethal 
3102 12 0 0 DroughtDamage 
3106 12 0 0 Snow/breakage 
3207 12 0 0 Rodents 
3208 12 0 0 Beaver 
3306 6 0 0 SeedCrstdWhtgrs 
3401 7 2 0 LCSCG+ExoticGrass 
3402 7 2 0 LCSCG+ExoticForb 
3403 2 0 0 BSCG+ExoticGrass 
3404 2 0 0 BSCG+ExoticForb 
3406 1 12 0 PartialCut+Wind 
3416 7 2 0 LCSCG+Exotics 
3417 7 2 0 BSCG+Exotics 
3418 9 10 0 RR1 
3419 9 10 0 RR2 
3420 9 10 0 RR3 
3421 9 10 0 RR4 
3422 9 10 0 RR5 
3423 9 10 0 RR6 
3424 9 10 0 RR7 
3425 10 0 0 DwarfMistletoe2 
3426 9 10 0 RR8 
3428 1 7 0 CC+LCSCG 
3429 1 7 0 CC+BSCG 
3430 5 4 0 PPUB+Thin 
3440 10 8 0 RD+WUB 
3441 10 5 0 RD+PPUB 
3442 10 5 0 RD+PUUB 

3446 8 2 0 WSRF+ExoticGrass 
3447 5 2 0 PPSRF+ExoticGrass 
3448 5 2 0 PUSRF+ExoticGrass 
3465 8 7 0 WSRF+LCSCG 
3466 5 7 0 PPSRF+LCSCG 
3467 5 7 0 PUSRF+LCSCG 
3468 8 7 0 WSRF+BSCG 
3469 5 7 0 PPSRF+BSCG 

3470 5 7 0 PUSRF+BSCG 
3483 8 9 0 MSF+BB 
3484 9 10 0 RR+DBF 
3485 9 0 0 MPB 
3490 12 0 0 Flood+Succession 
3491 12 0 0 WtrTblDrp+Drought 
3492 12 0 0 WaterTableDrop 
3493 10 9 12 Decay+BB+Erosion 

A more detailed disturbance description of the disturbance types is given 
below. This listing is not in any of the included text files, and is given here 
for reference purposes only. 

1001 Clearcut - No prep 
1003 Group selection cut 
1005 Individual selection cut 
1006 Overstory removal 
1009 Sanitation cut 
1012 Shelterwood cut 
1014 Clearcut + plant(Ponderosa pine) 
1015 Clearcut + plant(Douglas-fir) 
1016 Clearcut + plant(Western larch) 
1017 Clearcut + plant 
1018 Clearcut + plant(White pine) 
1020 Partial cut#6 
1021 Partial cut 
1022 Clearcut + broadcast burn 
1023 Clearcut and sprout 

1303 Successional maintenance cattle grazing 
1304 Successional accelerating cattle grazing 
1305 Not grazed by cattle 
1306 Successional change biggame grazing 
1307 Successional maintenance biggame grazing 
1308 Successional accelerating biggame grazing 
1309 Not grazed by biggame 
1310 Success. change cattle grazing + exotics 
1311 Success. accel. biggame grazing + exotics 
1313 Herb. application + seeding native plants 
1314 Mechanical prep + seeding 
1315 Winter grazing 
1317 Erosion 
1318 Unspecified agriculture 
1319 Grazing 
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1027 Partial cut 
1028 Partial cut #2 
1029 Overstory Removal #1 
1031 Clearcut - No prep #2 
1035 Partial cut #3 
1036 Partial cut #4 
1037 Partial cut #5 
1040 Shelterwood cut + burn 
1041 Shelterwood w/Reserves 
1042 Shelterwood w/Reserves #2 
1043 Shelterwood w/Reserves #3 
1045 Group Selection Cut #2 
1048 Shelterwood w/Dead Reserves 
1050 Shelterwood w/Dead Reserves #2 
1052 Clearcut w/Reserves 
1053 Clearcut w/Reserves #2 
1055 Clearcut w/Dead Reserves 
1101 Commercial thin 
1102 Precommercial thin 
1103 Thin from below 
1104 Thin from above 
1105 Thin #2 
1106 Thin #3 
1108 Thin Low #2 
1201 Bare root planting 
1301 Grazing general 
1302 Successional change cattle grazing 

1320 Successional change sheep grazing 
1331 Unspecified seeding 
1332 Vegetation manipulation 
1333 Vegetation manipulation + unspecified seeding 
1334 Vegetation Planting ie willows 
1335 Herbicide applic. + exotic seed source 
1501 Till + seed annuals + spray 
1502 Till + seed 
1503 Irrigation 
1504 Unspecified development 
1505 Till + seed native + spray 
1506 Till + seed perennial + spray 
2001 Douglas-fir beetle 
2002 Mountain pine beetle 
2003 Western pine beetle 
2004 Mtn pine beetle + western pine beetle 
2005 Western pine beetle + stand replacing fire #1 
2006 Bark beetles 
2007 Spruce beetles 
2008 Balsam wooly adelgid 
2009 Spruce budworm 
2010 Tussock moth 
2013 Western pine beetle + root disease 
2014 Unspecified defoliators 
2016 Douglas-fir beetles + defoliators 
2017 Mtn pine beetle #1 
2018 Mtn pine beetle #2 

2020 Unspecified insects 
2021 Bark beetles #2 
2022 Less insects + disease than naturally would occur 
2023 Douglas-fir beetle #2 
2024 Mtn pine beetle #3 
2025 Mtn pine beetle #4 
2026 Poplar borer 
2032 Low intensity bark beetles 
2033 High intensity bark beetles 
2035 Western pine beetle 
2038 Bark beetles #3 
2044 Bark beetles #5 
2101 Blister rust #1 
2102 Dwarf mistletoe 
2103 Root disease 
2104 Canker 
2106 Stem decay 
2111 Blister rust #2 
2112 Root disease #2 
2113 Blister rust #3 
2114 Leaf disease 
2115 Canker #2 
2116 Root pathogens 
2118 Root disease #3 
2119 Root disease + bark beetles 
2120 Root disease taking the stand to Douglas-fir 
2121 Severe root disease 
2122 Root disease taking the stand to Grand fir 
2123 Low intensity root disease 
2124 Blister rust #4 
2125 Blister rust #5 
2126 Blister rust #6 
2127 Root disease #3 
2128 Root disease #4 

3024 Prescr.-unplanned mixed severity fire 
3025 Prescr.-unplanned mixed severity fire #1 
3026 Prescr.-unplanned mixed sever. fire #2 
3027 Prescr.-unplanned mixed sever. fire #3 
3028 Prescr.-unplanned mixed sever. fire #4 
3029 Prescr.-unplanned underburn 
3030 Wildfire control 
3032 Prescr.-planned mixed sever. fire #5 
3033 Prescr.-unplanned mixed sever. fire #5 
3034 Non-lethal wildfire 
3035 Prescr. planned non-lethal fire 
3036 Prescr.-unplanned non-lethal fire 
3102 Drought damage 
3106 Snow breakage 
3207 Rodents 
3208 Beaver 
3306 Seed Crested Wheatgrass 
3401 Succ. change cattle grazing + exotic grass 
3402 Succ. change cattle grazing + exotic forbs 
3403 Exotic grass 
3404 Exotic forbs 
3406 Partial cut + wind 
3416 Succ. change cattle grazing + exotics 
3417 Succ. change biggame grazing + exotics 
3418 Insects + disease combination #1 
3419 Insects + disease combination #2 
3420 Insects + disease combination #3 
3421 Insects + disease combination #4 
3422 Insects + disease combination #5 
3423 Insects + disease combination #6 
3424 Insects + disease combination #7 
3425 Dwarf mistletoe 
3426 Insects + disease combination #8 
3428 Clearcut + Successional change cattle grazing 
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2129 Root disease #5 
2130 Root disease #6 
2133 Aspen diseases 
2201 Natural seeding #1 
2202 Natural seeding #2 
2203 Natural seeding #3 
2204 Natural seeding #4 
2205 Natural seeding #5 
2206 Natural seeding #6 
3001 Wild stand replacing fire 
3002 Wild stand replacing fire #2 
3003 Wild stand replacing fire #3 
3004 Wild mixed severity fire 
3005 Wild mixed sever. fire #1 
3006 Wild mixed sever. fire #2 
3007 Wild mixed sever. fire #3 
3008 Wild mixed sever. fire #4 
3009 Wild underburn 
3011 Prescribed-planned stand replacing fire 
3012 Prescr.-planned stand replacing fire #2 
3013 Prescr.-planned stand replacing fire #3 

3429 Clearcut + Successional change biggame grazing 
3430 Underburn + thin 
3440 Root disease + wild underburn 
3441 Root disease + prescr.-planned underburn 
3442 Root disease + prescr.-unplanned underburn 
3446 Wild stand replacing fire + exotic grass 
3447 Prescr.-planned stand replac. fire + exot grass 
3448 Prescr.unplanned stand replac fire + exot grass 
3465 Wild srf + succ. change cattle grazing 
3466 Prescr. planned srf + succ. change cattle graz 
3467 Prescr. unplanned srf + succ. change cattle graz 
3468 Wild srf + succ. change biggame grazing 
3469 Prescr. planned srf + succ. change biggame graz 
3470 Prescr. unplanned srf + succ. change biggame graz 
3483 Mixed sever. fire + bark beetles 
3484 Insect + disease combo + Douglas-fir beetle 
3014 Prescr.-planned mixed sever. fire 
3015 Prescr.-planned mixed sever. fire #1 
3016 Prescr.-planned mixed sever. fire #2 
3017 Prescr.-planned mixed sever. fire #3 
3018 Prescr.-planned mixed sever. fire #4 

3019 Prescr.-planned underburn 
3020 Prescr.-planned underburn#2 
3021 Prescr.-unplanned stand replacing fire 
3022 Prescr.-unplanned stand replacing fire 
3023 Prescr.-unplanned stand replacing fire 

3485 Mtn pine beetle 
3490 Flood and succession 
3491 Water Table Drop + Drought 
3492 Water Table Drop 
3493 Decay + Bark beetles + erosion 

DISTURBANCE GROUP FILE: DISTGRP.TXT 
This file lists the groups of disturbances. These groups are used for: 

1. displaying the pathways on the transition pathway diagrams; 

2. graphing results; 

3. changing probabilities using multipliers; 

4. generating between-year variability multipliers or landscape feedback 
multipliers; 

5. selecting the type of disturbance for a new or modified pathway; and 

6. disabling disturbances for a simulation. 

There can be up to 15 different groupings. 

The file must contain two columns: a number from 1 to 15 in the first column 
and the name of the group (with no spaces) in the second column. 

The example file below is the one distributed with VDDT and, like the other 
TXT files, may be edited. 
1 CommTimberHarvest 
2 Exotics 
3 NonImpactGrazing 
4 Pre-commThinning 
5 PrescribedFire 
6 Seed/Plant/ExoticsControl 
7 SuccChangeGrazing 
8 Wildfire 
9 Insects 
10 Pathogens 
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11 Agriculture 
12 Weather/Wildlife 
13 Other 
14 Other2 
15 Other3 

 

The colors used when drawing the pathways are linked to the group number. 
The current associations are: 

 

DISTURBANCE PROBABILITY MULTIPLIER FILE (*.MLT) 
The first line in the MLT file is an indicator that the area limit information 
starts. The second line gives the time interval limits including the start and 
end years. The next lines give the information for the area limits by 
disturbance group (dist group, min and max area for each time interval – in 
this example, lines starting with 1 through 20). The line with -9999 indicates 
the end of area limits information. The rest of the lines contain the multiplier 
information by disturbance type and region. 

 
-999     
1 10 30 50 100 150 
1 1 1 1 1 1 1 1 1 0 0 
2 1 1 1 1 1 1 1 1 0 0 
3 1 1 1 1 1 1 1 1 0 0 
4 1 1 1 1 1 1 1 1 0 0 
5 1 1 1 1 1 1 1 1 0 0 
6 1 1 1 1 1 1 1 1 0 0 
7 1 1 1 1 1 1 1 1 0 0 
9 1 1 1 1 1 1 1 1 0 0 
10 1 1 1 1 1 1 1 1 0 0 
11 1466 1466 226 226 828 828 1 1 0 0 
12 697 697 374 374 164 164 24 24 0 0 
13 1 1 80 80 1 1 1 1 0 0 
14 267 267 936 936 1 1 1 1 53 53 
15 255 255 34 34 1 1 1 1 3 3 
16 1 1 159 159 1 1 1 1 0 0 
17 2777 2777 805 805 1110 1110 379 379 348 348 
19 134 134 472 472 57 57 1 1 20 20 
20 1 1 1421 1421 1 1 600 600 0 0 
-9999     
1002 1 1 1 1 1 1 0 0 
1003 1 1 1 1 1 1 0 0 
1004 1 1 1 1 1 1 0 0 
1005 1 1 1 1 1 1 0 0 
1006 1 1 1 1 1 1 0 0 
1007 1 1 1 1 1 1 0 0 
1010 1 1 1 1 1 1 0 0 
1011 1 1 1 1 1 1 0 0 
1101 1 1 1 1 1 1 0 0 
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1102 1 1 1 1 1 1 0 0 

… 

INITIAL CONDITIONS FILE (*.IC) 
The initial conditions file has the format (items in [ ] are optional): 

structural stage, cover type, proportion of pixels with that combination, 
[minimum age, maximum age, [TSD]] 
[-999, area] 
[-9999, max TSD value] 

By default, the VDDT model initially spreads the pixels out among the ages 
associated with each class. The optional minimum and maximum age fields 
can be used to further define the actual ages associated with each class. The 
optional TSD field can be used to tell the model how long since the area has 
been disturbed by a particular disturbance. The last line of the file can 
optionally include the number -999 and then the area represented by this file. 

For example (no ages or TSD, but with area): 

 
 26 1015  12 
 1 2009  36 
 3 2009  20 
 4 2009  17 
 5 2009  8 
 6 2009  7 
-999 3672 

or (with ages but not TSD or area): 

 
 26 1015  6 1 6 
 26 1015  6 11 20 
 1 2009  36 21 50 
 3 2009  10 100 110 
 3 2009  5 120 130 
 3 2009  5 131 170 
 4 2009  17 200 299 
 5 2009  8 300 450 
 6 2009  2 500 510 
 6 2009  5 550 560 

or (with ages, TSD, and area): 
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26 1015  2 1 6 10 
 26 1015  4 1 6 21 
 26 1015  6 11 20 0 
 1 2009  36 21 50 25 
 3 2009  10 100 110 0 
 3 2009  5 120 130 20 
 3 2009  5 131 170 50 

4 2009  9 200 250 125 
 4 2009  8 251 299 175 
 5 2009  8 300 450 200 
 6 2009  2 500 510 330 
 6 2009  5 550 560 41 
-999 3672 
-9999 25000 

LANDSCAPE FEEDBACK FILE: *.LCM 
The landscape feedback file (*.LCM) contains all the information necessary 
to generate a feedback curve that relates the maximum possible proportion of 
the area disturbed by the disturbance type (in a "normal" year) to a multiplier 
that may increase or decrease the probabilities based on the current 
proportion of the landscape at risk. The file lists the disturbance ID and then 
six values. The six values represent the multipliers to be applied if the 
proportion of the landscape at risk is at 0%, 20%, 40%, 60%, 80%, or 100% 
of the maximum possible proportion. Values with a "-1" indicate that no 
value has been defined for that proportion. 
 1001 1 -1 -1 -1 -1 1 
 1021 1 -1 -1 -1 -1 1 
 1022 0.25 3 -1 -1 -1 -1 
 1201 0.25 -1 -1 -1 3 -1 
 2002 3 -1 -1 -1 -1 0 
 2101 1 -1 -1 -1 -1 1 
 2201 0.25 3 -1 -1 -1 -1 
 2202 0.25 3 -1 -1 -1 -1 
 3001 0.25 -1 -1 -1 3 -1 
 3004 0.25 -1 -1 -1 3 -1 
 3009 0.25 -1 -1 -1 3 -1 
 3011 0.25 3 -1 -1 -1 -1 
 3014 0.25 3 -1 -1 -1 -1 
 3019 0.25 3 -1 -1 -1 -1 
 3021 0.25 3 -1 -1 -1 -1 
 3024 0.25 3 -1 -1 -1 -1 
 3029 0.25 3 -1 -1 -1 -1 
 3030 3 -1 -1 -1 -1 0 

Note that LCM files from version 3.0 have 7 columns rather than 6. VDDT 
will import these files, but give a warning that they are from the older 
version. Thus, the multipliers will be offset from their original location. 

LANDSCAPE CONDITIONS FEEDBACK FILE: *.LCF 
The Landscape Conditions Feedback file (*.LCF) contains information on 
the landscape condition feedback groups used to link disturbance 
probabilities to numerical attributes. A simple example is shown below. The 
first line indicates the number of groups, in this case 2. Each group is then 
listed with one line of information followed by the disturbance codes of the 
disturbances associated with the LCF group: 

"name of the group", "numerical attribute", "prop area affected", "percent 1 
– 4", "number of disturbances" 
2 
"Risk of Fire","FireRisk",1,15,30,45,60,2 
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 3001 
 3011 
"Risk of Insects","BugRisk",1,15,30,45,60,1 
 2011 

LOCATION FILE 
The location file (*.LOC) stores the location of all the classes in a PVT. 
Once it is created for a PVT, it is required for all future use of the PVT file 
(unless it is not loaded with the PVT). If the file is deleted, the PVT file will 
load, but the locations will be set by VDDT. 

The columns are: PVT number, the location of the class, the cover type, and 
the structural stage. Class location is defined by imagining that there are 8 
boxes on each row, with the first box labeled 0, and then numbering from left 
to right along each row. Thus the boxes in the first four rows of the first 
column will have the location codes 0, 8, 16, 24. 

Example: 
 999   0    1015   26 
 999   1    2009   1 
 999   3    2009   3 
 999   4    2009   4 
 999   6    2009   6 
 999   13   2009   5 

MCM FILE 
A Monte Carol multiplier (*.MCM) file can contain up to 300 sets of 
randomized YSG multipliers.  

The first line of the MCM file contains the number of years and the Monte 
Carlo ID number: 
‘# of Years’ ‘MC ID’ 

The second line contains the YSG group ID number, the YSG name, and the 
number of disturbances in the YSG group: 
'YSG Group ID' 'YSG Name' '# of Disturbances in YSG Group' 

Line 3 contains disturbance IDs for each disturbance indicated in line 2: 
0 'DistID 1' 'DistID 2' ... 

Line 4, repeated for the number of years indicated in line 1, lists the 
multipliers for each disturbance: 
1, Mult, Mult, Mult, ... 
2, Mult, Mult, Mult... 

Repeat Lines 2 to 4 for each YSG in the model. 

Line 5: 
-999 

Repeat lines 1 to 5 for each Monte Carlo. 

In the following example MCM file: the number of years = 10; there are two 
YSGs (Drought and RainFire); the YSG called "Drought" contains 1 
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disturbance and the YSG called "RainFire" contains 7 disturbances; and there 
are two Monte Carlos. 

 
10  1  
 1 "Drought"  1  
 0      3103  
 1      0  
 2      0  
 3      0  
 4      0  
 5      0  
 6      0  
 7      0  
 8      0  
 9      0  
 10     0  
 2 "RainFire"  7  
 0      1319    1301    1302    3004    3001    1315    3105  
 1      0.5     0.5     0.5     1       3       1       1  
 2      0.5     0.5     0.5     1       3       1       1  
 3      1       1       1       2       2       0.5     0.5  
 4      0.3     0.3     0.3     0       10      1       1  
 5      1       1       1       2       2       0.5     0.5  
 6      0.3     0.3     0.3     0       10      1       1  
 7      1       1       1       2       2       0.5     0.5  
 8      1       1       1       2       2       0.5     0.5  
 9      1       1       1       2       2       0.5     0.5  
 10     2.5     2.5     2.5     3       1       0       0  
 -999 
 10  2  
 1 "Drought"  1  
 0      3103  
 1      0  
 2      0  
 3      0  
 4      0  
 5      0  
 6      0  
 7      0  
 8      0  
 9      0  
 10     0  
 2 "RainFire"  7  
 0      1319    1301    1302    3004    3001    1315    3105  
 1      2.5     2.5     2.5     3       1       0       0  
 2      1       1       1       2       2       0.5     0.5  
 3      1       1       1       2       2       0.5     0.5  
 4      1       1       1       2       2       0.5     0.5  
 5      1       1       1       2       2       0.5     0.5  
 6      1       1       1       2       2       0.5     0.5  
 7      1       1       1       2       2       0.5     0.5  
 8      0.5     0.5     0.5     1       3       1       1  
 9      1       1       1       2       2       0.5     0.5  
 10     1       1       1       2       2       0.5     0.5  
 -999 

PROBABILITY FILE 
The first line is a header line which gives the name of the scenario file 
containing the probabilities that are printed in this file. The second line gives 
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the number and name of the PVT that is printed. The remainder of the 
information is divided into three types of lines. The first gives information 
identifying the class (class letter, structural stage number and name, and 
cover type number and name). The second line type contains the letter of the 
class that the pixel would go to through succession, and the number of years 
that it would take before succession occurred. The third line type lists all the 
information about a disturbance: the letter of the destination class, 
disturbance ID, disturbance name, the probability associated with the 
disturbance in each of the three management regions, and the ages for which 
this probability is applicable. 

 
SCN: Sample.scn 
 999 SamplePVT 
 A 26 ClosedMidShrub 1015 GeneralShrub 
  Succession: B  5 
 B 1 StandInitiationForest 2009 LodgepolePine 
  Succession: C  45 
  A 3001 WSRF    0.006 6 51  0.006 6 51  0.006 6 51  0 
 C 3 StemExclusionClosedCanopyForest 2009 LodgepolePine 
  Succession: D  40 
  A 1001 CC-Noprep  0 0 0   0.0015 51 91 0.0015 51 91 0 
  A 3001 WSRF    0.002 51 91  0.002 51 91  0.002 51 91  0 
  A 3021 PUSRF   0.001 51 91  0 0 0   0 0 0   0 
  C 1103 ThinLow   0 0 0   0.0125 51 91 0.0125 51 91 20 
  C 3106 Snow/breakage 0.0002 51 91 0.0002 51 91 0.0002 51 91 10 
  D 1101 CommerThin  0 0 0   0.0023 51 91 0.0023 51 91 0 
 D 4 UnderstoryReinitationForest 2009 LodgepolePine 
  Succession: F  40 
  A 1001 CC-Noprep  0 0 0   0.023 91 131 0.023 91 131 0 
  A 3001 WSRF    0.004 91 131 0.004 91 131 0.004 91 131 0 
  A 3021 PUSRF   0.0015 91 131 0 0 0   0 0 0   0 
  A 3483 MSF+BB   0.0015 91 131 0.0015 91 131 0.0015 91 131 0 
  D 3009 WUB    0.0001 91 131 0.0001 91 131 0.0001 91 131 0 
  E 1021 PartialCut  0 0 0   0.002 91 131 0.002 91 131 0 
  E 2002 MPB    0.01 91 131  0.01 91 131  0.01 91 131  0 
 E 5 YoungMulti-strataForest 2009 LodgepolePine 
  Succession: F  80 
  A 3001 WSRF    0.0025 131 211 0.004 131 211 0.004 131 211 0 
  A 3021 PUSRF   0.0025 131 211 0 0 0   0 0 0   0 
  E 1021 PartialCut  0 0 0   0.0012 131 211 0.0012 131 211 0 
  E 2002 MPB    0.001 131 211 0.001 131 211 0.001 131 211 0 
  E 3440 RD+WUB   0.0001 131 211 0.0001 131 211 0.0001 131 211 0 
  E 3441 RD+PPUB   0 0 0   0.0001 131 211 0.0001 131 211 0 
  E 3442 RD+PUUB   0 0 0   0.0001 131 211 0.0001 131 211 0 
 F 6 OldMulti-strataForest 2009 LodgepolePine 
  Succession: F  999 
  A 1001 CC-Noprep  0 0 0   0.05 131 1130 0.05 131 1130 0 
  A 3001 WSRF    0.007 131 1130 0.007 131 1130 0.007 131 1130 0 
  E 1021 PartialCut  0 0 0   0.005 131 1130 0.005 131 1130 0 
  E 2002 MPB    0.01 131 1130 0.01 131 1130 0.01 131 1130 0 

PROJECT FILE 
In VDDT version 4, the project file stores the full filename of all files that 
are in use in VDDT at the time that the project file is saved. It is useful for 
grouping definition files with a PVT, and for loading all files at once without 
going through multiple windows and menu items. 
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The file format is generally: code word identifying the type of information, 
filename or value. The code word must be present, but the area after the ":" 
can be blank if the relevant file does not exist or should not be loaded 
automatically. 

Dists: disturbance type filename (distcode.*) 
DistGroups: disturbance group filename (distgrp.*) 
LongCover: cover type names filename (cover.*) 
ShortCover: cover type abbreviation filename (coverc.*) 
Structure: structural stage filename (structur.*) 
PVT: PVT filename (*.PVT) 
SCN: scenario filename (*.SCN) 
LOC: location filename (*.LOC) 
Atts: attribute filename (*.ATT) 
Des: model description filename  (*.DES) 
ICs: initial conditions filename (*.IC) 
YSGdef: year-sequence group filename (*.YSG) 
YTMult: year type multiplier filename (*.YTM) 
MSE: multiplier sequence filename (*.MSE) 
NSE: normalized multiplier sequence filename (*.NSE) 
LandMult: landscape feedback multiplier filename 
MCMults: filename containing the normalized annual multipliers for multiple Monte 

Carlo simulations 
Trend: filename containing trend multipliers (*.TRD) 
LCFdef: filename containing landscape condition feedback file definitions (*.LCF) 
LCF: filename containing landscape feedback multipliers (*.LFM) 
Mults: filename containing multiplier definitions for disturbances or groups 

(*.MLT) 
PFormat: file that is saved when exiting the Print to File screen with OK. 
PFormatOut: saves the name of all output files defined after making the run and 

selecting the Results|Print menu. 
AllTransFileName: holds the filenames selected from the menu Run Model|Print (during 

simulation). There can be up to three files separated by commas. 
TransFileName:  TRN filename 
ClassesFileName:  OUT files containing class information 
DistFileName:  OUT files containing disturbance information 
AvgDistProbFileName: OUT files containing the average disturbance probability information 
GOptions: a T or F indicate which graph options are selected followed by a number 

indicating the number of standard deviations or the central tendency %  
GMInt: mean line time intervals 
DisableDist: a T or F indicate which disturbance groups are disabled 
DoVariation: boolean for whether the variation multipliers are on 
DoLandscape: boolean for whether the landscape feedback multipliers are on 
DoLCF: a T or F indicates if landscape condition feedback multipliers are on 
DoTremd: a T or F indicates if trend multipliers are on 
UseMult: a T or F indicates if disturbance multipliers are on 
TSD: number of the disturbance group used for time-since-disturbance 

calculations (-1 = none) 
Region: current management region 
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Times: number of years to simulate, graph start time, graph end time, four times 
for each of the bar graphs 

Options: multiplier options: years generated; what generated; generation criteria; 
and normalization criteria  

MC: number of Monte Carlo iterations to do 
MCSeq: option to use for sequencing the between year multipliers during multiple 

Monte Carlo iterations 
Size: number of pixels, area 
Batch: the information for running a sequence of regions: number of values, 

region number, number of years 

Example: 
Dists: C:\VDDT\distcode.dem 
DistGroups: C:\VDDT\distgrp.dem 
LongCover: C:\VDDT\cover.dem 
ShortCover: C:\VDDT\coverc.dem 
Structure: C:\VDDT\structur.dem 
PVT: C:\VDDT\sample.PVT 
SCN: C:\VDDT\sample.SCN 
LOC: C:\VDDT\sample.LOC 
Atts: C:\VDDT\sample.ATT 
Des: C:\VDDT\sample.des 
ICs: C:\VDDT\sample.ic 
YSGdef: C:\VDDT\sample.YSG 
YTMult: 
MSE: 
NSE: 
LandMult: 
MCMults: 
Trend: 
LCFdef: 
LCF: 
Mults: 
PFormat: C:\VDDT\sample.FMT 
PFormatOut: C:\VDDT\sample.out 
AllTransFileName: 
TransFileName: C:\VDDT\sample.trn 
ClassesFileName: C:\VDDT\Classes.out 
DistFileName: C:\VDDT\Disturbances.out 
AvgDistProbFileName: C:\VDDT\Avg prob.out 
GOptions: TFFTFTFFF, 2 
GMInt: 10, 25, 50, 75 
DisableDist: FFFFFFFFFFFFFFF 
DoVariation: True 
DoLandscape: False 
DoLCF: False 
DoTremd: False 
UseMult: True 
TSD: -1 
Region: 1 
Times: 100, 0, 100, 0, 10, 50, 100 
Options: 100, 0, 1, 0 
MC: 3 
MCSeq: 0 
Size: 100, 100 
Batch: 1 , 1, 100 



VDDT 6.0 User Guide 

152 

PVT FILE (OLD FORMAT) 
The first line of this file is a line that can be used as a file header or identifier. 
Any information on this line is not used in the model but will be remembered 
and written to the file when saved. The second line shows the number of the 
PVT (999), its name (Sample), and the number of classes in the PVT (6). 
After that, the file has two types of lines. The first type is those that give the 
information about the class (its number, cover type, structural stage, 
beginning and ending age, the cover type and structural stage it goes to after 
succession, and the number of disturbances which originate in that class). 
The second line type lists the information about the possible disturbances 
from that class (disturbance ID, disturbance name, destination structural 
stage, destination age, destination cover type, relative age at the destination, 
and (optional) whether the relative age is maintained when the disturbance 
occurs). 

Note: 
Note that the relative age value shown in the dialog box with all the pathway 
definitions is calculated from the destination age and beginning age of the 
destination class when a pathway changes classes, and from the relative age 
value when the pathway remains in the same class. 

Note that the third line of the file must contain at least one letter in order for 
the file to be recognized as an old format PVT file. 
Optional file header/identifier 
999 Sample 6 
  1  26 CloseLowShrub  1015 Shrubfield  1 6 1 2009 0 
  2  1 StandInitiation  2009 Lodgepole  6 51 3 2009 1 
  3001 WSRF  26 1 1015 0 False 
  3  3 StemExclusionClosed 2009 Lodgepole  51 91 4 2009 8 
  3001 WSRF  26 1 1015 0 False 
  3011 PPSRF  26 1 1015 0 False 
  3021 PUSRF  26 1 1015 0 False 
  3030 WFC  4 91 2009 0 True 
  3106 Snow/breakage 3 61 2009 10 False 
  1103 ThinLow  3 71 2009 20 False 
  1101 CommerThin 4 91 2009 0 False 
  1001 CC-Noprep  26 1 1015 0 False 
  4  4 UnderstoryReinitiation 2009 Lodgepole  91 131 6 2009 11 
  1001 CC-Noprep  26 1 1015 0 
  1021 PartialCut 5 131 2009 0 
  3001 WSRF  26 1 1015 0 
  3011 PPSRF  26 1 1015 0 
  3021 PUSRF  26 1 1015 0 
  3009 WUB  4 91 2009 0 
  3019 PPUB  4 91 2009 0 
  3029 PUUB  4 91 2009 0 
  3483 MSF+BB 26 1 1015 0 
  2002 MPB  5 131 2009 0 
  1103 ThinLow 4 121 2009 10 
  5  5 YoungForest   2009 Lodgepole  131 211 6 2009 11 
  1001 CC-Noprep  26 1 1015 0 
  3001 WSRF  26 1 1015 0 
  3011 PPSRF  26 1 1015 0 
  3021 PUSRF  26 1 1015 0 
  3030 WFC  5 131 2009 0 
  1021 PartialCut 5 131 2009 0 
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  1103 ThinLow  5 131 2009 0 
  3440 RD+WUB  5 131 2009 0 
  3441 RD+PPUB  5 131 2009 0 
  3442 RD+PUUB  5 131 2009 0 
  2002 MPB   5 131 2009 0 
  6  6 OldForestMultiStrata 2009 Lodgepole  131 1130 6 2009 4 
  3001 WSRF   26 1 1015 0 
  1001 CC-Noprep  26 1 1015 0 
  1021 PartialCut 5 131 2009 0 
  2002 MPB   5 131 2009 0 

 

PVT FILE (NEW FORMAT) 
The "New Format" is very similar to the "Old Format" but there are a few 
important differences. The primary difference is the lack of text: new format 
files do not name every cover type and structural stage. The second main 
difference is the use of five or six digit numbers to represent the class. These 
numbers are the combined form of the structural stage (the first one or two 
digits) and cover type (the last four digits). This number uniquely identifies 
different classes within a PVT, and will be called the class identifier in the 
following description. 

As in the old format files, the first line of this file can be used as a file header 
or identifier. Any information on this line is not used in the model but will be 
remembered and written to the file when saved. The first line shows the 
number of the PVT (999), its name (SamplePVT), and the number of classes 
in the PVT (6). After that, the file has two types of lines (also like in the old 
format case). The first gives information about the class: the class identifier, 
the structural stage (alone), the cover type, the beginning and ending age, the 
class identifier for where it goes after succession, a new age (not used, so set 
to 0), and the number of disturbances which originate in that class. The 
second line type lists the information about the possible disturbances from 
that class: disturbance ID, disturbance name, destination class identifier, 
destination age and the relative age at the destination, and (optional) whether 
the relative age is maintained when the disturbance occurs. 

Note: 
Note that the relative age value shown in the dialog box with all the pathway 
definitions is calculated from the destination age and beginning age of the 
destination class when a pathway changes classes, and from the relative age 
value when the pathway remains in the same class. 

 
Optional file header/information 
 999 SamplePVT 6 
  261015 26 1015 1 6 12009 0 0 
  12009 1 2009 6 51 32009 0 1 
   3001 WSRF   261015 1 0 False 
  32009 3 2009 51 91 42009 0 8 
   3001 WSRF   261015 1 0 False 
   3011 PPSRF   261015 1 0 False 
   3021 PUSRF   261015 1 0 False 
   3030 WFC   42009 91 0 True 
   3106 Snow/breakage 32009 51 10 False 
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   1103 ThinLow  32009 51 20 False 
   1101 CommerThin 42009 91 0 False 
   1001 CC-Noprep  261015 1 0 False 
  42009 4 2009 91 131 62009 0 11 
   1001 CC-Noprep  261015 1 0 
   1021 PartialCut 52009 131 0 
   3001 WSRF   261015 1 0 
   3011 PPSRF   261015 1 0 
   3021 PUSRF   261015 1 0 
   3009 WUB   42009 91 0 
   3019 PPUB   42009 91 0 
   3029 PUUB   42009 91 0 
   3483 MSF+BB  261015 1 0 
   2002 MPB   52009 131 0 
   1103 ThinLow  42009 91 10 
  52009 5 2009 131 211 62009 0 11 
   1001 CC-Noprep  261015 1 0 
   3001 WSRF   261015 1 0 
   3011 PPSRF   261015 1 0 
   3021 PUSRF   261015 1 0 
   3030 WFC   52009 131 0 
   1021 PartialCut 52009 131 0 
   1103 ThinLow  52009 131 0 
   3440 RD+WUB  52009 131 0 
   3441 RD+PPUB  52009 131 0 
 
3442 RD+PUUB  52009 131 0 
   2002 MPB   52009 131 0 
  62009 6 2009 131 1130 62009 0 4 
   3001 WSRF   261015 1 0 
   1001 CC-Noprep  261015 1 0 
   1021 PartialCut 52009 131 0 
   2002 MPB   52009 131 0 

RESULTS FILES 
VDDT can produce information about runs in the form of reports (*.CSV 
files) that can be saved to file and opened in a spreadsheet program such as 
Microsoft Excel.  The model can produce summary and detailed output files 
for classes and transitions:  

• ClassesSummary.csv 

• ClassesDetailed.csv 

• TransitionsSummary.csv 

• TransitionsDetailed.csv 

The names for these four files never change.   

Summary Reports 
Summary reports provide overview information about classes and transition 
groups that can be graphed to show trends over time.   

The classes summary report contains Area information for each combination 
of structural stage (SSAbbr and SSCode), cover type (CTAbbr and 
CTCode), Monte Carlo simulation (MC) and Timestep.  In the example 
below, which shows only the first 15 records, VDDT generated area 
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information in intervals of 10 timesteps.  For each of the selected timestep 
intervals, one record was generated for each of the 6 structural states in the 
project.  This information can be used to graph area affected in each class 
over time. 

MC Timestep ClassCode CTCode CTAbbr SSCode SSAbbr Area
1 10 112012 2012 PPine 11 EAD 11
1 10 122012 2012 PPine 12 MID 27
1 10 132012 2012 PPine 13 LSD 34
1 10 212012 2012 PPine 21 EAO 5
1 10 222012 2012 PPine 22 MIO 12
1 10 232012 2012 PPine 23 LSO 11
1 20 112012 2012 PPine 11 EAD 13
1 20 122012 2012 PPine 12 MID 24
1 20 132012 2012 PPine 13 LSD 24
1 20 212012 2012 PPine 21 EAO 9
1 20 222012 2012 PPine 22 MIO 15
1 20 232012 2012 PPine 23 LSO 15
1 30 112012 2012 PPine 11 EAD 17
1 30 122012 2012 PPine 12 MID 19
1 30 132012 2012 PPine 13 LSD 19  

 

The transitions summary report contains Area information for each 
combination of transition group (TransGrpName and TransGrpCode), 
Monte Carlo simulation (MC) and Timestep.  In the example below, which 
shows the first 20 records of the report, VDDT generated area information in 
intervals of 5 timesteps for every defined transition group.  This information 
can be used to graph the area affected by each transition group over time. 

MC Timestep TransGrpCode TransGrpName Area
1 5 1 Selective_Log 0
1 5 2 Commercial_Thin 0
1 5 3 Thin 0
1 5 4 Prescribed_Fire 0
1 5 5 Bark_Beetle 0
1 5 6 Severe_Wild_Fire 0
1 5 7 Under_Burn 3
1 5 8 Fuel_Buildup 0
1 5 9 TSD 3
1 5 10 Succession 0
1 10 1 Selective_Log 2
1 10 2 Commercial_Thin 1
1 10 3 Thin 0
1 10 4 Prescribed_Fire 0
1 10 5 Bark_Beetle 0
1 10 6 Severe_Wild_Fire 0
1 10 7 Under_Burn 1
1 10 8 Fuel_Buildup 1
1 10 9 TSD 3
1 10 10 Succession 0  
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Detailed reports  
Detailed reports contain information about individual cells in the simulation, 
which provide a history of the state of each cell over time.  Detailed reports 
can be used to look at the distribution of age and time since disturbance.   

A classes detailed report contains Age and time since disturbance 
information for every cell (Pixel) and transition group (TSD-*) in the 
simulation.  This information is generated for every combination of structural 
stage (SSAbbr and SSCode), cover type (CTAbbr and CTCode), Monte 
Carlo (MC) simulation and Timestep.  In the example below, which shows 
only the first 5 records and the first 3 transition groups, VDDT generated 
information for every cell in intervals of 10 timesteps.  

MC Timestep Pixel ClassCode CTCode CTAbbr SSCode SSAbbr Age TSD-Selective_Log TSD-Commercial_Thin TSD-Thin
1 10 1 112012 2012 PPine 11 EAD 34 11 28 14
1 10 2 122012 2012 PPine 12 MID 40 20 14 22
1 10 3 122012 2012 PPine 12 MID 45 19 12 11
1 10 4 122012 2012 PPine 12 MID 45 20 18 32
1 10 5 212012 2012 PPine 21 EAO 8 23 12 11  

 

A transitions detailed report contains information about the starting and 
ending state of every cell (Pixel) that has a transition during the specified 
time interval.  For each of these cells, information is generated for every 
combination of transition type (TransType and TransTypeName), 
transition group (TSD-*), structural stage, cover type, Monte Carlo (MC) 
simulation and Timestep.  A series of Start* fields shows the state of the 
cell before transition and corresponding End* fields show the state of the 
cell following transition.   

SCENARIO FILE (OLD FORMAT 
The first line is a simple header line. The second line gives a code for the 
phase, the name of the phase, the beginning and ending years of the 
simulation, and the number of management regions which are present in the 
file. After that, the file is divided into the different management regions. The 
first line of each management region gives the region number, the region 
name, and the number of classes in the region. Note that these region names 
are those that will be used inside the program. The remainder of the 
information about the region is divided into two types of lines. The first gives 
information identifying the PVT and class (PVT number and name, structural 
stage, cover type, and the number of disturbances containing probabilities 
which originate in that class). The second line type lists the information 
about the disturbance (disturbance ID, disturbance name, percentage, and 
TSD value). Note that the values given in this file are a percentage, not a 
probability. 
Printed from VDDT 
 1 PhaseOne 0 300 2 
 1 Wilderness+NationalPark 5 
  999 Sample 1 StandInitiation 2009 Lodgepole 1 
  3001 WSRF   .6 0 
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  999 Sample 3 StemExclusionClosed 2009 Lodgepole 3 
  3001 WSRF   .2 0 
  3021 PUSRF   .1 0 
  3106 Snow/breakage .02 0 
  999 Sample 4 UnderstoryReinitiation 2009 Lodgepole 5 
  3001 WSRF   .4 0 
  3021 PUSRF   .15 0 
  3009 WUB    .01 0 
  3483 MSF+BB   .15 0 
  2002 MPB    1 0 
  999 Sample 5 YoungForest 2009 Lodgepole 4 
  3001 WSRF   .25 0 
  3021 PUSRF   .25 0 
  3440 RD+WUB   .01 0 
  2002 MPB    .1 0 
  999 Sample 6 OldForestMultiStrata 2009 Lodgepole 2 
  3001 WSRF   .7 0 
  2002 MPB    1 0 
 2 USFS+Federal    5 0 
  999 Sample 1 StandInitiation 2009 Lodgepole 1 
  3001 WSRF   .6 0 
  999 Sample 3 StemExclusionClosed 2009 Lodgepole 5 
  3001 WSRF   .2 0 
  3106 Snow/breakage .02 0 
  1103 ThinLow   1.25 0 
  1101 CommerThin  .23 0 
  1001 Clearcut-Noprep .15 0 
  999 Sample 4 UnderstoryReinitiation 2009 Lodgepole 6 
  1001 Clearcut-Noprep 2.3 0 
  1021 PartialCut  .2 0 
  3001 WSRF   .4 0 
  3009 WUB    .01 0 
  3483 MSF+BB   .15 0 
  2002 MPB    1 0 
  999 Sample 5 YoungForest 2009 Lodgepole 6 
  3001 WSRF   .4 0 
  1021 PartialCut  .12 0 
  3440 RD+WUB   .01 0 
  3441 RD+PPUB   .01 0 
  3442 RD+PUUB   .01 0 
  2002 MPB    .1 0 
  999 Sample 6 OldForestMultiStrata 2009 Lodgepole 4 
  3001 WSRF   .7 0 
  1001 Clearcut-Noprep 5 0 
  1021 PartialCut  .5 0 
  2002 MPB    1 0 

SCENARIO FILE (NEW FORMAT) 
As with the PVT files, the structure of the new and old format files is very 
similar. The main difference is the use of the class identifier (see PVT New 
Format description) and the lack of cover type and structural stage 
descriptors. The first three lines are in the same format as the old format 
files. The remainder of the information about the region is divided into two 
types of lines. The first gives information identifying the PVT and class 
(PVT number and name, class identifier, and the number of disturbances 
containing probabilities which originate in that class). The second line type 
lists the information about the disturbance (disturbance ID, disturbance 
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name, percentage, and TSD value). Note that the values given in this file are 
a probability, not a percentage as in the old format. 
TS 
 1 PhaseOne 0 300 2 
 1 Wilderness+NationalPark 5 
  999 SamplePVT   12009 1 
  3001 WSRF   .006 0 
  999 SamplePVT   32009 3 
  3001 WSRF   .002 0 
  3021 PUSRF   .001 0 
  3106 Snow/breakage .0002 0 
  999 SamplePVT   42009 5 
  3001 WSRF   .004 0 
  3021 PUSRF   .0015 0 
  3009 WUB    .0001 0 
  3443 UnknownCode  .0015 0 
  2002 MPB    .01 0 
  999 SamplePVT   52009 4 
  3001 WSRF   .0025 0 
  3021 PUSRF   .0025 0 
  3440 RD+WUB   .0001 0 
  2002 MPB    .001 0 
  999 SamplePVT   62009 2 
  3001 WSRF   .007 0 
  2002 MPB    .01 0 
 2 USFS+Federal    5 
  999 SamplePVT   12009 1 
  3001 WSRF   .006 0 
  999 SamplePVT   32009 5 
  3001 WSRF   .002 0 
  3106 Snow/breakage .0002 0 
  1103 ThinLow   .0125 0 
  1101 CommerThin  .0023 0 
  1001 CC-Noprep  .0015 0 
  999 SamplePVT   42009 6 
  1001 CC-Noprep  .023 0 
  1021 PartialCut  .002 0 
  3001 WSRF   .004 0 
  3009 WUB    .0001 0 
  3443 UnknownCode  .0015 0 
  2002 MPB    .01 0 
  999 SamplePVT   52009 6 
  3001 WSRF   .004 0 
  1021 PartialCut  .0012 0 
  3440 RD+WUB   .0001 0 
  3441 RD+PPUB   .0001 0 
  3442 RD+PUUB   .0001 0 
  2002 MPB    .001 0 
  999 SamplePVT   62009 4 
  3001 WSRF   .007 0 
  1001 CC-Noprep  .05 0 
  1021 PartialCut  .005 0 
  2002 MPB    .01 0 

STRUCTURAL STAGE FILE 
Structural stages are referenced throughout the model by number (although 
the transition pathway diagram may also show character abbreviations). A 
label attached to each number is printed to the output file (in the old format) 
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for informational purposes only. The labels and character abbreviations are 
read from the file STRUCTUR.TXT, contained in the base directory where 
VDDT resides. Like the other TXT files, the structural stage file can be 
modified as desired. 

The file has the format: 

column 1 structural stage number (must be a number from 1-50) 

column 2 code to put in the transition pathway diagram (number or 1-3 
characters) 

column 3 name or description of structural stage (used for informational 
purposes only, but must not contain any blanks). 

The following is the structural stage file that comes with VDDT. 
1 SIF StandInitiationForest 
2 SOF StemExclusionOpenCanopyForest 
3 SEF StemExclusionClosedCanopyForest 
4 URF UnderstoryReinitationForest 
5 YMF YoungMulti-strataForest 
6 OMF OldMulti-strataForest 
7 OSF OldSingle-strataForest 
11 SIW StandInitiationWoodland 
12 SEW StemExclusionWoodland 
13 URW UnderstoryReinitiationWoodland 
14 YMW YoungMulti-strataWoodland 
15 OMW OldMulti-strataWoodland 
16 OSW OldSingle-strataWoodland 
21 OHB OpenHerbland 
22 CHB ClosedHerbland 
23 CLS ClosedLowShrub 
24 OLS OpenLowShrub 
25 OMS OpenMidShrub 
26 CMS ClosedMidShrub 
27 OTS OpenTallShrub 
28 CTS ClosedTallShrub 
31 CRP Agricultural 
33 URB Urban 
34 WTR Water 
35 RCK Rock 

TEMPORAL TREND MULTIPLIER FILE  
The temporal trend multiplier file (*.TRD) contains all the information 
necessary to generate a temporal trend curve for a given disturbance. There is 
a line in the file for each trend multiplier defined. The first column contains 
the code for the disturbance type. The remaining columns contain the step 
followed by its associated value — repeated for each step. To illustrate, the 
first line in the example below contains the disturbance code 1004 followed 
by the first time step of 0 and its corresponding value of .0031. 

 
1004 0 .0031 10 .0025 20 .002 30 .0013 40 .0016 50 .0011 60 
.0008 70 .0008 80 .0007 90 .001 100 .002 
 
 1010 0 .0031 10 .0025 20 .002 30 .0013 40 .0016 50 .0011 
60 .0008 70 .0008 80 .0007 90 .001 100 .002 
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 1011 0 .0031 10 .0025 20 .002 30 .0013 40 .0016 50 .0011 
60 .0008 70 .0008 80 .0007 90 .001 100 .002 
 
 1012 0 .0031 10 .0025 20 .002 30 .0013 40 .0016 50 .0011 
60 .0008 70 .0008 80 .0007 90 .001 100 .002 
 
 1013 0 .0031 10 .0025 20 .002 30 .0013 40 .0016 50 .0011 
60 .0008 70 .0008 80 .0007 90 .001 100 .002 
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APPENDIX E:  LEGACY VDDT FILES 

FILE DESCRIPTIONS 
Two general types of files were used by VDDT version 4.4c and earlier: PVT 
files and scenario files. These files can still be imported into version 6 to 
create Projects.  The information about a transition pathway diagram for each 
potential vegetation type (PVT) is defined in the PVT file. This includes all 
valid combinations of cover type and structural stage, and all the possible 
pathways. The scenario file (extension SCN) contains the non-zero 
probabilities for the pathways in each management region. 

Each PVT file must have at least one scenario file (with the disturbance 
probabilities) associated with it. A single PVT file may be referenced by 
several scenario files, each of which defines probabilities under different 
scenario assumptions for one or more different management regions.  

 
 

In order to run the model a scenario file must be loaded. The program will 
prompt the user to load a scenario file once a PVT file has been loaded. 

Most users do not need to know the structure of the PVT and scenario files, 
but this information is sometimes useful. Example files, with a brief 
description, are shown in Appendix D. 
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PVT, SCENARIO, AND LOCATION FILES 

PVT and scenario files 
The PVT and scenario files contain the minimum amount of information 
necessary to run the model for a specific landscape or situation. As such, they 
will always import and export together. 

New scenario files may be loaded at any time by selecting Scenario from the 
File|Import menu. Only one scenario file can be loaded at any time, so the 
new one replaces the previously loaded one as the active file. The program 
assumes that the loaded scenario file is associated with the PVT in memory. 

If there are more than six management regions in the scenario file, the user is 
given the option to load only the first six. When a scenario file is saved, only 
those management regions that were read will be saved. For example, if a 
scenario file contains nine management regions and only the first six are read 
at the time the scenario file is loaded, these six will be the only management 
regions in memory. When the scenario information is saved, these six will 
also be the only regions present in the new file. Six management regions 
are the recommended maximum number of regions. 

As a safeguard against possible operator errors, the program performs a 
series of error checks while scenario files are loading. It displays a warning 
message if the scenario file is trying to access a PVT, class (cover type-
structural stage combination), or disturbance which is not part of the 
currently loaded PVT. If any of these are not present in the PVT file, the 
model will ignore them, and when saved, the new scenario file will not 
contain this information. Warning messages may be an indication that 
incompatible PVT and scenario files are being loaded. See the section about 
Trouble Shooting for additional information. 

After both files are loaded, the program does some checking of the PVT file 
to make sure that all information is valid. Warning messages will appear if 
file contains two classes with the same cover type and structural stage 
definition, or if some pathways (succession or disturbance) go to non-existent 
classes. The model may not run with these problems, so users should note the 
problems and fix them when the pathway diagram is fully loaded. 

Warnings about additional discrepancies, such as having a disturbance code 
or cover type that is not in the current disturbance or cover type file, will also 
be shown. These warnings are often an indication that the files were created 
with a different set of the TXT files than those that are currently in memory. 

Location file 
The location file contains information about the placement of the classes in 
the TPD diagram. This information is optional, as VDDT can organize 
classes using an internal rule-base. 

After the scenario file is read, the model will look to see if there is a location 
file with the same name as the PVT file. If so, the user will be prompted to 
load the location file as well. The information in the location file will 
overwrite the default information produced by VDDT. Once a location file is 
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being used for a VDDT session, all new classes must be placed in the desired 
location. 

Clicking on the Cancel button when VDDT asks for the location file name 
will cause VDDT to ignore the location file, and to use the default locations 
for the classes. 

Note: 
Note that if the location file has a different name than the PVT file, the 
model will not find the file and will not prompt the user to load it. You can 
open a location file with a different name by navigating to the directory 
containing the file, and selecting it. 
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APPENDIX F:  BUILD MCM TOOL 

This program generates complex multiplier streams for Year Sequence 
Groups and melds them into one Monte Carlo multiplier (*.MCM) file. In 
summary, the program: 

• reads an YSG file to determine the disturbance codes that apply to each 
YSG; 

• reads an YTM file to determine the multipliers that apply to each 
disturbance; and 

• generates up to 300 non-normalized sequences for each YSG and 
melds the data for up to five YSGs into one *.MCM file. 

To generate multipliers for multi-year outbreaks, use only the normal, high, 
and severe year types when defining YSGs. One suggested method is to put 
the actual probabilities associated with each year type (e.g. the actual 
probabilities during an outbreak) in the VDDT disturbance tables, then put 
multipliers of 1 or 0 in the YTM file to turn these disturbances on or off. In 
the program: 

Year type Description  

Severe represents "outbreak" years 
High represents "pre and post outbreak" years 
Normal represent non-outbreak years 

The figure below shows the dialog box used when running the program. 

To run the program: 
1. Enter the number of years and the number of sequences to generate. 

2. Load your YSG and YTM files by selecting the option from the File 
menu. 

3. Click on each box in the row labeled Random and select Yes or No. 

4. Complete the variable information for each YSG. The variables that 
apply to each YSG are as follows: 

Variable Description  

Min and Max Outbreak: Min and max number of years in each 
outbreak 

Min and Max Interval: Min and Max years between outbreak 
midpoints 

Last Outbreak: Years since the midpoint of the last outbreak 



Appendices 

165 

Pre/PostYears: Number of high (non-normal) years 
proceeding and following each outbreak 

 

5. Click Generate to calculate the multipliers. 

6. Save the results to a *.MCM file by selecting Save MCM File from the 
File menu. 
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APPENDIX G:  VARIATION MENU 

In earlier versions of VDDT, the Variation menu was used to define year 
sequence groups, and to generate and edit a variety of probability multipliers.   

 
In the current version of VDDT, the most commonly used options from the 
Variation menu have been moved to the Run menu (Run|Settings), and the 
Variation menu has been hidden from view.   

Users who wish to continue using the Variation menu so they can work with 
VDDT’s less commonly used advanced features, such as trend multipliers 
and landscape feedback, can still do so.  The Variation menu is also still 
needed by users who wish to generate their own temporal multipliers using 
the Build MCM Tool (see Appendix F).   

To access VDDT’s Variation menu: 
1. Navigate to and open the Microsoft Access VDDT database that 

contains the Project with which you wish to work (e.g., C:\Program 
Files\VDDT\VDDT.mdb).  

2. Open the database in Microsoft Access 2000 or later. 

3. Open the GlobalSettings table.   
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4. By default, this table contains a single record with the value -1 for the 

field HideVariationMenu, which hides the Variation menu in VDDT. 
Change this value to 0 and close the table.  Exit Microsoft Access (there 
is no need to save the database before exiting the program). 

 
4. The next time you open VDDT with the modified database selected, the 

Variation menu will be accessible as soon as you open a Project.   

 

The following sections of this user guide describe all of the options under the 
Variation menu, and provide guidance about how to use them.  

VARIATION MENU 
VDDT, through its stochastic algorithms, inherently generates some 
between-year variability in transition probabilities. The area affected by a 
transition type in any one year is dependent on the state of the landscape.  If a 
large amount of the landscape is in classes that have a high probability for 
transitions, the number of cells undergoing transitions will be higher than if 
most of the landscape is in classes in which transitions have low 
probabilities. Even disturbances that occur in many or all classes will show 
some minor variation due to random number generation and due to 
variability in the probabilities for different classes (see Appendix B for a 
discussion of probability distributions in transition probabilities). 
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In ecological systems, sources of variation also include external factors such 
as weather patterns. For example, several warm, dry years may result in 
higher than average areas burned or affected by mountain pine beetle. VDDT 
can capture some of this variation using some user-defined information, 
described in the following sections. 

The first question to be asked is if there is to be between-year variability 
from external conditions. If so, there are two paths to be followed, depending 
on whether or not external multipliers are to be used. External multipliers are 
ones that can be used directly. For example, suppose a user has information 
that describes stand-replacing fire behavior over a 100-year period. Outside 
of VDDT, the user determines the average area burned, and then a multiplier 
for each year to get from the average area burned to the actual area burned. 
These multipliers could then be placed in a file (in the format described in 
Appendix D) and used to create between-year variability for stand-replacing 
fires in VDDT. External files can also be created from saving the between-
year multipliers generated in earlier runs of VDDT. 

Many users will not have external files, at least not initially. Thus, their first 
step must be to create groups of disturbances that respond to similar 
conditions ("year sequence groups" or YSGs). For example, the group could 
contain disturbances that react to rainfall. Some disturbances (such as fires) 
may do worse in wet years than in dry years while other disturbances (such 
as flooding) will have an increased occurrence in wet years. But, since both 
disturbances respond to rainfall, they can be included in the same group. 
Once the groups are defined, the next question becomes whether the user 
wants to control the multipliers that are used. If not, the model can be asked 
to generate one or more sequences of random numbers. 

If users want more control over the multipliers, they can define multipliers 
for up to five different year conditions for each disturbance type that was 
placed within one of these YSGs (groups of disturbances). These "year type 
multipliers" will then be applied to a sequence of year conditions and turned 
into a stream of multipliers. 

The expected methodology is to use annual average probabilities in the 
pathways table for each succession class. The multipliers represent the ratio 
of acres disturbed in each year-type as defined in a YSG. For example, if 
stand replacement wildfires occur every 200 years, the average annual 
disturbance probability is 0.005. If the ratio of acres burned in low, normal, 
and high fire years is 1 to 10 to 40, these numbers would be included as the 
multipliers. 

Multipliers must be normalized when average disturbance probabilities 
are used. Normalization is a process whereby the actual values of the 
multipliers are adjusted, while keeping the relative values the same, to get an 
overall average multiplier of 1. This process eliminates any inherent bias 
arising from the use of between-year variation, and ensures that, barring any 
changes to the state of the landscape, the average area disturbed over the 
simulation period by different disturbance types is the same whether or not 
the multipliers are used. 
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In some cases the user may have actual disturbance probabilities for each 
year-type as defined in a YSG. In this instance, the user would put a constant 
less than or equal to 1 in the pathways tables and put the actual disturbance 
probabilities in the between-year multiplier table. There would be no need 
for normalization. 

Note that these between-year variability multipliers are not used by default. 
Multipliers must be generated or read from a file in order for the model to 
use them during a run. This must be repeated each time a new Project is used. 
Once the multipliers have been used for a run for a Project, all other runs 
with that Project (in the same VDDT session) will use the same multipliers 
unless they are explicitly turned off. 

Note: 
To create multipliers that change probabilities based on landscape conditions 
(i.e., internal factors), use the landscape condition feedback multipliers 
described.  

Defining Year Sequence Groups 
At the highest level, users define one or more "Year Sequence Groups" 
(YSG). A YSG defines a group of disturbances that are all affected by the 
same conditions. The definition also includes the percentage of the years that 
are expected to be in each of five different categories. 

To define a YSG: 
1. Select Define YSG from the Variation menu. A window will appear 

with a grid containing any already defined YSGs.  

  
 In the above example, one YSG has been defined: Fireyear. The YSG 

"Fireyear" has 0 disturbances assigned and the assigned proportions add 
to 100%. 

 If no YSGs have been defined, the grid will contain a blank line. The 
columns are as follows: 
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Column Description 

YSG (1): The name of the YSG. 

Very Low –Severe (2-6): The percentage of the years in each of the different 
categories. 

Total (7): The sum of the percentages. 

#Dists (8): The number of disturbances that have been 
assigned to this YSG. 

 

2. Type in the percent of the time that a year is in that condition in columns 
2 through 6. The different types of year conditions are named "Very 
Low," "Low," "Normal," "High," and "Severe." Users can interpret these 
for their own conditions and may use as many year types as are needed 
to model your problem 

3. Click on the cell in the Total column to add up the values in the previous 
five columns. 

4. If the result is different from 100, you can either adjust the numbers to 
make them add to 100 or click on the Recalc button to ask VDDT to 
recalculate the numbers so that they retain the same relationship to each 
other but add up to 100%. You can also select Recalculate all rows 
from the Grid menu. 

5. The last column of the grid in the main YSG dialog box shows the 
number of disturbances that are assigned to the YSG. To get a list of 
these disturbances, double-click on a cell in the last column. A summary 
dialog box will appear listing the disturbances currently assigned to the 
YSG. 

  
 

 In the above example, the YSG Fireyear was selected. Two disturbances 
are listed here. Note the Assign button which allows users to go to a 
dialog box for adding and deleting disturbances. 
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6. To add or remove disturbances, click on the Assign button at the bottom 
of the dialog box, or click on the OK button to leave this dialog box. 
Then click on the Assign disturbances button just below the grid. A 
second dialog box will appear that contains two lists.  

 The list on the left contains all the disturbance groups that have at least 
one disturbance defined in the Project. If one of these disturbance groups 
is selected by the user, a list of the disturbance types will appear on the 
right. Users can then pick one or more disturbances from one or more 
lists. Clicking on the Summary button will bring up the window that 
lists all the currently selected items. Note when the summary dialog box 
is accessed from this window, the Assign button will not be visible 
because the assignment is already in process. The summary window 
must be closed down (by clicking on the OK button) before adding more 
disturbances 

 Note that disturbances may be in up to three different disturbance 
groups. If the disturbance is selected under one of the groups, it will also 
be selected in the other groups. 

7. When done adding disturbances, click on the OK button to keep any 
changes or the Cancel button to ignore any changes. In either case, the 
window will close. 

 Note: 
Disturbances can belong to only one YSG. If a disturbance is selected 
that is already in another YSG, a message will appear: 
 
"The disturbance name is already part of another YSG. Do you wish to 
remove it from that YSG? Note that if the disturbance remains part of 
that YSG, the disturbance will not be added to the current YSG." 
 
Responding "No" to the message will mean that the disturbance remains 
part of the other YSG and is not saved as part of the current YSG. 
Conversely, selecting "Yes" as the response will remove the disturbance 
from the other YSG and save it in the current YSG. 

To add more YSGs: 
1. In the main YSG dialog box, click on the Add Row button or select Add 

Row from the Grid menu. Note that when a YSG is added, it contains 
no disturbances. 

To delete a YSG: 
1. Place the cursor on the row to be deleted and select Delete current row 

from the Grid menu. 

Once done, values may be saved to a file by selecting Save from the dialog’s 
File menu. This saves all information contained in the grid: the name of the 
YSG, the distribution in the different categories, and the associated 
disturbances. For complete details, see Appendix D.  This file may later be 
loaded by selecting Load from the File menu. Loading a file completely 
overwrites any values that are currently in the grid. In addition, any 
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disturbance types that are in the file that are not part of the current PVT will 
not be loaded, and thus, cannot be resaved. 

Clicking on the OK button saves the information to memory, for use in 
defining the remaining information required for between-year variation. 
Clicking on the Cancel button closes the window without saving any of the 
changes that were made. 

Defining Type Multipliers 
In order for the model to generate annual multipliers, each disturbance that is 
part of a YSG must have multipliers assigned for each of the five types of 
years that are used (Very Low, Low, Normal, High, and Severe). In a later 
step, these multipliers for each disturbance and year type will be combined 
with information about the YSG to generate annual multipliers. 

To assign the multipliers: 
1. Select Define Type Multipliers from the Variation menu. A dialog box 

will appear with a grid containing all the disturbance groups that contain 
at least one disturbance that is in a YSG. 

  
 

2. As in other grids, clicking on the + in the first column of the grid will 
show the specific disturbance agents in that disturbance group. Clicking 
on the - will hide the disturbance agents, while remembering any values 
that were assigned in the dialog box. 

3. Type in the multipliers for a group by entering them on the same line as 
the name of the disturbance group, which is also the line that has All in 
the DistType column (e.g., "Wildfire" in the example above). When a 
group multiplier is entered, it automatically overwrites all values for that 
year-type for all disturbances in that disturbance group. Values can also 
be entered for individual disturbances. 
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 Note that if a disturbance occurs in more than one disturbance group, the 
actual multiplier that is applied is the one that occurs in the last group 
for which it is defined. 

 If a value for one of the disturbance types is deleted by the user, and if 
no value is entered that applies to the entire group, the multiplier is 
assumed to be zero. 

 

The values in the grid can be saved to a file by selecting Save from the File 
menu on the dialog. Multipliers can also be loaded from a file by selecting 
Load from the dialog’s File menu. Note that if multipliers are loaded, they 
will overwrite any existing values in the grid. Also, any disturbance types 
that are not in the file will have no multipliers (or will have a multiplier of 1) 
and any disturbance types that are in the file that are not defined as part of a 
YSG will not be loaded. The default file extension is *.YTM (Year Type 
Multiplier) and the file format is given in Appendix D. 

Clicking on the OK button saves the information to memory, for use in 
defining the annual multipliers. Clicking on the Cancel button closes the 
window without saving any of the changes that were made. 

Annual Multipliers 
Annual multipliers are the values that are actually used by VDDT during a 
model run. In most cases, these will be generated based on the information in 
the previous two dialog boxes (the YSGs and the Year-Type Multipliers). In 
these cases, for each YSG, the generation routine first creates a stream of 
types of years based on the proportions defined earlier. Second, for each 
disturbance type, the model changes the year category into the corresponding 
multiplier (as defined in the second step of the process). This creates sets of 
annual multipliers for each disturbance type. These multipliers are then 
normalized to ensure that there is no inherent bias in their use. Alternatively, 
multipliers can be read from external files. 

Note: 
An accessory program for generating complex multipliers streams, named 
BUILD_MCM, is explained in Appendix F. 

To create the multiplier streams: 
1. Select Annual multipliers from the Variation menu. 

2. To turn off all between-year multipliers (but not remove them from 
memory), select Turn off from the Multipliers menu on the View And 
Generate Multipliers dialog, and then click on the OK button. The 
status bar at the bottom of the main VDDT window shows whether or 
not the multipliers are being used (Annual Mult.). 

3. There are several options available for generating the annual multipliers. 
In the simplest case, users can click on the Generate button, then on the 
Normalize button and then on the OK button to save the values, exit the 
window, and use the resulting values for their run. Many users, however, 
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will want to have more control over their options, to view the 
multipliers, or to load or save the multipliers. Each of these is described 
in more detail below. 

Generation Options 
Many of the options can be found by selecting Options from the Multipliers 
menu on the View And Generate Multipliers dialog. Four categories of 
options can be set: 

1. The disturbance types to generate. 

 Under this option, users can choose whether they want to generate the 
multipliers for: 

a. all disturbance types (default), 

b. for the selected YSG, or 

c. for the selected disturbance types. 

 Most of the time, the default option is the most appropriate (see example 
screen below). The second option may be chosen if the user likes most 
of the patterns, but wants to refine the scenario for just one or two 
YSGs, or if the multipliers were read from a file and some of the 
disturbances in a YSG were missing. The third option is not 
recommended for anyone who is using YSG information for generating 
the multipliers, and should only be used if the third option from the 
generation criteria is selected. 

  
 

2. Generation criteria. 

 The first step of the definition of between-year variability was to define 
the proportion of years in each different year-type. The options basically 
allow users to decide whether these defined proportions are to be 
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maintained, whether they are just a guideline, or whether they should be 
totally ignored. Three options exist to control how the generation occurs: 

a. Keep the defined YSG proportions for the different types of 
years; 

b. Target the YSG proportions (default); and 

c. Ignore all YSG information. 

 If one of the first two options is chosen, the model will use the 
information to generate annual streams of types of years for each YSG, 
based on the proportion of the years that should get the different types. 
Disturbance multipliers are then generated from this information. 

 If the first option is chosen, the model will maintain the defined YSG 
proportions for the different types of years. For example, if the annual 
probability of a severe year is 0.01, exactly 3 severe years will be 
generated in a 300 year simulation. 

 With the second option (default), the defined YSG proportions for the 
different type of years are not maintained. With this option each 
generated year type is based on an independent random draw. Because 
the number of years in each type is not fixed, this option results in more 
stochastic variation between runs. 

 If the third option is chosen, the generation routine will totally ignore the 
proportions and the defined multipliers and will simply generate a 
sequence of normally distributed random numbers for each disturbance 
type (or for each selected disturbance type if that option has been 
chosen). 

3. Normalization criteria. 

 Normalization is a process by which the multipliers retain their sequence 
and their relative magnitude but are adjusted such that their average over 
a given period is one. As with the other criteria, there are also three 
options for normalization. 

a. Normalize over the period to be simulated (default).  This ensures 
that the multipliers introduce no bias and that the disturbance 
probabilities remain, on average, as originally defined. If there were 
no large differences in disturbance probabilities due to landscape 
conditions (i.e., state classes), the same proportion of cells would be 
disturbed with the normalized multipliers and without any 
multipliers, but the between-year variability would differ. 

b. Normalize over the period that was generated. This option assumes 
that the generated period is similar to the one for which the 
probabilities are defined. Users may only use a fraction of this 
normalized stream, and may thus alter the average area disturbed. 

c. Do not normalize.  This option is not recommended. The primary 
function of this option is to allow users to enter actual disturbance 
probabilities for each type of year defined in a YSG. 
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d. Base on target not actual proportions.  The default option (#1) 
adjusts the multipliers based on the actual number of years in each 
year type for each YSG. This method holds the average expected 
frequency of each disturbance more or less constant and prevents 
the total area disturbed over the entire simulation period from 
varying significantly from run to run. The option’s adverse effect is 
that multiplier sequences with relatively more severe years result in 
the same total area disturbed as sequences with relatively few (or 
no) severe years. By checking Base on target not actual 
proportions, VDDT does not adjust for the actual proportions of 
years in each type, instead there is more variation from run to run. 
This should be seriously considered instead of the default. 

4. The number of years to generate. 

 This option is self-explanatory. The default value is 300 years, the same 
as the default number of years allowed for a simulation run. It is 
recommended that the number of years generated is the same as the 
number of years being simulated. 

 

The default multiplier values are automatically set, so most users will not 
have to set or change the options. If options are selected, however, clicking 
on the OK button saves the options and clicking on the Cancel button 
ignores the changes. The options are remembered throughout the VDDT 
session. Thus, once the options are set as desired, they will not need to be 
changed. 

Generation Procedures 

To generate the multipliers: 
1. Click on the Generate button, or select Generate from the Multipliers 

menu. If the options specified that only a specific YSG or specific 
disturbances are to be generated, then these must be selected from the 
appropriate list. Note that once a YSG is chosen, the related disturbance 
types are listed and can be selected. 

To view the multipliers: 
1. Select one or more disturbances from a YSG and click on the Redraw 

button. One or two graphs will appear.  
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 In the above example, the multipliers have been generated using the 
default options. The multipliers for the disturbance "WMF" have been 
graphed. The top graph shows the actual multiplier sequence 
(unnormalized), while the bottom graph shows the relationship between 
the actual proportion of years of each condition (left bar) and the pre-
defined proportions for that YSG (right bar).   

 The top graph shows the disturbances. If the default options were 
chosen, or if the generation was done using YSG information, all the 
disturbances in the graph should follow the same pattern, although their 
magnitudes will be different. In addition, a second graph appears below 
the first. This graph shows the actual percent of the years in each year 
type and the defined percent of the years in each year type. If the default 
options were chosen, the two sets of bars will be identical.  

 

The second step of the generation process is to normalize the multipliers. 
This is not done automatically. 

To normalize the multipliers: 
1. Click on the Normalize button or select Normalize from the 

Multipliers menu. No visible change will occur on the dialog box. 

2. The changes can, however, be seen by selecting Graph normalized 
from the Multipliers menu. A check mark will appear next to the menu 
item and the graph will be redrawn using the normalized multipliers 
instead of the original multipliers. The graph will look identical except 
that the y-axis scale will have changed. Selecting this menu item again 



VDDT 6.0 User Guide 

178 

will remove the check-mark and will graph the unnormalized 
multipliers. 

You can eliminate any effect of the multipliers by resetting them to one. 

To reset some or all multipliers to one: 
1. Select Remove from the Multipliers menu. This will reset the 

multipliers as determined by the options. Thus, if the options suggest 
generation for only the selected disturbances, the multipliers for the 
selected disturbances only would be set to one. 

Clicking on the OK button will save the results to memory and close the 
window. The normalized multipliers (unless otherwise specified) will be 
applied to all VDDT runs until they are explicitly turned off or until a new 
Project is loaded. The Cancel button closes the window without making any 
changes. 

Saving and Loading 
There are several aspects of the between-year multipliers that can be saved to 
or read from external files. The most appropriate option depends on the goal. 

Goal: 
1. Have the same series of high and low years between runs. 

 This option would be used if the same YSG is being used in a number of 
situations with different disturbances (because of having different 
disturbances in different PVTs or because of adding or deleting 
disturbances from a YSG) or different year-type multipliers. The 
generation routine in each simulation would then be given the same 
sequence of years and would generate the annual multipliers based on 
the defined disturbances and year-type multipliers. 

 This method has the advantage that, when comparing simulations, the 
high and low years are in the same place and only the magnitude of the 
multipliers changes. Also, if a new disturbance is part of a YSG, it will 
automatically use the same pattern of years as the other members of its 
YSG. 

Note: 
The annual year-type sequence is regenerated each time the Generation 
button is clicked. Thus, even within a single PVT, the only way to use the 
same sequence of years for multiple runs is to save the sequence to a file and 
reload it before generation. 

Saving and loading these files is done by picking Load or Save from the File 
menu on the View And Generate Multipliers dialog, and then selecting 
Year-type sequence. The default extension for these files is *.TSE (Time 
Sequence), and the file format is given in Appendix D. 

Note that a *.TSE file can be easily modified or built with a text editor to 
create any desired sequence of years. In this manner, the user can model the 
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potential effect of cyclic climatic patterns, global warming, etc. For more 
details on generating complex sequences, see Appendix F. 

 

2. Use identical multipliers between runs 

 This option would be used to control for differences in between-year 
variability. If identical multipliers are used, the differences between runs 
has more to do with the differences in landscape conditions or defined 
probabilities than with the annual multipliers. 

 The main disadvantage to this method is that if any disturbances have 
been added to a YSG, they will have no multipliers. The multipliers for 
these disturbances will need to be generated which will likely cause 
them to have a different pattern of years than the other members of the 
YSG. 

 The main advantage of this method is that actual multipliers can be 
loaded and used. In addition, the multipliers can be reloaded and 
normalized with a different option before using in the simulation. 

Saving and loading these files is done by picking Load or Save from the File 
menu and then selecting Multiplier Sequence or Normalized Sequence. 
The default extension for these files is *.MSE (Multiplier Sequence) or 
*.NSE (Normalized Sequence), and the file format is given in Appendix D. 

Note: 
The "unnormalized" multipliers are not saved when this part of VDDT is 
exited (unless the routine was specifically asked not to normalize the 
multipliers). Thus, the only way to use the same set of raw multipliers, even 
within a single VDDT session, is to save the values to a file and to reload 
them when next entering this window. 
 
Note also that, since the year types are not saved with the multipliers, the 
second graph (that compares the defined YSG proportion with the actual) 
will not be shown. 

Multiple iterations 
If the annual multipliers are being used in a run with multiple Monte Carlo 
simulations, users are asked to choose from the following when defining a 
run: 

1. Read multipliers from the database 

 This is the default option for new Projects.  It directs the model to use 
annual multipliers for the next simulation that are already associated 
with the Project and incorporated into the active database.  If your 
Project contains annual multipliers that have been imported or loaded 
from *.MCM or *.CSV files, they are in the database and can be read 
from there.  Under this option, each Monte Carlo iteration can have a 
different combination of low and high years, thus allowing for the 
possibility of simulating rare events. 
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2. Use the same multiplier sequence for each iteration. 

 Under this option, differences in the results are only a result of 
differences in picking the random numbers and in the resulting state 
difference. The same years will have large or small multipliers applied. 
This method shows little variation between runs and is not 
recommended. 

3. Use the same set of multipliers in a different order for each iteration. 

 Under this option, the high and low multipliers will be applied in 
different years, adding another source of variation between the 
iterations. This ensures, however, that each run has exactly the same set 
of “good” and “bad” years, just varying their order. This is an easy way 
to show variation between runs while holding the total area affected by 
the disturbances more or less constant. 

4. Read the multipliers from an external file. 

 Under this option, each iteration may have a different combination of 
low and high years, thus allowing for the possibility of simulating rare 
events. This method best shows the variation that could occur and is 
recommended. 

The first option requires that annual multipliers have been loaded into the 
Project (see about Temporal Multipliers in the Probability Multipliers topic, 
above) and incorporated into the active database. The second two options 
require that multipliers have been loaded into memory from the annual 
multipliers dialog box. The last option requires only that the annual 
multipliers have been turned on, and that a file with the appropriate format 
has been created. This file can be created in the Annual Multipliers window 
by selecting Make MC file (all YSGs) from the Multipliers menu. The user 
will be asked the number of Monte Carlos to generate and the file name in 
which to store the results. The file is saved in Monte Carol multiplier 
(*.MCM) format (Appendix D) and can contain up to 300 sets of randomized 
YSG multipliers. The model will generate information for all disturbances in 
the number of years listed in the Multiplier Options window. Note that the 
current multipliers stored in memory will be replaced with one of the sets of 
multipliers generated for the file. 

If the third option is chosen for the model run, the user will be asked to 
supply a filename, with the default being the file created in the Annual 
Multipliers window. The model will read this file at the beginning of each 
Monte Carlo. If it reaches the end of the file before all Monte Carlos have 
been simulated, VDDT will produce a warning, and will read the file again 
from the beginning. 

To use annual multipliers in a simulation run: 
1. Under VDDT’s Variation menu, select Sequencing to open the 

Temporal Multiplier Sequencing dialog.  The option chosen here will 
dictate where VDDT will look for the annual multipliers for the next 
simulation and how to use them.   
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3. Click OK to save the chosen settings to memory, or Cancel to abandon 

the changes and close the Temporal Multiplier Sequencing dialog. 

4. The next time you run the model using this Project, your annual 
multipliers will be used in the simulation according to the sequencing 
option you selected.  If, at some later time, you wish to run a simulation 
without the multipliers, simply turn the multipliers off (under the 
Multipliers menu of the View and Generate Multipliers dialog 
(Variation|Annual Multipliers) or on the Options tab of the Run 
Settings dialog (Run|Settings)).  The model will ignore the assigned 
multipliers until the option is explicitly turned back on. 

Note that if the Sequencing option under the Variation menu is grayed out, 
this means that the multipliers are turned off. 

Open Variation Files 
Use this option under the Variation menu to load multiplier values from 
files.   

To load multiplier values from files: 
1. Select the Open variation files option from the Variation menu. 

2. A series of "open file" windows will appear from which you will choose 
the year sequence group (*.YSG), year type multipliers (*.YTM) and 
multiplier sequence (*.MSE or *.NSE) files you need.   

3. After each choice, click OK to load the values and close the screen. 

Landscape Multipliers 
In VDDT, the area disturbed by a particular agent increases as the proportion 
of the cells in the landscape that are susceptible to this disturbance agent 
increases. For example, if through prolonged suppression of fires, the 
average age of the cells in the landscape increases and if older successional 
classes are more susceptible to mountain pine beetle, then the area disturbed 
by the beetles will increase. In this example, more area is disturbed because 
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there are more susceptible cells, but each cell still has the same probability of 
being affected by this agent. 

For some disturbance agents, the probability of disturbing a particular cell 
may be altered by the spatial context of the cell. For example, a stand that is 
susceptible to mountain pine beetle has some likelihood of being attacked. It 
is often thought that this probability is higher if the stand is surrounded by 
susceptible stands than if it surrounded by non-susceptible stands. Because 
VDDT is a non-spatial model, contagion processes cannot be represented in 
detail. Instead, users can define a multiplier that is designed to provide 
feedback between the probabilities of disturbance and the landscape 
condition. 

Open Landscape Multiplier Files 
Use this option under the Variation menu to load landscape multiplier values 
from files.   

To load landscape multiplier values from files: 
1. Select the Open landscape multiplier files option from the Variation 

menu. 

2. An "open file" window will appear from which you will choose the 
landscape multiplier file (*.LCM) you need.   

3. Click OK to load the values and close the screen. 

Edit Landscape Multipliers 
The intent of the multiplier function is to either increase or decrease the 
"average" probability of disturbance based on the proportion of the cells in 
the landscape that are in a state that is susceptible to the disturbance agent. 
To measure the state of the landscape, VDDT compares the current area to be 
disturbed by the agent with the maximum area that could be disturbed by the 
agent. The maximum area is the product of the highest probability of 
disturbance for this agent, times the number of cells in the landscape. The 
current area to disturb is the product of the probability of disturbance of each 
successional class times the number of cells in each class. 

Note: 
Note that use of the landscape multipliers will slow down the model. This 
will be especially apparent for Projects with a large number of transitions, for 
runs with large numbers of cells, and on slower machines. 

To set up one or more landscape multipliers: 
1. Select Edit Landscape multipliers from the Variation menu.  

2. A window will appear that lists all currently active transition groups.  
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The columns of the grid in the Landscape Multipliers dialog are: 

Column Description 

DistGroup: The name of the disturbance group. 

DistType: The name of the associated disturbance types. Note 
that the first line of the group will always contain 
the work "All" as the type. If the "+" is clicked in 
the first column of the group, the other disturbance 
agents will appear. 

Max: The maximum possible proportion of the landscape 
that could be disturbed by the given disturbance 
agent using just the defined multipliers (i.e., no 
between-year multipliers). This value cannot be 
edited and is just there as a guide for how much 
disturbance is possible without additional 
multipliers. Each year, the potential proportion of 
the landscape that could be disturbed will be 
compared to this value. 

0, ..., 100: These columns are for adding the multipliers that 
would be used if the potential percent of the area 
that would be disturbed by a disturbance agent 
were at the listed percentage. For example, if a 2 
were entered in the column labeled 40, and if the 
maximum proportion of the landscape that could 
be disturbed in a year were 0.01, then, if the 
potential amount of the landscape that would be 
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disturbed in the current year were 40% of the .01 
(or 0.004), the probabilities for that disturbance 
agent would all be multiplied by 2. 

In the above example, the disturbance group StRepWfire (stand replacement 
wildfire) has been expanded to show the available disturbance agents, in this 
case only "SR_Wfire." The values shown represent one of the pre-defined 
sets of multipliers and have been graphed.  

Multipliers can be defined either for the entire group or for individual 
disturbance types. If values are entered on the top line of the disturbance 
group, next to the disturbance type All, they will be applied to the entire 
group. If the individual types are visible (either by clicking on the +next to 
the group name or by selecting Show all from the Multipliers menu) then 
values can be entered into the row next to the disturbance agent’s name. 

In the simplest case, users can assign one of five pre-defined sets of 
multipliers. To do this, place the cursor on the row to which the values 
should be assigned and select the appropriate pre-defined function from the 
menu. Values will be entered into the row, and the function will be graphed. 
The x-axis in the relationship is the ratio of the maximum to the current area 
to be disturbed by the disturbance agent. The y-axis describes the value of 
the multiplier to be applied to the disturbance probabilities. A positive 
feedback is achieved if the multiplier increases as the proportion of the 
stands in the landscape that are susceptible increases. No feedback between 
landscape conditions and the probability of disturbance is obtained with a 
multiplier of 1. This is also the current default condition. A negative 
feedback is achieved if the multiplier declines with an increasing proportion 
of the landscape in the susceptible class. There may be no ecological systems 
in which this negative feedback exists and the pre-defined condition is only 
an example. 

 
The above figure provides a summary of the pre-defined landscape 
multipliers. 
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Users can also define other relationships by entering values directly in the 
appropriate columns. Values only need to be entered in some of the columns. 
Thus, to create a curve that increases from 0 to 4, simply enter a 0 in the first 
column (the 0 column) and a 4 in the last column, and a line will be drawn. 
During a simulation the model: 

• applies the last defined multiplier up to the maximum (100%); 

• sets the value in the "0" column to 0 if values have been assigned in 
later columns; and 

• interpolates between defined values, unless otherwise specified by the 
user. 

For example, suppose a user puts a 2 in the 40% column, and that is the only 
column with an assigned value, and the user is using the default option of 
interpolation. The model will: 

• use the 2 for all landscape conditions from 40% to 100% (inclusive); 

• use a 0 for 0%; and 

• interpolate between 0 and 2 for landscapes between 0% and 40% 
(exclusive). 

To graph a user-defined curve, place the cursor on the row to be graphed and 
click on the Redraw button. 

The multipliers can be used with or without interpolation between the 
defined values. The default is with interpolation. With no interpolation, 
changes happen more abruptly. To use the example above, when using 
interpolation, the multiplier would change from 1.95 to 2 as the landscape 
went from 39% to 40%. Without interpolation, the multiplier would change 
from 0 to 2 with the same change in landscape value. Each type of change is 
appropriate for simulating different types of effects. Note, however, that the 
decision of whether or not to use interpolation applies to all disturbances. 

These landscape multipliers may be saved to a file by selecting Save from 
the File menu. This saves all values in the grid. Reading multipliers from a 
file can be done by selecting Load from the File menu. When the file is 
loaded, multipliers that have been defined for disturbances not currently in 
the Project are ignored. All multipliers for disturbances that are in the current 
Project and not in the file are left as the last value defined in the model. 

Note: 
The breakpoints for the multipliers have changed from version 3.0. Thus, a 
warning will appear if version 3.0 files are read. The program will attempt to 
process the file appropriately, but it is important to double-check all values 
(and save them in the version 6 format). 

 

Clicking on the OK button saves the information to memory and tells the 
model to use the defined landscape multipliers (unless explicitly told 
otherwise). Clicking on the Cancel button closes the window and ignores 
any changes that were made. 
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Note that defined multipliers can be explicitly disabled for a simulation by 
selecting Turn off from the Multipliers menu. A check will appear next to 
the menu item to indicate that the multipliers are not being used, and a 
warning will occur as when the OK button is clicked. 

Note: 
No normalization is done to these multipliers because it is impossible to 
anticipate the distribution of successional classes in the simulation run. Thus, 
the average area disturbed by a disturbance agent that is using these 
multipliers may be very different than the average area when the multipliers 
are not used. The amount and direction of the bias depends on the landscape 
condition and the shape of the curve. 

Landscape Feedback 
Use the Open Landscape Feedback Files option under the Variation menu 
to load landscape feedback values from files.   

To load landscape feedback values from files: 
1. Select the Open landscape feedback files option from the Variation 

menu. 

2. Two "open file" windows will appear from which you will choose the 
landscape feedback files (*.LCF and *.LFM) you need.   

3. Click OK to load the values and close the screen. 

Defining Landscape Feedback Group 
The landscape condition feedback (LCF) option allows the user to link 
disturbance probabilities to the average value of a numeric attribute – or 
landscape scale condition. This means that you can create an attribute to 
calculate any environmental risk (fire, insects, etc.), then simulate a major 
disturbance when the risk reaches a critical threshold. 

To use this option, you first need to have created a numeric attribute that 
defines the landscape condition (Attribute menu). Values from 0 to 1 must 
be used to represent the condition associated with each succession class. 
Examples of landscape variables are fire risk and insect risks. 

A suggested method for using the LCF option is to assign a very low 
background disturbance value for each succession class susceptible to the 
disturbance, then to enter large multipliers associated with critical 
breakpoints. For example you may have little or no mountain pine beetle 
until average conditions reach a critical level, then have a major epidemic 
killing 50% of the stands. 

To define a landscape feedback group: 
1. Select Define landscape feedback group from the Variation menu. 

2. Click on the Add Row button. 

3. In the Landscape condition variables table that appears: 
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a. name each group, 

b. indicate the attribute that applies, and 

c. link the associated disturbances to the group.  

 

 
 

Column Description 

LCF Variable Name: The name of the LCF variable is typed in here. 

Attribute: The numeric attribute that applied. Select from 
drop-down list. Note that only numeric attributes 
are shown in this list. 

Prop Area Affected: Refers to the proportion of the study area for which 
the LCF group applies. For example your VDDT 
Project may cover an entire watershed, but the 
LCF variable for mountain pine beetle may apply 
only to the lodgepole pine area within that 
watershed. 

Percent 1, ..., 4: Represent the breakpoints to use to when applying 
the multipliers. You can specify from 1 to 4 
breakpoints. A breakpoint of 50 would represent an 
average condition of 0.5. By default the tool 
creates breakpoints at 0 and 100 percent. 

Dists: Number of disturbances linked to the 
corresponding LCF variable. Double-click on this 
column to select disturbances or click on the Add 
Disturbances button. 
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4. When done, select Save from the File menu on the Landscape 
Feedback Multipliers dialog to save the data to the LCF file (see 
Appendix D for more detail). 

5. Alternatively, you can load LCF values from a file by selecting Load 
from the dialog’s File menu. 

Editing Feedback Multipliers 

To edit landscape feedback multipliers: 
1. Select Edit feedback multipliers from the Variation menu to edit the 

landscape feedback multipliers table. 

  
 

2. Click on the + sign at the beginning of the data line to see the 
multipliers. 

3. For each disturbance within each LCF enter the multiplier to apply. 

4. After entering all multipliers select Redraw to review your assumptions. 

5. Select Save from the File menu on the Landscape Feedback 
Multipliers dialog to save the multipliers to the LFM file (see Appendix 
D for more detail). 

6. Alternatively, you can load LFM values from a file by selecting Load 
from the dialog’s File menu. 
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Temporal Trend Lines 
Use this feature under the Variation menu to add an explicitly temporal 
trend line to any disturbance. There are several ways to add trend lines: 

• load trend multiplier values from files; 

• enter predefined values; and 

• define your own values. 

Open Trend Information 
Use this option under the Variation menu to load trend multiplier values 
from files.   

To load trend multiplier values from files: 
1. Select the Open trend information option from the Variation menu. 

2. An "open file" window will appear from which you will choose the trend 
information file (*.TRD) you need.   

3. Click OK to load the values and close the screen. 

Editing Trend Multipliers 

To use predefined temporal trend lines: 
1. Select Edit trend multipliers from the Variation menu. 

2. Select the disturbance type you want to use by clicking on the + sign to 
expand the desired disturbance group and clicking on the Disturbance 
Type. 

3. Select Use predefined from the Multipliers menu and click on the 
desired option: 

a. No trend, 

b. Slow increase, 

c. Fast increase, 

d. Slow decrease, 

e. Fast decrease. 

The predefined values will appear in the Step and Value columns in the 
middle of the screen and the graph will be redrawn.  

4. Select Save from the File menu to save the multipliers to the TRD file 
(see Appendix D for more detail). 
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 The above example shows pre-defined trend multipliers for the Fast 
increase option.  

To create your own temporal trend lines: 
1. Select Edit trend multipliers from the Variation menu. 

2. Select the disturbance type you want to use by clicking on the + sign to 
expand the desired disturbance group and clicking on the Disturbance 
Type. 

3. Type in the Total number of years you want to use for the trend line. 

4. Type in the interval in years for defining values. 

5. Click on the Apply button. The Step and Value columns will change 
based on what you defined in Steps 3 & 4. 

6. Type in the appropriate value for each step. 

7. Click on the Redraw button to draw the graph of your temporal trend 
line. 

8. Select Save from the File menu to save the multipliers to the TRD file 
(see Appendix D for more detail). 

9. Alternatively, you can load TRD values from a file by selecting Open 
from the dialog’s File menu. 
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 The above example shows user defined trend multipliers with an interval 
of 10 years.  

Note that defined multipliers can be explicitly disabled for a simulation by 
selecting Trend Multipliers OFF from the Multipliers menu. A check will 
appear next to the menu item to indicate that the multipliers are not being 
used, and a warning will occur as when the OK button is clicked. 
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